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Overview of the Estimating Process
The estimating process typically progresses through the following five steps. If you are an Owner you
may not take part in all five of these steps, but may instead do a few in an iterative process as you pro-
gress through stage gate approval phases.

1. Enter project details.

2. Enter proposal deliverables.

3. Calculate Direct & Indirect Project Cost.

4. Add Markup, Contingency, & Fees.

5. Distribute Cost + Markup to required structure.

The below table displays how these five steps correspond with specific forms in InEight Estimate:

Note the forms used in InEight Estimate to accomplish the steps above:

l Job Properties

l Pay Item & Proposal

l CBS (Cost Breakdown Structure)

l PBS (Price Breakdown Structure)

The rest of this section walks you through an overview of each step in the process and its cor-
responding form in InEight Estimate.
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Step 1 – Enter Project Details
When you decide to estimate a new project, the first step is to create a new estimate and set it up with
the general project details. In InEight Estimate, you’ll enter basic information and project specific set-
tings in the Job Properties form from the Setup tab.

The Job Properties form is organized into tabs to help you keep track of all the basic information and
settings for the project. It begins with the Overview tab. You will move from left to right entering your
project specific information and adjusting any settings that differ from the default.

Step 2 – Enter Proposal Deliverables
For Contractors who are submitting a proposal to a client, this step enables you to enter the client
provided deliverables clients are requesting pricing for. Most Owners will skip this step unless there is
a need to track various funding sources or prepare for internal or external company billing.

In InEight Estimate this list of items is recorded in the Pay Item & Proposal Register on the Setup tab.

• Notice that your pay items have no pricing when first entered because you have yet to figure out
costs. You will come back to this form later in the process to distribute your costs and markup.

Step 3 – Calculate Direct & Indirect Project Cost
Once you’ve set up your estimate, you will perform take-offs and cost analysis to determine the total
estimated cost to complete the entire scope of work.
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The Cost Breakdown Structure (CBS) Register is the main form where you will do your cost estim-
ating.

l It is the hierarchy of work activities that make up the estimate

l Each row in the CBS represents a work activity and is called a cost item

Step 4 – Add Markup, Contingency, & Fees
Once you have estimated all project costs, you may need to add markup, contingency or other fees and
define the job’s profit in the Price Breakdown Structure form.
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Step 5 – Distribute Cost + Markup to required Structure
You now have a target price or total estimated value that you can spread to your required project deliv-
erables, back in the Pay Item & Proposal form. InEight Estimate has tools within this form to help auto-
matically distribute your cost, overhead and all markups to the listed items.
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Key Concepts and Terms
To help you get started in InEight Estimate, you should know a few key terms:

l Job Folder

l Library

l Form

l Cost Item

l Pay Item

l Resource

l Assembly

Job Folder
Job folders hold all the information for an individual project estimate. It is possible to import master
data into a job folder, but when you work in a job folder it is independent, meaning any activity per-
formed in that folder will not affect any other jobs and will not affect the library.

When moving back and forth between jobs, make sure to always double-check that you are in the right
job.

Library
The Library is a storehouse for master data, such as:

• Labor, equipment, and material unit cost rates

• Standard account codes

• Units of measure

When you create a new job from scratch, default data and settings copy from the Library into your new
job folder, except for the resource rates. Multiple list of resource rates can be maintained in the library
so you must select which rates to populate a new estimate with. Four tag fields are available to filter the
resource rates you bring into an estimate from the master library. For example, you may select a subset
of your labor rates based on the geographical location of the project.

Form
Any screen you open in InEight Estimate is considered a Form. There are three types of forms: Stand-
ard, Register, and Record forms.
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Standard Forms resemble typical data entry forms with fields available to fill in key project inform-
ation. They also may contain radio buttons or checkboxes to define settings for the job.

InEight Estimate uses tabs to group and organize entry fields and settings in a logical way, so that the
information is easy to access.

Register Forms have a grid format of rows and columns, giving it a spreadsheet look and feel. Register
forms allow you to see information for multiple items at once. The Cost Breakdown Structure (CBS)
Register is an example of a register form.

In a register form, you can open a Record for individual items you want to drill into.

The Tab key is the best way to move among fields in InEight Estimate (instead of the Enter key).

The below figure displays a Cost Item Record accessed by double clicking on that item on the Cost
Breakdown Structure (CBS) Register.

Cost Item
Cost items are the individual cost-related activities that make up the project. Cost items are organized
into a hierarchy in the Cost Breakdown Structure (CBS) Register. Each row in the CBS is considered a
cost item.
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Pay Item
Pay items typically represent the owner required deliverables a contractor must submit pricing for. Pay
items are used to distribute the cost calculated in the Cost Breakdown Structure, with all markup,
including any fees or contingencies calculated in the Price Breakdown Structure. This allows the total
estimate value to be distributed to a structure that is different than the CBS. Pay Items are pre-
dominantly used by contractors to prepare a bid sheet. Owners may use pay items to identify funding
sources or for various reporting needs.

Resource
Resources are the building blocks of a detailed cost estimate.

Resources are the people, equipment, material, and supplies needed to complete the project. Resources
are employed to cost items to develop an estimate, and are organized into seven categories or types:

1. Labor

2. Construction Equipment

3. Rented Construction Equipment

4. Installed Equipment

5. Installed Materials

6. Supplies

7. Unique

Resource Assembly
A Resource Assembly is a group of resources that are often used together. For example, for civil work,
you may group together an operator foreman, operator, and laborer, along with a loader and excavator.
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When estimating, you can employ this assembly which includes all of the pre-selected resources.

Cost Item Assembly
A Cost Item Assembly is a predefined group of cost items that has cost based on estimator inputs to a
set of questions. Cost item assemblies provide parameter-driven estimating and can also refer to ref-
erence tables. They allow companies to create intelligent construction systems to automatically estimate
various scopes of work, based upon a user providing specification and dimension variables.
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General Navigation
As a new user to the InEight, the First-time sign in dialog box opens when you first sign in, and
presents questions about your working environment in the Project Suite environment. Preferences are
set for language, date, and number formats and the User Agreement, which you must accept before you
begin. The First-time sign in dialog boxes only show for the initial sign-in to any of the InEight
products.

Step by Step — Estimate preferences setup

1. Select your preferred language, and then click Next.

2. Scroll to the bottom of the user agreement, and then select the check box for the terms and con-
ditions and privacy policy. Click Next.

Make sure you have scrolled to the end of the user agreement

3. Select a date format and number format, and then click Next.
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System Settings Options
From the Backstage View, you can access system settings. System settings contain options and settings
that effect the entire InEight Estimate system. These settings include:

l General settings (options)

l Title Bars

l Navigation Bar

l Job Startup

l Language

l Visual Style

All of the settings under the Options branch are user-level settings.

The following step by step walks you through configuring general settings (options).

Step by Step — Decimal Precision

1. With InEight Estimate open, click on the File tab to go to the Backstage view.

2. Select Settings.

3. Select General under Options in the node tree on the left.

4. To activate Prompt to Save, select the Prompt to Save checkbox.

5. Select how often you want to be prompted (in minutes).

6. Select Decimal Precision in the tree on the left.
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7. Review the default settings.

Units of Measure will default to English, and Currency will default to U.S. Dollar.
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Columns
Within each register, you can move, sort, filter and group your columns to view the information the
way you need to see it.

Move Columns
You can move columns by selecting a column header and using drag-and-drop. If there are columns on
the register that you don’t use, you can hide and unhide them from view, as needed.

Step by Step — Move Columns

1. In the CBS, click on the Currency column header and drag the column to the left, dropping it to
the right of the Description column.

2. Hide the Optional Code column by dragging the Optional Code column header down until a
black X appears, then let go.

l The Optional Code is now hidden from view

l To unhide a column, right click on any column header and select Column Chooser; a Cus-
tomization window appears, which contains all the hidden columns in that register

3. Find the column you want to unhide and drag-and-drop it to the location where you want it to go.

l You can also unhide a column using the Go To Column feature

4. Right click on a column header and select Go To Column.
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5. Click on the drop-down menu and select the column you want to unhide.

6. Click OK.

Sort and Filter Columns
You can sort and filter your columns to drill down to specific information.

Step by Step — Sort Columns

You can sort on any column by clicking once on the column header.

1. In the CBS Register, click on the Total Cost (Forecast) column to sort the column in ascending
order (e.g., 1 to 10, A to Z).

2. Click the Total Cost (Forecast) column a second time to sort in descending order (e.g.,10 to 1, Z
to A).

Use Ctrl-click to unsort a column and reset it to its original state.

Step by Step — Filter Columns

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click on the filter icon in the Unit of Measure column to select a filter value.

l From the filter list, you can select any of the values defined for that column or you can use
one of the predefined values (Custom, Blanks, Non blanks).
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3. Make your selection, then click Close.

4. To clear the filter, click on the red X at the bottom of the form or click on the filter icon on the
header of the column you filtered and select (All), then click OK.

Filter Editor Overview

Column filters can be managed on individual columns or for the entire register using the Filter Editor.
The Filter Editor tool lets work with all the column filters for a register view in one place as well as cre-
ating more complex filters through the use of grouping and applying And/Or statements.

When you add a new Group, a new Condition is automatically added to that Group.

With each additional Condition statement, you need to select an operator and a value in order for your
customized filter to take effect on your chosen column. Many new comparison operators have been
added to this version as shown below:

Creating complex filters using the Filter Editor

You can define filters across any of the columns available in the CBS register. You can also open the
Filter Editor using the button in the column filter drop-down, but regardless of how you access it, the
Filter Editor dialog permits defining a filter for the entire register and not just the selected column.
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Because all the register fields are available, more complex filters can be created by using Grouping and
Or operators. In the following example, a filter has been defined to return all Terminal Cost Items that
either have a cost source of Plug, or exceed $100,000 of Total Cost (Forecast).

When modifying a filter, the Filter Editor can be invoked by clicking the Edit Filter button located on
the bottom right of the CBS page.
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Step by Step — Filter Editor

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click the Filter icon in the Unit of Measure column to select a filter value; select the desired
UoM.

3. Select the Filter Editor button, and the Filter Editor data box appears.

l By default, an And statement is created with a Begins with operator and a blank value.

4. Select your preferred operator and enter in your preferred value.

5. To add additional And/Or statements, select the word And in the top left corner. A drop-down
appears.

6. Choose which And/Or statement to add and then select the Preferred Operator.
7. Enter in your Preferred Value to complete your additional statement.
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8. Click OK.

l Select the X to delete a single statement.
9. Select the And statement in the top left corner to begin clearing all And/Or statements.
10. From the drop-down, select the option Clear All.
11. Once done, select Apply and then click OK.

Group Columns
Sometimes you may want to organize your information into groups. Instead of filtering your inform-
ation down to one value (e.g., unit of measure = Ton), you can look at your information with a separate
group for each value (e.g., a group for Tons, a group for Cubic Feet, etc.).

Step by Step — Group Columns

1. From the CBS register, group the Unit of Measure column by dragging it into the grouping area
(where it says “Drag columns here to group”).

l Notice that the cost items in the register are now grouped together by their units of meas-
ure, and each group of cost items is subtotalled by costs, hours, quantities, etc.

2. To ungroup, right click in the grouping area and select Clear Grouping

l The column returns to its original location

You can group by more than one column to have multiple grouping levels.

Saved Views
Once you have set up a view the way you like it, you can save the view so you won’t have to configure
it again later. InEight Estimate also comes with some pre-built views to help you organize the screen
the way you want to see it.

Views are accessed from the Saved Views menu in the top right portion of a register.
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The following steps assume you have made changes to your register view and want to save it for future
use.

Step by Step — Create a Saved View

1. In the CBS register, click on the Saved Views drop-down menu and the Save disc icon appears.

2. Click on the Save disc icon.

l The Save Current View window appears

3. Enter the View Name, then select OK.

l The new view displays in the drop-down menu

Saved views are user-specific; you will only see your own saved views when you are logged in.

Subtotal Calculator
You can select multiple cost items and use the Subtotal Calculator to summarize and display Unit Cost,
Man-Hours/Unit and Units/Man-Hour. Highlight a cost item in the CBS and right click on a Total Cost
column (e.g., Total Cost (Forecast), Labor Total Cost, Owned Equipment Total Cost, etc.). Select Sub-
total Calculator from the right click menu, and enter the number of units to use in your calculation.
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Register Running Totals
You can select multiple rows in a register and see the sum total amount at the bottom of the register.

For example, you can hold down the CTRL key and multi-select cost items 2.1.1, 2.2.1, and 2.3.2 in the
CBS register, you can see the sum of the three selected cost items toward the bottom row of the
register.
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Estimate calculates subtotals for quantities when the UOMs match. Superior cost items are not included
in the subtotals to avoid any double counting in the subtotal.

It is not necessary to export data to Microsoft Excel and run separate calculations to better understand
costs of multiple items. The sigma symbol shows in the subtotaled row to indicate it is the total of the
selected rows.
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Find Feature
The Find feature lets you search across all columns in the register with a single operation. The match-
ing results are then highlighted in yellow. A scroll bar annotation is provided to indicate the rows in the
grid containing matches. This lets you easily navigate to the search results in the register.

The Find feature also includes the flexibility to perform more precise searches using various syntax in
the search bar. The Find search bar shows the currently selected and total number of search results.

If you type in two words, such as total cost, the grid considers them as individual conditions and
selects records that contain either total or cost.

Search Syntax Example

+ To find records that contain both search terms
like total cost, type + before the second word.
For example: total +cost.

- Type - to exclude records that contain a specific
word, for example: total-cost. You can combine
different operators. Use + and - to select records
that contain both pay and item, excluding
records that contain assignment. For example:
pay +item -assignment.

"quotes" To search for a string that contains a space char-
acter, you need to enclose this string in quotation
marks. For example: "total cost".

: To search against a specific column, type the
first letters of the column's display name plus a
colon character. For example: optional: unas-
signed. Now the grid displays records containing
unassigned in the optional code column.

If you add another column-specific condition, the grid joins them using the + logical operator. Then the
record shows the result that matches both options. The same happens when you join a column-specific
condition with the one applied to all columns. An example of this search criteria looks like this:
optional: unassigned +"pay item".
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Step by Step — Find Feature

1. From the Cost Breakdown Structure (CBS) Register, bring up the Find feature using CTRL+F.

2. In the search bar, type inMaterials.

3. When all the searches are highlighted in yellow, use the up or down arrows to the right of the
search bar to navigate to the next search result in the register.

4. To add the Find feature to the register functions header, select the Options icon to the far right of
the search bar. Then select Always Expanded.

5. To search in a specific column only, select the Options icon to the far right of the search bar.
Then select Search in Selected Column Only. Search a specific term in your selected column.

6. To close the Find functionality, click the Close icon to the left of the search bar. You can also
hold down the Shift key and then select the F3 key to use this feature.

A drop-down can be used to see a list of previous searches.
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Library Overview
The Library is where you set up and maintain master information that imports into your projects, includ-
ing resource rates, tags, units of measure, cost item assemblies, and master breakdown structures. It is
also where security roles and permissions are configured.

You access the Library from the Backstage view in Estimate. Click the Library button to open.

You can also access the Library by clicking on the Library icon, when on the InEight Estimate landing
page.

When the Library opens, you see ribbons available under the main menu tabs. Each menu tab has
unique sections which hold the necessary forms.

Library Tabs
The Library has four tabs which organizes the forms under sections:

l Setup

l Estimate

l System

l Integrations
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The Actions and More Actions tabs show when you open a register and contain functions for the
register you have active.

Setup Tab

Name Description

1 Job Prop-
erties

The job properties maintained in the library will serve as the default settings
for any new estimate that is created from scratch. When creating a new job it
will inherit all the job properties set in the master library.

2 Foundation
Setup Data

A master set of account codes, tags, and units of measure. When a new folder
is created, the master set is automatically copied from the Library to the new
folder.

3 Address Book Used to store and maintain all information pertaining to the companies with
whom you work and contact regularly (subcontractors, vendors, architects,
etc.).

4 Trench Cal-
culator

Stores and maintains common trench configurations that are used from pro-
ject to project.

5 Shift Rate
Calculator

Allows you to set up shift rate configurations that you can access at the pro-
ject level.

6 Resources Opens the Library Resource Rate Register where you can create and edit all
resources and resource cost details available for import into your projects.

7 Most Used
Resources

For quick access to the Labor, Equipment and Materials tabs of the Master
Resource Rate Register.

8 Resource
Assemblies

Takes you to the Library Resource Assembly Register where you can set up
resource assemblies to import into individual projects.

9 Cost Item
Assemblies

Cost Item Assemblies are predictive models to quickly and accurately estim-
ate elements of a job that can be repetitive in nature on the job or from job to
job.

10 Standard
Tables

The Standard Tables are used to create and/or list job-level table data that is
accessible by any of the Cost Item Assemblies that exist in a job. The Stand-
ard Table Record allows the user to create and or modify a Table record. The
Standard Table Register lists all the job level tables created / available in the

Overview - Setup Tab
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Name Description

project.

11 User Roles Opens the User Roles Register that shows user role names and their descrip-
tion which you can use in the Access Control Register.

12 Access Con-
trol

Allows you to customize your system permissions by restricting destinations
or commands that only designated roles should have access to.

13 Reports Opens the Reports window, where you can access all system reports and con-
figure the default report settings.

Estimate Tab

Name Description

1 Cost Break-
down Struc-
ture (CBS)

Opens the Library Cost Break Structure register, where you can define the CBS
that will automatically import when a new project is created.

2 Account
Code Util-
ization

Used to roll estimate line items into an account code hierarchy and benchmark
against historical projects in a way that is consistent across projects.

3 Work Break-
down Struc-
tures

Opens the Library Work Breakdown Structure register, where you can define
additional Work Breakdown Structures that will automatically import when a
new project is created.

4 Master
Workbook

Opens the master Microsoft Excel template which will be embed into each new
estimate job folder. The cells in the embed excel workbook can be linked to
send information to or from InEight Estimate Fields.

5 Indirect Cost
Items

Takes you to the Library Cost Breakdown Structure Register where you can edit
and define indirect cost items.

Overview - Estimate Tab
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Name Description

6 Job Finance Takes you to the Library Cost Breakdown Structure Register where you can
edit the Job Financing cost item.

7 Price % Add
On

Takes you to the Price % Add On record, where you can define the price % add
to be included in the Library CBS.

8 Prime Bond Opens to the Library Prime Bond record where you can define the bond tables
that will import automatically when a new project is created. 

9 Reports Opens the Reports window, where you can access all system reports and con-
figure their report settings.

System Tab

Name Description

1 Customize Window to customize the field titles that are displayed throughout vari-
ous screens in the system, including all cost category titles, user-defined
Tags, and more.

2 Saved Views Allows you to save your views onto a disk or load from a disk. 

3 Titles Allows you to save titles onto a disk or load from a disk. 

4 Colors Allows you to save your colors onto a disk or load from a disk.

5 Output Set-
tings

Allows you to save your output settings onto a disk or load from a disk.

6 Quantity
Item Set-
tings

Save your mapped quantity item source settings to your computer. You
can then load the saved mapped settings into your Quantity Item
Sources Register.

7 External Menu to not only generate reports created by Estimate, but also to open

Overview - System Tab
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Name Description

Reports programs, folders, documents, reports, or Internet resources with the asso-
ciated program.

8 External
References

Allows you to open programs, folders, documents, reports, or Internet
resources with the associated program.

9 Help Section Offers you links to Estimate’s general Help menu, information about
Estimate (i.e., version number, system information, tech support, etc.),
What’s New in the new version, and InEight’s external website.

External Reports

The External Reports menu lets you generate reports created by Estimate, and also lets you open pro-
gram files, folders, documents, or other internet resources.

Each menu item can be added to the External Reports menu. Upon selecting one of the menu items, the
associated program, file, folder document or URL will open, as defined by the command entered in the
Open column.

Page 30 of 516 InEight Inc.  |  Release 20.2

Library Tabs Estimate Help Topics



To add a new menu text, first select the Add button and enter a name in theMenu Text field, and then
type in the location of the new Menu text under the Open field.

Customized Job Folder Tags match the view of the fields in the Job Properties form.
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Integrations

Name Description

1 Publish Estimate to
a New Project

Lets you publish an estimate job to a new project. This
requires the installation of the data provider plug-in.

2 Publish Cost Items
to Active Project

Lets you publish cost items to an active project. This requires
the installation of the data provider plug-in.

3 App Logs Lets you open the Estimate application logs in Project Suite,
view log details, and export to Excel.

Overview - Integrations Tab

App Logs

The InEight Project Suite App Log lets you drill down to the Detail level which helps you find, analyze
and solve application errors.

Page 32 of 516 InEight Inc.  |  Release 20.2

Library Tabs Estimate Help Topics



InEight Inc.  |  Release 20.2 Page 33 of 516

Estimate Help Topics Library Tabs



Library Job Properties
The Library Job Properties form serves as a template for new jobs. Some of the tabs on the Library Job
Properties form hold basic settings that will require a default selection which will apply to all new jobs
created from scratch. Time can be saved when utilizing Library Job Properties, because the data and set-
tings you fill out will be automatically imported into a new job. Once imported, these settings can be
changed at the job level if necessary.

It may be helpful to complete the following tabs / fields at the Library level:

l Overview Tab Notes Field:  Filling out the Notes section at the Library level would be helpful
for any instructions or reminders that you want to display on all projects’ Job Properties form.
For example, “Always double check currency exchange rates”

l Cost Basis Tab:  Shift arrangements may or may not be standard across all projects, as well as
wage rates and scales. The cost basis default rules should be established within the library.

l Fuel Cost Tab:  Entering a default fuel cost here will factor with the utilization of your equip-
ment to be included in your equipment rates
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Library Foundation Setup Data
Foundation Setup Data is where all drop-down options within Estimate fields are stored. These can
serve as category labels, alternate structures or validated tag fields. The different validated fields are
organized into tabs on this form.

You should be aware of these category labels:

Category Labels

Name Definition

Account
Codes

These codes will be set up on the back end and will help you compare your cost and
production rates to similar cost items in past projects.

Tags Some tags are already set up for you. Additional tags can be created and used to
group and filter your items.

Work Break-
down Struc-
tures

Use this format when you need to have multiple variations and summary reports of
an estimate. WBS retains the same relationships between items as in the original
estimate and only changes the view and how items are arranged in hierarchy.

Units of Meas-
ure

These are standardized to relate to one another by a conversion factor. If you need to
create a new unit of measure, you will need to reference it to a base unit of measure
and can include a conversion factor to allow you to convert back and forth between
English and Metric.

Currencies The default currency is set to U.S. Dollar, but you can also enter the exchange rate
for other currencies (such as Canadian) so you can estimate with whatever currency
you need. Multiple currencies can be used in the same project. The system base cur-
rency can be changed from USD in the backstage view settings, but is a global
change for the entire estimate environment.

When you create a new job folder, all category labels defined in the Library Foundation Setup Data
Register will be copied to the new job folder automatically.
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Resources
InEight Estimate refers to labor, equipment and material items as Resources. You will use these
resources as the basic building blocks used to detail the costs in your estimates.

InEight Estimate organizes resources into seven types:

Resources

Name Description

Labor The human resources that perform direct or indirect work. Direct labor is typically
classified by trade (e.g., pipefitters, electricians, iron workers) and title (e.g., fore-
man, journeyman, laborer).

Construction
Equipment

Owned construction equipment.

Rented Con-
struction
Equipment

Construction equipment rented from a third party.

Installed Mater-
ials

Materials that will remain installed on site after the project is completed, (e.g., con-
crete, piping, aggregate).

Installed
Equipment

Equipment that will remain installed on site after the project is completed, (e.g.,
boilers, heat exchangers, vessels, cooling towers).

Supplies Expendable items that will not be permanently installed (e.g., small tools, con-
sumables).

Unique Resources that are of a “unique” nature and do not fit well into the other types (e.g.,
dump fees, hauling charges and equipment rented by the month).

After creating a new job folder, you can import a filtered set of resources from the Library into the new
project. This is done on the Cost Basis tab of the Job Properties form.

In the following section, you will learn more about the resources stored in your Library in the Library
Resource Rate Register.

Library Resources Register
To open the Library Resources Register, select Labor from the Master Resources ribbon.
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Overview – Library Resource Rate Register

Name Description

1 Tabs There are tabs along the top of the form for each of the seven resource types, in
addition to an All tab that holds the resources of all types.

l Notice that you are on the Labor Tab

2 Resource
Code

Each record (or row in the register) represents a single resource.

3 Description The Description provides more detail about the resource.

4 Resource
Rate per
Unit

This is the resource cost per unit.

5 Utilization
Count

Tells you how many units of that resource are being used in the job.

6 Unit of
Measure

Each resource is defined with a Unit of Measure.

7 Register This register includes columns for the resource attribute categories so you can fil-
ter and group your resources.

Source Job and Source System name fields

The Source Job field provides visibility into the jobs from which the data may have originated from.

The Source System Name helps to see the source of the data when integrating with other systems.
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Resource rate add and search tips:

l You cannot add new resources on the All tab.
l You can search for resources in the Resource Rate Register using the ‘Find’ field.

Next you will take a look at the different types of resources and how they differ when we drill into
resource rate records from each category.

Labor Resources
Looking at your Labor resources more closely, you will see all the Resource Codes for the Labor
resources begin with an L. This is a best practice for naming and organizing your resources, but you
can also use another organizational method of your choice.

Resource Rate Record
If you need to add cost to a resource, adjust a rate, or just view a more detailed breakdown, you can
open the resource’s rate record. From the Library Resource Rate Register, double click on the row
header for the resource you need to view in greater detail.

Overview – Resource Rate Record

Name Description

1 Record The record references the resource you are editing.

2 Charge Rate The Charge Rate tab is the tab the record defaults to and is where you define
the cost of the resource.

3 Scale Buttons The Scale buttons only show up on labor resources. They are used for defining
regular time, overtime and double time rates for the resource.
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Name Description

4 Cost Cat-
egory Break-
down

The Cost Category Breakdown is where you enter the costs for the resource.
The categories will depend on what type of resource it is (e.g., equipment
resources will have equipment cost categories and materials will have material
cost categories).

5 Special
Instructions /
Base Wage
Factors

The right side of the record will have additional options to help you define the
rate. These options change depending on what type of resource it is.

Name Description

6 Setup There is also a Setup tab where you can define the resource’s attributes, plus other
settings. These attributes are used for filtering which resource rates to load into a
new estimate.

7 Cost
Driver

Labor resources default Cost Driver is CI Duration which means their costs are
driven by time.

8 Default
Quantity

The Default Quantity is typically set to 1 for most cases if you are bringing in the
resource you are using at least one.

The following steps walk you through how to create a new labor resource.

InEight Inc.  |  Release 20.2 Page 39 of 516

Estimate Help Topics Resource Rate Record



Step by Step — Create a Labor Resource

1. From the Library landing page, on the Setup tab, click on Resource Rates from the Master
Resources section.

l The Library Resource Rate Register opens

2. Select the Labor tab.

3. Right click on any row header and select New.

l A new Labor Rate Record displays

4. In the Code field, type L + [your initials].

5. Press the Tab key.

6. Fill in the Description field.

7. Click on the resource’s Setup tab and select Standard Labor Rate File from the Resource File
drop-down list.

8. Select a location for the Geographic Area.

9. SelectWage Zone A for Wage Zone.

10. Select a labor type for the Organizational Category.

11. For Tag 1, select a code.

12. For Tag 2, select a code.

13. On the Charge Rate tab, enter a dollar value for your Labor Base.

14. Expand Labor Burden and under Labor Fringes, type in a dollar value for Pension and Sub-
sistence.
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15. Define an overtime and double-time rate for the resource. Select the checkbox for Use Base
Wage Factors for Scales 2 and 3.

16. Set the Scale 2 Factor to 1.50 x Base Wage and Scale 3 Factor to 2.00 x Base Wage.

17. Click OK, to close the record.

Construction Equipment Resources
l Similar to Labor Resources, Construction Equipment Resources are also duration driven
resources by default

l They contain cost categories for ownership and operation costs

These resources are the fleet of construction equipment that you own.

Rented Equipment Resources
These resources represent the construction equipment that you rent.

l Rented Equipment Resources are also duration driven resources by default

l Contain cost categories for rental and operation cost as well as additional fees

l On the Rental Construction Equipment Record, you will notice a new tab named Quote

l Quotes will be discussed in detail in Lesson 8 – Quote Management

l You will also note the Tax section. You can check the box to Apply Standard Tax, which pulls
the Sales Tax percentage defined on the Cost Basis tab in Job Properties, or you can manually
specify a unique sales tax rate
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Step by Step — Create a Rental Equipment Resource

1. Open the Library Resource Rates Register.

2. Select the Rented Construction Equipment tab.

3. Right click on any row header and choose New; a new Installed Rented Equipment Rate Record
displays.

4. In the Code field, type RECR + [your initials], then press Tab.

5. In the Description field, type Crane 110 Ton.

6. Click on the resource’s Setup tab and select Standard Rental Rate File from the Resource File
drop-down list.

7. Select a resource from the Organizational Category drop-down list.

8. Move back to the Charge Rate tab to follow the step by step on the next page.

Equipment Consumption Rates
The Construction Equipment and Rented Construction Equipment Resource Rate Records include con-
sumption rates that will factor with the fuel cost you define on the Library Job Properties > Fuel Cost
tab to give a fuel cost for your equipment rate.

The below figure shows where consumption rates are defined on the Construction Equipment Resource
Rate Record.

Non-Hourly Rate Calculator
For owned and rented construction equipment, the rate entered must be hourly. If your rate is weekly or
monthly, you can use the Non-Hourly Rate Calculator on the Construction Equipment Resource Record
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to come up with the hourly rate.

Step by Step — Non-Hourly Rate Calculator

1. Refer back to your last entry's rate amount. Under Non-Hourly Period Charge Rates on the right,
check the Calculate Non-Hourly Period Charge Rates checkbox.

2. On the resulting prompt, click OK.

3. In the Period field, select Weekly.

4. In the Amount Per Period field, type in a number value.

5. Type in a number of hours in the Hours Per Period field.

6. Click OK to close the record.

Installed Materials, Installed Equipment & Supplies Resources
l Comparing the Installed Material & Equipment resources to those covered so far, you will note
that the unit of measure is not Hour for materials, but it is specific to the kind of material. It is a
quantity-driven resource, as opposed to duration-driven like your labor and equipment resources

l You will also note the tax field can pull your standard tax settings from the Cost Basis tab in Job
Properties, or a unique sales tax rate can be manually entered in each record

l On record for these resource types, you will notice a new tab named Quote. This tab shows up
here because you may have to shop around and get quotes for these resources

l Quotes will be discussed in detail in Lesson 8 – Quote Management
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l In the Setup tab you will see a field named Waste % Add-on. Here you can account for approx-
imate waste percentages

l Cost categories will differ on each type of resource record

Above is an example of the Installed Material tab in the Library Resource Rate Register.

The following steps walk you through how to create a new material resource in InEight Estimate.

Step by Step — Create an Installed Material Resource

1. Select Resource Rates from the Library landing page.

l The Resource Rate Register displays

2. Select the Installed Material tab.

3. Right click on any row header and select New from the drop-down menu.

l A new Installed Material Rate Record displays

4. In the Code field, type MGBP + [your initials], then press Tab.

5. In the Description field, type Brick Pavers.

6. Select a unit of measure from the Unit of Measure drop-down list.

7. On the resource’s Setup tab, under Resource File select Standard Material Rate File.

8. On the Charge Rate tab, expand Materials and enter a number valuein the Installed Materials
Amount field.

9. Click OK to finish adding this resource.
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Unique Resources
The Unique resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

l The Unique resources are the only resources that have all cost categories available, as well as all
units of measure

l You will also note the tax field which can pull your standard tax settings from the Cost Basis tab
in Job Properties, or a unique sales tax rate can be manually entered in each record

l Quotes will be discussed in detail in Lesson 8 – Quote Management
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Resource Assemblies
A Resource Assembly is a group of resources. You can create an assembly once and then reuse it as
needed in multiple cost items whenever the same combination of resources is needed.

The most common use for an assembly is to group labor resources into crews (e.g., Pipe Crew, Con-
crete Crew); however, any resource (equipment, materials, etc.) may be grouped into an assembly. Util-
izing assemblies allows you to estimate faster, since you can add and manage an entire group of
resources at once.

You can create assemblies in the Library and import them into job folders the same way you import
resources.

Library Resource Assembly Register
To open the Library Resource Assembly Register, select the Library icon, then select Resource Assem-
blies from the Master Resources section of the Setup tab.

Overview – Library Resource Assembly Register

Section Description

1 Each row in the register represents a single resource assembly and is defined with an
Assembly Code and Assembly Description.

2 Each assembly can be expanded by clicking the plus icon next to its Assembly Code.

3 Expanding an assembly reveals the list of resources that make up that assembly.

l Best practice for creating Assembly codes is to use C for Crew Assemblies, M for
Material Assemblies, etc., however you can have labor, equipment, and materials in
the same assembly
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Resource Assembly Record
To open an existing Resource Assembly Record, right click on the row header of an assembly (row) on
the Resource Assembly Register and select Open.

Overview – Resource Assembly Record

Name Description

1 Assembly
Code and
Description

Each assembly is defined with an assembly Code and an assembly Description.

2 Quantity
and Unit of
Measure

Each assembly has a quantity and unit of measure. The default is 1 EA. For
crew assemblies with all hourly duration driven resources, it is a best practice to
change the Qty to Hour, so that when used on a cost item, it will show you the
assembly’s unit cost per hour.

3 Assembly
Details

The rows in the Assembly Details register represent the resources that make up
the resource assembly.

4 Notes An area where the estimators make notes for records related to the resource
assemblies for work orders which is commonly performed by a type of crew.

Productivity Rate Indicator in the CBS Register

The Productivity Indicator shows the field that contains the as-entered value and is driving the estimate
for that cost item. This appears as an arrow aligned to the left of the cell as shown below.
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Being able to see productivity drivers on the CBS register makes it easier to review and modify the
estimate as a whole while reducing the potential to accidentally overwrite a manually entered data.

Follow the step by step below to create a Resource Assembly.

Step by Step — Create a Resource Assembly

1. From the Library landing page, under the Master Resources section of the Setup tab, select
Resource Assemblies.

l The Resource Assembly Register is shown.

2. Right click on any row header and select New from the drop-down menu.

l A new Resource Assembly Record is shown.

3. In the Code field, type CEXC + [your initials] as the unique code for the assembly.

4. Add a description in the Description field.

5. In the Assembly Details register at the bottom of the screen, click in the Resource Code column
in the first blank row, and then select the Resource icon that appears in the cell.

6. On the Labor tab of the resulting register, select the resource with the Description: LL2Laborer
and click OK to add this resource to the assembly.

7. Add two additional resources.

You can use the Ctrl and Shift keys to select multiple resources at once.

8. Click OK to save and close the new assembly.
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Importing Resources
The following procedures inform you how to setup resources in InEight Estimate from an excel sheet.

Use of this lesson will draw from other sections of InEight Estimating Manual. Basic understanding of
the Sort, Group, Filter, Excel integration functionality in InEight Estimate is required.

Open Resource Rate Register
You can create resources within the Resource Rate Register. This is the location to build out the struc-
ture of those resources.

Step by Step — Opening the Labor tab

1. Open the Job Folder or Library that you’re going to be working in.

2. From the Ribbon, select the Setup tab.

3. Under the Resources section, select Resource Rates. The Resource Rate Register opens.

4. Select the tab you want to add resources to.

The layout of this register and excel file is up to the organization and the decisions that are made dur-
ing the detail design phase. A basic excel file will be provided to your organization as a starting point
to work from. If that can’t be located, you can easily build one utilizing the views within InEight Estim-
ate.

Creating A Labor Saved View - Resource Rate Register

You can create a view to mirror both the register and excel sheets to easily bring information back and
forth from the two applications.

Example of columns:

l User Defined 1
l Resource Code
l Description
l Resource File Description - Validated field
l Geographic Area - Validated field
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l Wage Zone - Validated field
l Organizational Category - Validated field
l Tag 1 - Validated field
l Tag 2 - Validated field
l Currency - Validated field
l Default Quantity
l Use Base Wage Factors - Scale Factors
l Scale Factor 2 - Scale Factors
l Scale Factor 3 - Scale Factors

For more information on Validated Tags field, see Validated Tags topic. Scale Factors aren’t required if
you are manually applying rates to each cost category scale.

The view should appear as shown below with User Defined 1 in the first column. This field is used for
sorting and arranging data accurately moving between Estimate and Excel. You are not limited to UDF
1 and can choose to utilize a field of their choice for sorting.

Setting up the excel file
Go to the Excel sheet and make sure the information in the columns shown in the screenshot are filled
out. Basic concepts to keep in mind regarding the excel file:

Sort Code - This column needs to have a high sequential number such as 10000. This is very important
to assign as it will help us authenticate all the labor rates.

Resource Code - A unique Naming convention to be assigned to every labor resource. In this example
we have all labor resource starting with a L followed by the letters that represent the resource descrip-
tion.

Labor Base - The base wage of the labor resource is entered here. Estimate does not allow $ sign to be
pasted, which is why the cells for the Base column are formatted to Number.
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Creating the resource

Follow this procedure once you have information filled out in excel.

Step by Step — Creating the Resource

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.

3. Highlight the cells you want to bring into the estimate.

4. Copy the cells using right click and selecting Copy from the context menu.

5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Labor tab of the Resource Rate Register.

7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking
Are you sure you want to insert the selected values?

8. Select Yes to confirm inserting the selected values.
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9. The cells you copied from the excel sheet are now copied into the Resource Rate Register. The
Sort code data is pasted in the User defined 1 column. Resource Code & Resource description
data is pasted as well.

10. For Make sure the sorting is on User Defined 1 column. This allows us to see the information
being sorted similar to our data in excel file. Base Wage Factors need to be flagged to turn on
with the check box. Your first copy and paste should have activated them. You need to copy and
paste again in order to apply the factors.

Resource Cost Details

Labor resources are now in the system a user can apply rates to those resources.
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Step by Step — Resource Cost Detail

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

3. Create a view to mirror the accompanying excel sheet or create one to bring in the associated
resource cost in the details register.

4. From the Saved views drop down, select the Labor view to filter down to only labor resources.

5. Right click a column header and select Column Chooser.

6. Drag and drop the columns into the view identified below.

Example of columns – The level of detail and utilization of specific cost categories is a decision for
each organization:

l User Defined 1 - Non editable fields from resource rates register
l Resource Code - Non editable fields from resource rates register
l Description - Non editable fields from resource rates register
l Resource File Description - Non editable fields from resource rates register
l Geographic Area - Non editable fields from resource rates register
l Wage Zone - Non editable fields from resource rates register
l Organizational Category - Non editable fields from resource rates register
l Scale - Non editable fields from resource rates register
l Labor Base
l Travel
l Premium
l Holiday
l Savings
l Pension
l Vacation
l Subsistence
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l Health & Welfare
l Apprenticeship
l Undefined Fringe 1
l Undefined Fringe 2
l Undefined Labor Fringes
l Bodily Injury & Property Damage
l Workers Compensation
l Undefined Insurance1
l Undefined Insurance2
l Undefined Labor Insurance
l FICA
l FUTA
l SUTA
l Undefined Tax1
l Undefined Labor Taxes
l Undefined Labor Burden
l Undefined Labor
l Construction Supplies
l Undefined Materials
l Undefined
l Billing Rate
l Billing Rate Markup
l Billing Rate Markup %

Filter/Sort/Paste - Resource Cost Details Register
The Labor upload view brings in the columns required to enter Labor base, burdens etc. Every Labor
resource has three rows created with Scales 1,2,3. The Scale Column is used to setup Straight time,
Over time, Double time.
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Step by Step — Filter Resource Cost Detail Register

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 1.

3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.

5. Go to Estimate. Right click and select Paste from the context menu.

6. You will be prompted with a Are you sure you want to insert these values? message as before.
Select Yes to continue.
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Manual Set-Up of Scales 2 & 3 – Optional
If the organization wants to have more in-depth cost details for each scale rather than using scale
factors the same procedure will be utilized to copy Labor burden, fringes, and other add-ons to setup
Scale 2 & Scale 3.

For Base Wage Factor Columns will not be active if your organization is using method 2.

Resource Rate Register

Resource Cost Details Register

Step by Step — Manual Setup of Scales

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 2.
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3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.

5. Go to Estimate. Right click and select Paste from the context menu.

6. You will be prompted with a Are you sure you want to insert these values? message as before.
Select Yes to continue.

7. Follow the same procedure for scale 3.

Non Labor Resource Setup

The same principles can be applied for the other resource types within InEight Estimate. This procedure
covers installed material, but can also be used for the other six resource types.

Creating A Materials Saved View - Resource Rate Register
Create a view to mirror both the register and excel sheets to easily bring information back and forth
from the two applications.

Example of columns

l User Defined 1
l Resource Code
l Description
l Resource File Description - Validated Tag field
l Geographic Area - Validated Tag field
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l Wage Zone - Validated Tag field
l Organizational Category - Validated Tag field
l Tag 1 - Validated Tag field
l Tag 2 - Validated Tag field
l Currency - Validated Tag field
l Apply Standard Tax - Validated Tag field
l Unique Sales Tax
l Unit of Measure - Validated Tag field

Creating A Material Resource
Follow the step by step once you have information filled out in excel.

Step by Step — Creating the Resource

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.

3. Highlight the cells you want to bring into the estimate.

4. Copy the cells using right click and selecting Copy from the context menu.

5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Installed Material tab of the Resource Rate Register.
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7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking
Are you sure you want to insert the selected values?

8. You will be prompted with a Are you sure you want to insert these values? message. Click
Yes to continue.

Create A Material Saved View - Resource Cost Details Register
Installed Material Resources are now in the system. You can apply rates to those resources. Create a
view to mirror the accompanying excel sheet or create one to bring in the associated resource cost in
the details register.

Step by Step — Material Saved View

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

3. Create a view to mirror the accompanying excel sheet or create one to bring in the associated
resource cost in the details register.

4. From the Saved views drop down, select the Installed material view to filter down to only mater-
ial resources.

5. Right click a column header and select Column Chooser.

6. Drag and drop the columns into the view identified below.
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Example of columns – The level of detail and utilization of specific cost categories is a decision for
each organization:

l User Defined 1 - Non editable fields from resource rates register
l Resource Code - Non editable fields from resource rates register
l Description - Non editable fields from resource rates register
l Resource File Description - Non editable fields from resource rates register
l Geographic Area - Non editable fields from resource rates register
l Wage Zone - Non editable fields from resource rates register
l Organizational Category - Non editable fields from resource rates register
l Unit of Measure - Non editable fields from resource rates register
l Currency - Non editable fields from resource rates register
l Total - Non editable fields from resource rates register
l Installed Materials
l Undefined Materials
l Sales Taxes
l Undefined Fees
l Undefined
l Billing Rate
l Billing Rate Markup
l Billing Rate Markup %
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Quantity Checking
The Quantity Checking feature allows you to compare the quantity of a superior cost item to the sum of
its relevant subordinate cost item quantities. This setting enables the use of the Quantity Check and
Quantity Warning columns in the Cost Breakdown Structure. The use of these columns can assist in
confirming whether or not your quantities are correct.

The subordinate cost item quantities need to have the same unit of measure as the superior cost item
before you are able to choose the Quantity Check column.

In the example below, break a concrete pour cost item into four subordinate parts. The Forecast (T/O)
Quantity of the superior item will be 156875.00 tons of concrete. Start by dividing each of the four
parts into 35000.00 tons each. Once you have broken out this concrete pour, determine if you need a
fifth pour or if you should distribute the remaining quantity to the four pours. The factors you keep in
mind are the trips and time involved in the extra pour vs capacity of equipment.

Step by Step — Quantity Checking

1. From the Ribbon, select the Setup tab.

2. Under the section Initialize, select Job Properties. Then select the Cost Basis tab.

Quantity checking starts by turning the feature on in the Job Properties. If you want to have
quantity checking turned on for all jobs in Estimate, then this setting needs to be turned on in the
Master Job Properties. The Master Job Properties is located in the Library.

3. From the Rules data box, select the Activate Quantity Checking check box.
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4. Next bring a couple of columns into your view on the Cost Breakdown Structure (CBS) Register.
Right click on the column header and choose Go To Column.

5. The Go To Column dialog box appears. Have the Include columns that are not currently in
the view check box selected.

6. Click OK when you have selected your preferred columns.

Next, toggle the check box for the Quantity Check column.

7. As you check Quantity Check for the four batches of Concrete, the superior cost item Quantity
Warning turns yellow. This is indicating a quantity warning. Hover your mouse over the superior
cost item Quantity Warning column. Then, an overlay message appears showing the quantity dis-
crepancy. Apply this discrepancy to the Subordinate cost items. That way, the superior cost item
with be the sum of the parts.

8. The remaining quantity is 16875.00 tons which does not warrant a fifth pour.
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Job Creation
In InEight Estimate, a job represents the folder containing your estimate (or version of your estimate),
including its related bid items, cost breakdown structure, resources, quotes, and change logs. All the
jobs in your organization are stored in the Job Register.

To create a new job, you can choose from multiple options available when selecting New in the InEight
Estimate Backstage view. The image and table below show the available options.

Option Description

Scratch Creates a new job folder from scratch that is empty, containing no existing data.

Template Creates a job from an existing template, selected from the Template Register. For
more information, see "Templates" on page 226.

Existing
Job

Creates a job from an existing job, selected from the Job Register. For more inform-
ation, see "Copy an Existing Job" on page 224.

Bid Wiz-
ard

Uses a wizard tool to create a new job by selecting pay items and/or cost items from
an existing source job. For more information, see "Bid Wizard" on page 237.

Archive Creates a new job from an Estimate Job Archive (.est) File. For more information on
creating and using job archives, see "Archive and Restore Jobs" on page 354.

Snapshot Creates a new job from a register containing snapshots for all jobs. You can filter the
register of snapshots to find the snapshot you need. For more information, see "Snap-
shots" on page 248.

Create a Job from Scratch
When you need a clean estimating environment that is not based on any past work, select the create a
new job from Scratch option. Creating a job from scratch gives you complete flexibility and ensures no
assumptions are carried over from past estimates.
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Platform Project association to job
In Estimate, you create a job that represents your project estimate and all the information associated
with it. This job must be associated with a project in InEight Platform that represents the overall con-
struction project being managed by your organization, from planning to execution and turnover.

When you select to create a new job, in the New Job window, select a project in the Core Project field
drop-down list to associate to your job in Estimate. Core project refers to a project in Platform.

Because projects in Platform are organized in an Organizational Breakdown Structure, associating your
job (estimate) to a project in Platform allows your estimates to be included in that organizational struc-
ture.

After the job you create is associated to a Platform project, in the Job Register, you can view the job in
the context of your organization breakdown structure. In the example below, the job register is filtered
to the Tantalum Group > Estimating > Site Work level of the organization. Under project ID number
5013592, you can see two jobs, the original estimate and a second version.
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For more information, see Job Register.

Create a new job from scratch

1. From the Backstage view, select to create a new job from scratch.

2. In the New Job dialog box, click in the Core Project field to select a Platform job from the list.

3. Modify the Code field as needed.

4. Enter a description of the job in the Description field.

5. Determine if you want to select the Auto-Update Job in Connected Analytics check box.

6. Click OK to create the new project.
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Job Properties
When you create a new project, the Job Properties form automatically shows. This is where you can
enter basic information about the project. You can access Job Properties on the InEight Estimate land-
ing page > Setup > Job Properties.

Overview Tab
The Job Properties form opens to the Overview tab. The image and table below show the Overview
options:
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Name Description

1 Code The name of the Estimate job. The
name cannot be changed.

2 Status Current state of the job, such as Bid-
ding, Awarded, or Completed.

l When searching for jobs in the
Job Folders list, you can filter
and sort jobs by their status.

l You can set statuses for jobs to
fit your company requirements
in the Jobs Register > Actions
> Tools > Job Status.

3 Project ID Information in this field originates
from the Platform project the estimate
is associated with and cannot be
changed. You can click the Project ID
link to navigate to the project in Plat-
form.

4 Organization Information in this field originates
from Platform.

5 Description You can enter a job description. You
can edit the description any time.

6 Project name Information in this field originates
from the Platform project the estim-
ate is associated with and cannot be
changed.

7 Notes Add estimate related information,
such as when creating multiple ver-
sions of an estimate for the same Plat-
form project. For example, you can
enter This version is per addendum
#1 or This version is per a specified
design change, or This version of the

Overview Tab
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Name Description

estimate is incorporating last minute
changes.

8 Project Notes Information in this field originates
from the Platform project the estim-
ate is associated with. The notes can
be added and edited at any time in
Platform to document specific pro-
ject-level details.

9 Job created by Indicates the user or entity that ini-
tially created the job.

10 Source job The name of the original job that the
job was copied from.

When you copy a job, the new job shows the name of the person who created the copied job, and the
name of the source job the job was copied from.

Cover Sheet Tab
The Cover Sheet tab is where you can define much of the general information about the project. It
includes fields to identify the job’s location, contacts, and bid details.

The following fields are available:

l Job Location

l City, County, Country, Province/State

l Job Type

l Engineer

l Owner

l Architect

l Forecast Start and Forecast Finish

l Bid Date and Bid Time

l Bid Location

l Estimator

l Opening Type and Proposal Type
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l Liquidated Damages (if applicable)

The fields on this tab can be helpful for historical reference and job classification. It is good practice to
complete as many of these fields as possible, so you can reference and find the project later. These
fields can be updated as needed at any time.

Cost Basis Tab
The Cost Basis tab has some important settings that will affect how costs are calculated in your estim-
ate. The settings reviewed below are the ones you need to consider.

Name Description

1 Standard Shift
Arrangements

The default standard shift arrangements are set up as 8 hours per shift, 1 shift
per day, and 5 days per week; this can be changed if a project requires a dif-
ferent standard shift arrangement.

2 Standard
Wage Rate
Composite:

Allows you to indicate what percentage of your labor hours will be regular
time (Scale 1), overtime (Scale 2) or double time (Scale 3). You can enter
these percentages manually, or you can use the Shift Rate Calculator to obtain
a more accurate figure.

3 Lock Cost
Items to Pay
Items:

For this sample job, you will check this box. When Cost Items are locked to
Pay Items, your level 1 estimate structure is controlled by your list of pay
items.

4 Default Cur-
rency:

The default will be set to U.S. Dollar, but this can be changed if needed.

5 Sales Tax
Rate:

This field is not required but may be used to automatically apply a sales tax to
all your material and rental items. The default is set to zero.

Cost Basis Tab Overview
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Shift Rate Calculator
Take a closer look at calculating your shift rates using the Shift Rate Calculator. For this example, you
will walk through setting up 2 shifts for your project.

Step by Step — Shift Rate Calculator

1. On the Job Properties > Cost Basis tab, select the Shift Rate Calculator button.

2. For Shift 1, type a number value of hours in the Monday through Friday Work Hours fields.

l You can enter up to three shifts for the project
3. For Shift 1, type a number value of hours in the Scale 1 fields.

l Scale 1 will be your regular time and Scale 2 will be any overtime

4. Enter a number value for hours in the Scale 2 fields (just Monday through Friday).
5. For Shift 2, type a number value for hours as you did above in Step 3.
6. Click OK.
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l Now you have a blended shift arrangement, and your labor rates are a blend of 64.18%
straight-time and 35.82% overtime

Import Filtered Resources
You may have noticed the bottom portion of your Cost Basis tab called the Resource Filter.

The Resource Filter portion of the Cost Basis tab is the most important part of Job Properties. You use
it to import your labor, equipment, and materials from the Library. Until you import filtered resources,
you have no resources (labor, equipment, materials) in your project.

Updated resource rates can be imported into the Library on a regular basis. It is important to update and
have the “Latest & Greatest” rates available to import into your estimates.

You will import the rates you need using a set of four filters called Resource Attributes. Especially for
labor rates, filtering by these attributes allows you to pare down the master list to just the resources you
need.

Each of the resource filter categories are open for use as determined best by your business. The fol-
lowing are examples of common uses:

Resource Attribute Filters

Name Description

Resource File
Description

This attribute can be used to designate the rate type or the year to which the rates
pertain.

Geographic This attribute is used to designate regions, cities, or provinces based on geo-
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Resource Attribute Filters

Area graphical location of a project.

Wage Zone This attribute is typically used specifically for labor resources. For example, it may
designate the trade and union agreements your labor resources belong to.

Organizational
Category

This attribute can be used to designate what trade or work type your resources per-
tain to.

Resource filters become more specific from left to right, so it makes sense to start with Resource File
Description and end with Organizational Category. The geographic area, wage zone and organizational
category attribute titles can be changed to meet your business needs for filtering resources.

You can sort the filter lists by clicking on the filter category titles.

The following steps walk through using the Resource Filter to import resources.

Step by Step — Import Filtered Resources

1. In your Job, go to the Job Properties > Cost Basis tab, select the Labor Rate resource type.

2. Under Resource File Description, select Standard Labor Rate File.

3. In the Geographic Area, select an Area.

4. For Wage Zone (Work Center), select a Wage Zone.

5. For Organizational Category, select All.

6. Follow the same steps for the remaining resource types.

7. Select the Import Filtered Resources button to bring your selected resources into the job.

l For this example, we'll select the following filters for the Labor resource type:

You must select “Import Filtered Resources” to import your resources. Clicking OK on the Job Prop-
erties form will not import your resources.
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Fuel Cost Tab
On this tab you can enter the cost for fuel (or other energy sources). These unit cost will be multiplied
by the consumption rates entered on each equipment record to define the fuel operating cost of each
piece of equipment. The Cost per UM fields default to $0.00.

Step by Step — Enter Fuel Costs

1. In your job, open the Job Properties > Fuel Cost tab.

2. In Cost Per UM column, enter a dollar amount into the following:

l Diesel

l Gas & Gasoline

l Off Road Diesel

3. Currency should read U.S. Dollar and UM should read Gallon.

Job Folder Tags Tab
On this tab, you can enter tag fields to label your project, so you can reference it later.

Many of these fields are validated fields, meaning you can choose from options in a drop-down list.
The names of these tags and the drop-down values are defined at a master level within the Library
Foundation Setup Data. Some job folder tags are setup to be date fields or numerical fields. These tags
are used to sort and filter the job register as well as for selecting which past estimates to utilize for
benchmarking.
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Schedule Tab
The Schedule tab is used to define the scheduling options for the integration of Estimate with InEight
Schedule, Microsoft Project, or Primavera. The settings you define determine what information is sent
to your scheduling application or tool, and how it’s structured.

l Integrated Schedule – Select your integrated schedule from InEight Schedule, Microsoft Pro-
ject, Primavera, or Manual.

l Schedule Currency – When you use Microsoft Project or Primavera, you can select the currency
type used for the integration. The InEight Schedule and Manual option is set to U.S. Dollar by
default.

l Plug Days - You can select Always use Plug Days when updating Estimate from schedule.

l Cost Item Roll Up – You can select to automatically calculate plug days when rolling up cost
items for scheduling purposes.

InEight Inc.  |  Release 20.2 Page 75 of 516

Estimate Help Topics Schedule Tab



Other Job Properties Tabs
There are several additional tabs on the Job Properties form. The other tabs will not be discussed here
because they are either used for project controls, or they will be covered at another time.

Other Job Properties Tabs

Name Function

Minority Setup Used to set up minority participation goals (for example, DBE or MBE) and you
want to track minority participation goal attainment status during the bid process,

Job Tracking Used to select the code that will be used when tracking job progress, define the
planned production calculation, define the percent complete calculation, define the
forecast methods, and define markup rates for calculating earned revenue on Time
and Expense pay items.

Pricing Used to define how you want the Balanced Unit Price for each of the job's pay
items to be calculated when using the AutoPrice feature. You can also choose form
several options in determining how markup is defined.

Cash Flow Defines the cash flow rules (payment terms) that are used in the calculation of Job
Financing and cost/revenue realization to generate the curves that display on the
Cash Flow form.

Equipment
Maintenance

Used to define the calculation of maintenance labor man-hours based on equipment
utilization, to capture the impact on total man-hours when changes are made that
affect the job's total value.

Benchmarking Used to establish the historical data to be used for benchmarking the current job,
and to define the default benchmark graph display and calculations.

Alternates Used to define Alternate Scenarios, to assess the impact of those scenarios.

Page 76 of 516 InEight Inc.  |  Release 20.2

Other Job Properties Tabs Estimate Help Topics



Pay Item Creation
Pay items typically represent the owner required deliverables a contractor must submit pricing for.
Within InEight Estimate, pay items are used to distribute the cost calculated in the Cost Breakdown
Structure and all markup, fees or contingency calculated in the Price Breakdown Structure to a list of
defined items. This allows the total estimate value to be distributed to a structure that is different then
the CBS. Pay Items are predominantly used by Contractors to prepare a bid sheet. Owners may use pay
items to identify funding sources or for various reporting needs.

Many Bid Forms are organized by grouping bid items for related scopes of work. Pay items within the
Pay Item and Proposal screen can be grouped in a hierarchy by utilizing the Position Code column.

You can create pay items in the Pay Item & Proposal Register. Access this form by selecting the Setup
tab > Pay Item & Proposal.

Name Description

1 Proposal and Item
Recaps

Related to pricing during bid close-out. You can disregard them at this
time.

2 Pay Item Number Represents the bid item number from the client (if they give you one)
or can be a number you specify. This field is alpha-numeric

3 Position Code Controls the way pay items can be grouped, and provide you with an
efficient way to sort.

4 Description You can enter a pay item description.

5 Pay Quantity and Fore-
cast (T/O) Quantity

The Pay Quantity is the quantity provided by the client.

The Forecast (T/O) Quantity is your measured quantity for the item.
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Overview – Pay Item & Proposal Register

Step by Step — Create a Pay Item

1. Open your job and select Setup tab >Pay Item & Proposal from the InEight Estimate landing
page.

l The Pay Item & Proposal Register displays

2. In the Pay Item Number column, in the first blank row, type a number value.

3. Use the Tab key to move to the Description column and type a description.

4. Leave the Pay Quantity at 1.00 and change the Unit of Measure to LS (Lump Sum).

l The Forecast (T/O) Quantity will auto populate to match your pay quantity, but can be
changed later

l You can tab to the next row to create additional pay items if needed

Pay Item Prices by Category
Owners are increasingly requiring more information from contractors as part of their bid submissions.
Many times, this is a further breakdown of a bid price such as separating the price of an item based on
its labor cost, material cost or man-hours. Select columns in the Pay Item & Proposal register enable
users to summarize their pay item prices by up to 10 price categories.

In addition to seeing the price by category, these additional columns also give users better visibility into
how the price is established, including columns for the total cost, total distribution, total markup and
markup percent. These new columns make it easier to verify that the distribution of unassigned cost and
markup are calculated as intended by the estimator.
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Standard Proposal report
The Pay Item Standard Proposal report is located in Execution > Reports > Pay Item & Proposal >
Standard Proposal, and is intended to be used as a bid form, and distributed to other clients, partners,
and contractors. In the Details box below, you can determine which key fields you want included and
shown on your standard proposal report.
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Cost Breakdown Structures
The Cost Breakdown Structure (CBS) is the main form where you will do your cost estimating.

l It is the hierarchy of work activities that make up the estimate

l Each row in the CBS represents a work activity or organizing category and is called a cost item

To access the Cost Breakdown Structure, from the InEight Estimate landing page select the Estimate
tab, then under the Breakdown Structure section select Cost Breakdown Structure (CBS).

Name Description

1 Actions
Menu

Shortcut icons allow you to edit cost items and import items from other sources
such as Excel.

2A CBS Tree
Filter Mode
(drop-
down)

The CBS Tree filter shows the CBS hierarchy and is used to quickly help filter
cost items, instead of scrolling the CBS to locate certain cost items. The CBS
Tree Filter lets you choose between a filter mode or a new navigation mode.

2B CBS Tree
Filter or
Navigation
Mode

Both Filter and Navigation modes on the left side of the page provides you with
the visibility of your entire CBS structure, as well as giving you the option to
navigate and filter throughout the CBS estimate. The Cost Item record can also
be tiled next to the tree to make navigating and filtering possible, while viewing
all the cost item record details at the same time.

3 Left CBS
register

This side of the register contains all of the estimate activities (cost items) that
you create or import, organized into a parent-child hierarchy.

4 Right CBS
register

This side of the register contains numerous columns for cost detail, production
values, and user-defined tags and fields.

Overview – Cost Breakdown Structure (CBS) Register
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Cost Item Terminology
The CBS contains both direct and indirect costs.

l Direct Cost Items contain costs that pertain directly to the deliverables of the project. Therefore,
direct cost items are typically assigned to pay items

l Indirect Cost Items contain overhead costs that are not directly associated with particular deliv-
erable items but contribute to the total cost of the project (e.g., supervision, site office, safety sup-
plies, bid securities). Occasionally an indirect cost item may be assigned to a pay item (e.g.,
Mobilization costs that are indirect but assigned to a Mobilization pay item).

InEight Estimate uses various terms to describe the parent-child relationships of the multiple levels in
the CBS:

Terms Description

Superior A Superior cost item has subordinate (child) items below it that determine hours and
costs.

Subordinate A Subordinate cost item is a child to a Superior cost item.

Terminal A Terminal cost item has no subordinate items. Resources, costs, and production can
only be added at the terminal cost item level.

A Terminal cost item may or may not be a subordinate.
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The levels of the CBS are referred to as Level 1, Level 2, etc., as you drill down in the structure. As
costs are defined on the terminal items, the sum of the terminal cost items roll up to the superior cost
items.

A superior cost item can have no costs of its own; its costs are strictly the rolled-up total from the sub-
ordinate cost items below it.

You can use superior cost items as buckets for organizing your work.

As hours and costs are defined on the terminal items, the sum of the terminal cost items roll up to the
superior cost items.

Work Breakdown Structures
The Work Breakdown Structure (WBS) allows you to reorganize the estimate using different formats
such as Construction Specifications Institute (CSI) MasterFormat or UniFormat. WBS formats are used
when you need multiple variations and summary reports of an estimate. The WBS retains the same rela-
tionships between items as in the original estimate while only changing the view and items arrangement
in the WBS hierarchy.

To view the Work Breakdown Structure View Register, in the Ribbon select the tab Estimate > Work
Breakdown Structures.

Name Description

1 WBS
Tree

Use the WBS Tree to filter to a particular WBS item.

2 WBS
Grid

When a specific WBS item is selected in the WBS Tree,
all subordinate WBS items display in the WBS grid.

3 Cost
Items

The Cost Items associated with the WBS subordinate in
the WBS Grid displays in this data block.

Overview – Work Breakdown Structure (WBS) View Register
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Locked vs. Unlocked Approach
There are two basic approaches to structuring your cost items and pay items. You can choose to work
in a “locked approach” or an “unlocked approach.”

In a locked approach, level one cost items are automatically created and assigned to pay items. This
locked approach works well when pay items adequately represent the work plan. Subordinate cost items
inherit the pay item assignment of superior cost items.

If the Lock Cost Items to Pay Item rule is checked in Job Properties, InEight Estimate will auto-
matically create level 1 cost items in the CBS Register for each of your pay items.

The unlocked approach may work better when the pay items do not adequately represent the work plan.
You can then assign your cost items to your pay items in any arrangement. Companies looking to stand-
ardize the way they estimate and use templates will want to use this approach as it allows you to dictate
the cost breakdown structure. Owners will also typically use the unlocked approach since pay items are
not necessary to their estimating process.
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The option of working in a locked approach vs. an unlocked approach is available in the Job Properties
Form, on the Cost Basis tab under the Rules section. By selecting the checkbox for Lock Cost items to
Pay Item, you are choosing to work in a locked approach.

Take-Off Quantities
In the Cost Breakdown Structure, estimated quantities are entered into the Forecast (T/O) Quantity field
with a corresponding unit of measure. The quantity will default to 1 each when you create a new cost
item and should be updated to reflect the work being estimated.

Forecast (T/O) Quantities are only used for your cost items in the CBS Register.
Pay Quantities are used for final pricing in the PBS and Pay Item & Proposal forms.

Because the training project is a “locked” job, you already have level 1 cost items, and their default
take-off quantities are populated from their corresponding pay item quantities.
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The following step by step walks you through adjusting the default take-off quantities on a couple of
your cost items.

Step by Step — Adjust take-off quantities

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. In the Forecast (T/O) Quantity column, the Forecast (T/O) Quantity is brought over from the Pay
Item & Proposal Register, but here you can adjust it if needed. Practice adjusting the Forecast
T/O quantity of one of your cost items.

l For this example, we’ll change Clearing and Grubbing to 15.00 Acre and Excavation to
40,000 CY.
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Cost Item Creation
During estimate development, you will create new cost items to break down your work into specific
activities. You can create superior and subordinate cost items as needed to organize your work.

Insert Subordinate Cost Item
You can add subordinate cost items in two different ways:

Option 1

Right-click on the row header of the superior cost item and select Insert Subordinate.

The row header is considered the far left edge of the CBS row where the small arrow appear appears
above. It is used to open records and perform actions on items instead of clicking on cells within the
row which will allow you to directly type into the selected cell.

Option 2

Click on the Subordinate Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.
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Insert Cost Item
You can add cost items at the same level in two different ways.

Option 1

Right click on the row header of the superior cost item and select Insert.

Option 2

Click on the Cost Itemicon on the Cost Breakdown Structure (CBS) Register toolbar.

Because the project you are working in is a “locked” job (where cost items are locked to pay items),
your CBS Register will already have level 1 cost items representing each of your pay items, and each
cost item will be assigned to its corresponding pay item.

The following step by step walks you through creating a subordinate (child) cost item for one of your
level-one cost items.
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Step by Step — Create a subordinate cost item

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on a cost item and select Insert Subordinate.

l This creates a new subordinate cost item below your selected cost item

3. For the subordinate cost item, enter a description.

4. Add a quantity and select your Unit of Measure.

l For this example, we’ll insert a subordinate under Clearing & Grubbing for Clearing

You can create a subordinate at the same level, by right clicking on an equal-level cost
item and selecting Insert.

Move Cost Items
As you develop your estimate, you may need to move cost items around in the Cost Breakdown Struc-
ture. To move a cost item:

1. Select the row header of the cost item you wish to move. If you select a superior cost item, it will
bring the subordinates along with it.

2. Drag and drop the cost item to the right place in your structure. Notice one of two cursor symbols
appears:

The symbol with three equal bars will drop the cost item at the same level
as the cost item you drop it on.

The symbol with a subordinate bar will make the cost item become a sub-
ordinate to the one you drop it on.
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Costs and Production
For the cost items you’ve created, you can now add their costs and production. All information for a
cost item is contained in a Cost Item Record.

Cost Item Record
You can open the Cost Item Record by either double clicking on a cost item row header, or right click-
ing and selecting Open.

Cost Item Record Overview

Name Description

1 Cost Item
Header
Information

Provides general information about the cost item. It displays the cost item’s
take-off quantity, Unit of Measure, and Cost. It also indicates what Cost Source
is being used.

The Cost Segment drop-down is used to differentiate estimated costs in the Dir-
ect Costs, Job Overhead or Business overhead categories.

2 Costing
Area

Section where costs are defined. There are three ways to enter costs: Detail,
Plug, and Quote. The Cost Summary tab summarizes whatever costs are
defined.

Under the Cost Segment drop down, you can choose

3 Data Blocks Contains a set of tabs for entering additional information including production,
shift arrangements, man-hour factors, notes, and scheduling information.
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Cost Segments
The Direct Costs, Job Overhead, and Business Overhead cost segments helps to classify the scope of
work so you can report on direct vs indirect costs, and accurately control how markup is spread through-
out your bid. This differentiation is necessary to effectively price work based on the risk profile of each
segment of cost.

Cost Sources
You can define costs on a cost item in one of three ways, called Cost Sources:
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Tab Description

Detail This is the recommended costing method, where labor, equipment, and material resources
are defined, along with productivity, to determine costs.

Plug This method allows you to enter a unit or total cost directly, without needing to enter
resources or production. This should rarely be used, but does have a couple of use cases:

l Place holder value until you get more information (from subcontractors or designers)

l For preliminary estimates when limited information is available

Quote The Quote cost source is for contractors, subcontractors or vendor quotes.

l Creating and managing quotes is covered in Lesson - Quote Management

On each Cost Item Record, InEight Estimate gives you the option to define both Plug and Detail values
on each respective tab.

Plug Tab

The Plug tab allows user to input unit or total cost to any of the listed cost categories which can be cus-
tomized based on company requirements.
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Detail Tab

Entering both a detailed and plug cost allows you to define costs at a higher summary level initially
(Plug tab), and then define more detail as the estimating process progresses (Detail tab). You can
review and compare your plug and detail values by toggling between tabs, but your cost item will only
contribute the total cost from one of the tabs based on which cost source is selected.

You control which cost is used by selecting Detail or Plug in the Cost Source field on the Cost Item
Record.

The Quote Cost Source can only be selected from the Quote Comparison & Award form. See Lesson 8
– Quote Comparison.

Plug Costs
The following steps walk you through defining a plug cost on a cost item.
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Step by Step — Define a plugged cost

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for a cost item and select Open.

3. In the Cost Source drop-down field select Plug.

4. In the left section of the cost item, select the Plug tab.

5. Click in the Unit cost or Total cost field for a cost category and type in a Numeric Value.

l For this example, on the Mobilization cost item, we’ll add $10,000 in the Total Cost field
for both Labor and Owner Equipment.

Detail Costs
The Detail cost method is also defined on the Cost Item Record. On the Detail tab, you can add
resources (labor, equipment, and material) and define production.

On the Production tab (right side of screen), define production by entering one of the following:

l A duration, or

l A unit per duration, or

l A duration per unit

When you enter a production value, all the other production fields will auto-fill based on what you
entered.

The hours defined on the Production tab drive the labor and equipment resources you employ on the
left, multiplying their unit costs by the production hours.
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When you employ material resources, their costs are driven by the quantity you enter into the quantity
field.

The Total Cost of each resource is added together to give you the Total Cost for the cost item.

Step by Step — Detail costs

1. On the Detail tab, add resources (labor, equipment, and material).

2. On the Production tab, define production (duration, unit per duration, or duration per unit).

3. The hours defined on the Production tab drive the labor and equipment resources on the left, mul-
tiplying their unit costs by the production hours.

l With material resources, their costs are driven by the quantity entered in the quantity field.

Add Cost Detail

The following steps walk you through adding resources and production on a cost item.

Step by Step — Add cost detail

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on row header for a cost item and select Open.

3. Select the Detail tab.

4. A blank row is available to define your costs. With your cursor in the code field, click the
Resource Selection icon to open the Resource Selection Register.

5. Select a resource tab (e.g., Labor).
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6. Select a resource.

7. Select OK.

8. Repeat the steps to add additional resources as needed.

9. Click in each resource’s quantity field to change their quantity as needed.

10. From the lower-right section of the form, select the Production tab.

11. Type a numeric value in the Days field, then press Tab.

12. Click OK to close the record.

l For this example, we’ll add cost detail to the Clearing cost item, adding the following labor
and equipment resources and production value:

Add Assembly

Step by Step — Define cost detail by adding an assembly

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for one of the cost items and select Open.

3. Select the Detail tab.

4. With your cursor in the Resource Assembly field, click the Resource Assembly Selection icon
to open the Resource Assembly Selection Register.

5. Select an assembly, then click OK.

6. Because this crew includes duration-based resources, you need to enter a Production value. Select
the Production tab.

7. Type a numeric value in one of the production fields (e.g., UoM/day), then press Tab.
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l For this example, on the Grading cost item, we’ll add a Grading assembly with a pro-
duction value of 1 Acre/Day.
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Cost Item Details
The Cost Item Record contains other tabs (called Data Blocks) in addition to the Production tab, for
storing and calculating information specific to that cost item.

You can add to or adjust the information on these tabs as needed, based on the cost item’s cir-
cumstances. In this section, you will review three of the tabs (in addition to the Production tab) you
will likely use most often: Cost Item Setup, Notes, and Man-Hour Factors.

Cost Item Setup
On the data block where the Production tab was found, there is also a Cost Item Setup tab where you
can adjust wage scale and shift arrangements for a specific cost item.
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The composite wage scale and work and pay hours are used in the calculation of the cost of employed
labor resources. The data reported on the Default Pay Rules tab is, by default, the composite wage scale
and work and pay hours defined on the Job Properties - Cost Basis tab for the current job.

These settings can be modified from the default on a cost item-by-cost item basis.

The Pay Rules for cost items can also be defined or modified on the Cost Breakdown Structure (CBS)
Register in the Scale 1, Scale 2, Scale 3, Work Hours Rules, and/or Pay Hours Rules columns in the
row of the subject cost item.

Cost Curves

Cost curves are used to determine how the cost of a cost item is distributed over time. The main benefit
of defining the cost curve for a cost item is to create a more accurate estimation of the cash flow over
the life of a project.

The schedule dates entered on a Cost Item are used to define the periods across which a cost item will
incur its costs. A cost item’s start and finish dates can be entered manually by the user or established
using Schedule Integration, and the time periods (day, week, month, quarter, year) are determined in
the Cash Flow settings in Job Properties. For more information on scheduling, see topics Microsoft Pro-
ject and Primavera.

By default, Cost Items have a linear cost curve, which distributes the cost of the cost item equally
across all periods for the Cost Item. There are 5 different types of cost curves that can be selected from
in the Cost Item Record > Cost Item Setup page.
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Cost curve type Definition

Back Loaded Costs are low for most of an activity's timeline,
but then increase towards the end. This curve
type starts out with a lower slope and gradually
becomes steeper as the work progresses. Most
resources are assumed to be consumed later in
the activity and may be more characteristic of
subcontracted work where costs are incurred as
the work nears completion.

Bell Shaped Expenses are low at the start of an activity,
increase during construction, and decrease as
the project approaches completion. Bell shaped
cost curves incur the majority of their costs
towards the mid-point of the work and expo-
nentially increase and decrease from the begin-
ning to the end of the activity. This type of
curve can be characteristic of larger portions of
work that start with a few resources, ramp up to
a peak, incurring more costs during the ramp
up, then ramp back down as the work nears
completion.

Front Loaded A front-loaded cost curve is when costs are
incurred early in a activity. This can happen for
several reasons such as early procurement of
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Cost curve type Definition

materials to take advantage of lower prices or to
address long lead times.

Linear Linear cost curves take the total cost of the
activity and spreads it equally amongst the spe-
cified periods.

Cost Item Periods Invoked by using the Period Quantities feature
(described below). Cost Item Periods are used to
customize cost curves based on the quantities
consumed in various periods. In comparison to
the other curves which spread the items total
cost proportionally based the chosen cost curve,
the Cost Item Periods option can generate a
more precise distribution of costs to specific peri-
ods because the user can simply define how
much quantity of work is getting completed in
each specific period.

You can also choose to create your own custom cost curve by clicking on the add button in the Cost
Curve drop-down menu.

Custom cost curves let you define your own from and to durations along with their associated values,
which need to add up to 100%.
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Cash Flow

All cost curves, regardless of type, impact the generation of the cash flow graph. The Cash Flow form
provides a graphical representation of the cash flow and resource utilization of your project, so you can
quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

To generate a cash flow curve, the estimate must be populated with schedule dates either directly from
integration with Primavera, Microsoft project, or input manually.
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Cash flow options

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and vendors/sub-
contractors. Cash flow is then calculated based on both the earning and payment terms you specify, and
the job's schedule and pay item prices.

Cash Flow Display Settings

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow
graph.
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Cash Flow example

Using the Period Quantities cost curve type as an example, on the Cash Flow graph, you can see that
50% of the total cost for this cost item, represented by the red line, is incurred in the first period of the
project. Half of the project’s cost is incurred during the first period of the project’s lifespan as determ-
ined by what is entered in the cost item’s period quantities.

A reason why half of the project’s cost is being used during the first period could be that resources
available to perform the project happen to be mostly available during the front end of the project.
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After the first period, the project incurs the remaining balance of the total project cost of $95,000. This
is spread equally with quantities of $5,625 amongst the last three periods. This information helps you to
better understand when the owner provides payment, in addition to deciding if more project funding or
financing is needed.

Perhaps most costs on this one item will be incurred at the end of the activity, such as a subcontractor
billing for most of his work as it nears completion. If it’s determined costs are incurred towards the end
of the activity, you can attribute most of the cost items quantity in the last period. You can add any
number of additional periods to a custom cost curve or to a cost curve defined by period quantities
curve and the costs will be proportionally spread across the actual number of periods defined by the
Cost Items start and finish dates and cash flow settings. Be aware reducing the number of periods in a
front or back end loaded curve may show a steeper total cost in some periods.
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Using period quantities as the cost curve helps you determine how much of a cost item’s cost is going
to be spread in different durations of time.

Period Quantities

Like the other four cost curves, Period Quantities are used to customize cost curves, which show you a
graphical representation of the cash flow and resource utilization so you can assess the proper financing
and resource project needs. When the Period Quantities check box is selected, the Cost Curve auto-
matically changes to Cost Item Periods.

The Period Quantity calculator uses the cost item quantity assigned to various periods to calculate the
specific percentages attributable to each range of periods covered by the cost item. The purpose of
using period quantities is to spread costs via the cost curve in the cash flow analysis. For example, if
you have an item where 50% of the cost is incurred when you start the work because you have to buy
all the material first, then you would want a customized cost curve to reflect that this is how the costs
will be incurred over time when building that work.

In the example below, since 50% of the cost is incurred when the project starts, period one's quantity is
50% of 45,000 Forecast (T/O) Qty which is 22,500. The remaining costs are then spread equally across
the remaining three periods.
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You can also choose to select the Re-spread quantities button to spread the quantities equally among
the periods entered in the Number of Period Quantities field.

Step by Step — Adjust shift arrangements

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for a cost item and select Open.
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3. Select the Cost Item Setup tab in the lower-right portion of the form (the tab name may be abbre-
viated).

4. In the Default Pay Rules data block, adjust your Composite Wage Scale as needed.

5. Under the Composite Wage Scale, adjust the number of hours and paid as needed

6. In the Default Shift Arrangements data block, make changes as needed.

l For this example, we’ll make the following changes on the Clearing cost item:

l Composite Wage Scale – 80% Scale 1, 20% Scale 2.

l For every 10 hours worked, pay 10 hours.

l Default Shift Arrangements – Change Work Hours per Shift to 10.

Notes
On the Cost Item Record, you can enter any cost item-specific instructions, parameters, or general
information on the Notes tab. Below are a few examples of the kinds of notes you might enter:
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l For a Hauling cost item:  There should be very little waste. If so, we can spread it out in the right
of way at MP 111

l For a Structural Excavation and Backfill item:  The backfill cannot be the native material. Have
to use clean base rock

l For an Underground Pipe cost item:  The average depth is close to 10 ft.

You can use the Notes tab to reference cost item changes (e.g., changing shift arrangements, changing a
resource rate).

Man-Hour Factors
For items that have known risks or potential resource concerns, you can apply a Man-Hour Factor to
take those risks into consideration.

Man-Hour factors are applied on the Man-Hour Factors tab on the Cost Item Record. Factors are
applied in relation to 1, where slower production is greater than 1 and faster production is less than 1.

Man-Hour Factors affect both Labor and Equipment Hours.

For example, if you predict production to be 20% slower due to weather concerns, you would type 1.2
in the weather factor field.

Even after defining a Man-Hour Factor, the Production tab will still display the original Production val-
ues.

l To see the factored Production values, click the Customize Display link on the Production tab
and select Show Man-Hour Factors

l Both original and factored production are then displayed on the Production tab

You can apply Man-Hour Factors to multiple cost items at once by Multi-Editing selected cost items on
the CBS Register.
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Unique Identifier
You may have noticed when you made changes on the Cost Item Setup tab, that the fields you changed
and the Cost Item Setup tab became highlighted, indicating they were altered from their original state.

On the CBS Register, the cost item you edited now has a Unique Identifier in the row header indicating
the cost item was altered from the default values set in the project job properties or in the project lib-
rary of resources rates.

If you hover over the identifier, a pop-up menu appears indicating what data points were changed.

This same identifier will show up for resources as well, if you make changes to the employed
resource’s cost to be different than the original resource rate imported from the Resource Rate Register.

Highlight Unique (Delta) Toggle

You can turn the highlighting of unique resource and cost item fields off and on from the Actions menu
of the Cost Item Record, under the View section.
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Cost Drivers
Each type of resource has a default cost driver. For example, Labor resources are duration driven so the
cost driver is CI Duration, meaning their costs are driven by the duration of the cost item. If you want
an Operator to only be assigned to a specific cost item or work activity for half the time, you can
change its quantity to .5 and it will be driven by half of the cost item’s hours.

To enter work hours manually for the employed resource, you can change the Cost Driver option to CI
Quantity or Fixed.

With CI Quantity as your cost driver for the Operator, you can adjust the Work Hours manually, where
previously that column was read-only.

Let’s say you want your Operator to work specifically 80 hours.

However, since the resource is now quantity driven, if you change the Forecast (T/O) Quantity to 50
you will see that the work hours will still adjust from 12 to 40.
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If you want it set at 80 hours no matter what changes you make to your quantity, you can change the
cost driver to Fixed. Then when you change the Forecast Quantity to 500, the work hours for the Oper-
ator will not change and will remain at 80 hours as shown below.

If you followed along and made any adjustments to cost item 2.1 Clearing, change the Cost Driver for
the Operator resource back to CI Duration and the Work Hours back to 100.

Suspend Cost Items
The Suspend feature allows you to turn cost items on and off in order to perform “what-if?” analysis or
evaluate alternative approaches to the work.

A cost item can be suspended in InEight Estimate for various reasons including the following:

l Manually suspended cost items

l Suspended parent

l Parent with cost source that is not Detail (plugged or quoted)

l Parent cost item with a zero quantity

l Pay item is suspended

l Allocated cost items

l Alternate scenarios:

l Overridden by another alternate

l Alternative is not active

Suspended cost items do not contribute any cost to the job's total value. Suspended items can be un-sus-
pended at anytime in order to be included in the total project value.

Step by Step — Suspend a Cost Item

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right click on the selection and select Toggle Suspended from the menu.
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l You can also select Toggle Suspended under the Edit section of the Actions tab up above

l You can also suspend cost items by checking the Suspend checkbox on the Cost Item
Setup tab of a cost item record

l If a superior cost item is suspended, its subordinate cost items are automatically suspended
as well

l The costs associated with these cost items will no longer contribute to the estimate

Editable Man-Hour Factors in Suspended Cost Items

You can edit Man-Hour Factors for a suspended cost item by creating and maintaining cost items,
including Man-Hour Factors. This can be accomplished in a suspended state while having the scope of
work included in your estimate. The cost to contribute is excluded from the scope of work until you are
ready to make it part of your estimate.

Unsuspend a Cost Item

Follow the step by step below to unsuspend a cost item.
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Step by Step — Unsuspend a Cost Item

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right click on the selection and choose Toggle Suspended.

l You can also select Toggle Suspended from the Edit section of the Actions tab

l You can also unsuspend cost items by unchecking the Suspend checkbox on the Cost Item
Setup tab of a cost item record

Suspend Column

Within the CBS Register, the Suspend column indicates which cost items are suspended.

l Hover over the checkmarks to see why the cost item is suspended

l You can suspend and unsuspend cost items by checking and unchecking the checkboxes in the
Suspend column as well

Adding Cost Adjustments
Total Cost and Billing Adjustments can now be made in the CBS register which can be viewed either
from the Standard view of the CBS register, or a saved view affiliated with change.

Adjustment fields have been added to the CBS to view and modify the adjustment amount and adjust-
ment percent without going into each individual cost item.
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Any adjustment made to the Adjustment Amount fields on the CBS register will then have the Adjust-
ment Percent field automatically calculated. Changes made to those fields will be highlighted in yellow
signifying an adjustment has been made.

Other adjustments fields in the CBS register include the many adjustments fields that have been added
to the Billing Rates View.

A new Saved view called Cost Item Adjustment View has been added to the Cost Breakdown Struc-
ture.
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Indirect Costs Overview
Indirect costs such as the cost of prime bond, mobilization, or site supplies are typically overhead costs
that are not directly associated with a particular project deliverable but contribute to the total cost of the
project. However, indirect costs can be assigned to a pay items. This gives you the flexibility to more
accurately control the cost basis of bid items and strategically price the work to maximize cost recovery
and profit.

Once your direct costs are defined, you can add indirect project costs. Estimate provides two ways you
can create indirect costs:

1. Default Indirect Cost Items:  These are pre-built cost items created by InEight Estimate, located
at the top of the CBS Register.

2. User-Defined Indirect Cost Items:  Any cost item you create in the CBS Register that is not
assigned to a pay item is considered indirect cost.

The Cost Breakdown Structure (CBS) located in the Library under the Estimate tab, Master
Breakdown Structures section, controls which of the default indirect cost items to copy into new
job folders.

Navigation to Indirect Costs
From the Estimate tab of the InEight Estimate landing page, you can quickly access indirect costs from
the Indirect Cost section.

l Select Indirect Cost Items to open the Cost Breakdown Structure Register filtered to only your
indirect costs

l You can select Prime Bond, Price % Add On, and Job Financing to access those indirects

The following section takes a closer look at the default indirect cost items.
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Default Indirect Cost Items
InEight Estimate contains various default cost items to help you calculate your indirect costs.

Independent Indirect Cost Items
Independent indirect cost items function very much like the direct cost items you defined previously:

l Job Management & Equipment

l General Expense

Job Management & Equipment

The sample Job Management & Equipment Record below shows that you can add resources and pro-
duction just like in your direct cost items. Supervisory staff resources were added, and the production
duration is set to 100 days.

The following Step by Step walks you through defining resources and costs for your Job Management
& Equipment indirect cost item.

Step by Step — Add job management & equipment costs

1. In your job, from the Estimate landing page, select the Cost Breakdown Structure (CBS).

2. Double-click on the row header of the Job Management & Equipment indirect cost item.

3. Add resources by clicking in the Code column and selecting the Icon.

4. Select the Production tab.

5. Enter a production value.

6. Click OK to close the record.
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l For this example, we'll add the following resources and production:

Step by Step — Add general expense costs

1. From the Estimate tab, select the Cost Breakdown Structure (CBS).

2. Right-click the row header of the General Expense row header and select Open.

l You could add existing resources here, but in this case, you will create an ad hoc resource.

3. In the first blank row, enter a description, quantity and unit of measure.

4. Click on (highlight) that row, and then click the Resource Employment Breakdown tab.

5. Type a numeric value in the Undefined Supplies cost category.

6. Click Ok to close the record.

l For this example, we’ll add General Office Supplies, 1 Lump Sum, $1,000 in the Supplies
category.

Dependent Indirect Cost Items
The other default indirect cost items are dependent indirect cost items, meaning their costs depend on
other costs, prices or hours. They include:

l Direct and Indirect Cost Add-On

l Direct and Indirect Cost Escalation

l Prime Bond
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l Price % Add-On

l Job Financing

l Man-Hour Add-On

It’s possible to assign any assigned or dependent cost Item to any of the 3 cost segments and provides
greater control over where costs exist in the Price Breakdown Structure (PBS).

Default Dependent Cost Item Deletion

If you need to use additional dependent cost items, you can create your own, but you must delete all the
existing default dependent cost items first.

The following steps walk you through deleting your existing default indirect costs so you can create
your own.

Step by Step — Delete existing default dependent cost items

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Select an Indirect Cost Item by clicking on its row header.

3. Press and hold the Ctrl or Shift key to select multiple indirect cost items.

4. Right-click on the selection and select Delete.
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5. Select Yes to confirm you want to delete the selected cost items.

Prime Bond

The following steps walk you through adding and defining your prime bond for the job.

Step by Step — Define prime bond

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for any cost item and insert Dependent cost Item.

3. On the resulting Attention prompt, select Based on Bond Table.

4. Click OK.

5. Right-click on the Prime Bond row header and select Open.

6. Use the Table Name drop-down to choose a table (e.g., Example: General Construction).

7. Click OK to close the record.

Multiple bond rate dependent items

For certain projects, it may be desirable to calculate costs for bond or insurance premiums based upon
multiple different rate tables. It is now possible to add multiple bond/rate table based dependent items
in the CBS.

For example, in addition to having a prime bond, the job may also require insurance coverage where
the premium is calculated using a rate table-based approach. This can now be accomplished by adding
another Bond/Rate-table based dependent cost item to the job.

Deleting Bond Tables

Delete bond tables that are not applicable to your estimate by selecting them and then clicking the
Delete button. You can customize the Bond Table window to only view the tables that are relevant to
your estimate from the Table Name drop-down list.
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Price % Add-On

The following steps walk you through defining the Price % Add-On.

Step by Step — Define a price % add-on

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Job’s Price.

3. Click OK.

4. Double-click on the Price % Add On row header to open the record.
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5. The Price % Add-on Record opens to the Description tab. Type a description in the Description
field and enter a numeric value for rate.

6. Click OK to close the record.

l For this example, we’ll enter a description of Office Overhead and a rate of 4%.

Direct Cost Add-On

The following steps walk you through creating a Direct Cost Add-On dependent cost item.

Step by Step — Define a direct cost add-on

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Direct Costs.

3. Click OK.

4. Double-click on the Direct Cost Add-On row header.

5. On the Description tab, type a description in the Description column.

6. Press the Tab key (you can define additional rows for other add-on costs as needed).

7. Click on the Dependency tab to see what contributes to your subject cost.

8. For this activity, leave the default (lower) button selected.

9. On the Cost Breakdown tab on the right, add an add-on rate (percentage) or cost at any of the
cost category levels you need.

l This updates the Total Cost (Forecast) of your item on the Description tab

10. Click OK to close the record.
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l For this example, we’ll create a new Direct Cost Add-On, giving it a description of Small
Tools with a rate of 10% on the Labor cost category

Repositioning Dependent Cost Items

Repositioning dependent cost items creates a simpler way to manage the hierarchy of your project by
placing items of more importance ahead of other line items.

Since dependent cost items can now be repositioned, a Position Code field has been added with the
functionality similar to column remaining the same. The below listed dependent cost item fields are
now exposed in the CBS register so you can more easily see the various percentages used in dependent
items.

• Subject Cost

• Subject Cost Rate

• Subject Billing Amount

• Subject Billing Rate

These columns can also be found in the new saved view Bid Review.
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User-Defined Indirect Cost Items
You may prefer to create your own indirect cost items. You create user-defined indirect cost items the
same way you create direct cost items. The only difference is that your indirect cost items will not be
assigned to pay items. One advantage of creating your own indirect cost items is the ability to create a
parent-child structure for your indirect costs.

Here is an example of user-defined indirect cost items, expanded to show their employed resources:

Step by Step — Add user-defined indirect cost items

Let’s walk through a specific scenario for this step by step.

1. At the bottom of your CBS, create an indirect cost item called Job Overhead with a Forecast
(T/O) Quantity of 1 and Unit of Measure of Each.

2. Add two subordinates under the new cost item named Job Trailer and Utilities. Job Trailer is 1
Each but change Utilities to 1 Lump Sum.

3. Open the Job Trailer cost item by double-clicking on the row header.

l Assuming there is no Job Trailer in our Resource Rate Register, you will create this
resource “on the fly”.

4. In the Detail grid, click on the Resource Register icon in the Code field as if you were going to
select from the Resource Rate Register.

5. On the Resource Rate Register, click the Rented Construction Equipment tab.

6. Right-click on one of the Line Items and select New to add a new resource.

7. Enter a Resource Code of RJT and description of Job Trailer.

8. In the Amount column enter 25 for the Rented Equipment category.

9. Click OK to close the Resource Rate Record.

10. Select the new resource you created, then click OK to return to the cost item record.

11. On the cost item record, adjust the Job Trailer quantity to 2.
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12. On the Production tab, enter 70 days.

13. Click OK to close the record.

14. On the CBS register, select the Utilities cost item by double-clicking on the row header.

15. Create an ad hoc resource on this cost item called Electricity, which will be 1 Lump Sum.

16. Finally, go to the Resource Employment Breakdown tab and enter 1500 in the Custom Category1
row.

17. Click OK to close the record.
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Job Markup (Profit)
On the Data Map  notice how the different segments within the pyramid coincide with the
percentage amounts that make up Direct Costs, Indirect Costs and Target Profit. Illustrations below
show how the Data Map values correspond to the values that make up the cost and profit.

To open the Data Map, select the Price tab, then Data Map from the Overhead and Profit section.

Target Price
For contractors building the price of your project is like building a pyramid. The foundation of your
price consists of the direct costs of the job.

The images below represent a default examples.

On top of your direct costs, you can decide if costs with a cost segment of business overhead should be
indirect costs or markup. You estimate your direct and indirect costs in the CBS Register.
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At the top of the pyramid you add an amount for profit. You add profit in the Price Breakdown Struc-
ture (PBS) form. There is a very small block at the top of the Data Map, which comprises 0.22% of
Indirect Cost Markup.

The total of the direct cost, indirect cost, and profit in the project is referred to in InEight Estimate as
the Target Price. This is the final price that you want to submit as your proposal.

Price Breakdown Structure
As you already practiced, your direct and indirect costs are estimated in the CBS. Your project’s profit
needs to be defined in the Price Breakdown Structure (PBS) form.

The main purpose of the Price Breakdown Structure (PBS) is to add markup (profit) to the estimate.
The Price Breakdown Structure is a visual run-down of the costs and profit that make up your Target
Price. It helps you analyze how your costs contribute to the price you are targeting, including the
amount of profit you would like to include.

You can open the PBS from the InEight Estimate landing page by selecting the Price tab, then Price
Breakdown Structure (PBS) from the Overhead and Profit section.
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Name Definition

1 PBS Descrip-
tion

The left side of the screen displays several cost classifications:

l Target Profit

l Business Overhead

l Job Overhead

l Direct Cost

2 Various
Columns

The Assigned and Unassigned columns show which costs are either assigned or
not assigned to pay items. Unassigned costs are spread back to pay items based
on the distribution logic set in Job Properties > Pricing. The Total columns rep-
resents a summation of both columns.

Each layer displays with an amount, and the percentage of the Target Price that
this amount represents.

3 PBS Menu The right side of the screen holds several tabbed pages of information. This
information is useful in analyzing the job at a summary level.

4 Refresh
Data

To ensure that you are always reviewing the most up-to-date factors and ratios,
click the Refresh Summary Data button whenever you are reviewing the data.

Overview – Price Breakdown Structure

All costs in the Price Breakdown Structure are based on pay quantities (not forecast take-off quantities).

Markup vs. Margin
Let’s look at the difference between Markup and Margin.

l Markup is a function of cost, while margin is a function of price

l Markup indicates how much you are marking up the cost
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l Margin indicates what percentage of your price the markup represents

The percentages on the main PBS screen are margin, so you can see what percentage each category in
the PBS represents compared to the total price. If you enter 10% in the Target Profit field, your profit
will be 10% margin of your total price.

When you open the Direct or Indirect Markup Records, the Rate percentage there indicates markup of
the cost. If you enter 10% markup on $100, the markup will be $10.

Within Job Properties, you can choose if costs with a cost segment of business overhead should be
indirect costs or markup. If selecting markup, then Business Overhead will be spread within the
Markup category of the Price Breakdown Structure. The Total Markup will be the sum of Target Profit
and all Items categorized as Business Overhead.
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This lets you see the true total cost of the job, including the total markup inclusive of the business over-
head. You can also create cost items and categorize them as business overhead, then possibly include
overhead costs such as estimating or home office expenses. This provides you with added flexibility in
marking up your job.

Define Profit
Before you define profit, review the PBS. You estimated your direct cost items, and you also estimated
some indirect cost items in the CBS. You can view your direct and indirect cost totals on the Price
Breakdown Structure. Notice you have not defined profit yet.
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You can define profit by entering a profit percentage directly on the PBS, or by modifying the Direct or
Indirect Cost Markup Records.

The following steps walk you through plugging a Target Profit percentage directly on the PBS form.

Profit as a Percentage of Target Price

Step by Step — Add profit as a percentage of target price

1. Open your job.

2. Select the Price tab.

3. Select Price Breakdown Structure (PBS) from the Overhead and Profit section.

4. On the Target Profit row, enter a numeric value in the % of Target Price column; press Tab.

l For this example, we’ll add 10% for the Target Profit.

Profit Through Direct Cost Markup Record

The following steps walk you through how to add profit as markup on the Direct Cost Markup record.
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Step by Step — Modify the direct cost markup record

1. On the PBS form, double-click on the Direct Cost Markup row.

2. In the record, overwrite the Default entry with Direct Cost Markup in the description field.

3. In the Rate column on the Dependency Cost Breakdown, add a numeric value in Labor, Owned
Equipment, Materials and Fees categories. Then reset other categories back to 0.

4. Click Ok to save your changes and return to the PBS.

5. Click the Refresh Summary Data button to see the changes reflected.

l For this example, we’ll add a rate of 15 for Labor, 10 for Owned Equipment, 8 for Materials, and
2 for Fees, then zero out all other categories.
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Cost Estimate Audit/Review
InEight Estimate offers built-in reports to double check your estimate and review different aspects of
your project, including material costs, quotes, man-hours and production.

Price Breakdown Structure Tabs
The purpose of the tabs on the Price Breakdown Structure is to assist with estimate reviews.

Markup Analysis

On this tab, you can compare your profit to your costs for labor, subcontract and other cost groupings.
By seeing the ratios of your markup compared to your different cost categories, you can gauge if you
have the right balance of costs in your estimate.

For example, if your markup is more than 100% of your Labor cost, it may indicate that you don’t have
enough labor cost in your estimate to cover the work, which could indicate labor cost overruns during
execution that would eat into your profit margin.

Cost Source

The Cost Source tab shows the breakdown of Detail, Plug and Quote cost sources, as well as the
amounts and percentages of each that are attributable to Direct and Indirect cost. Your Plug cost source
should be the lowest percentage.
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Resource Utilization

The Resource Utilization tab shows a breakdown of the man-hours and equipment hours utilized on the
job, based on take-off quantities.

Subcontract Status

The Subcontract Status tab displays a breakdown of subcontractor amounts, costs, and percentages for
quoted cost items. This is a good place to review how much of your estimate is subcontracted.

Vendor Status

The Vendor Status tab displays a breakdown of vendor information, including amounts and percentages
of the Target Price represented by vendors. This is a good place to review how much of your estimate
costs come from vendor quotes.
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Spread Target Price Over Pay Items
In the Cost Breakdown Structure you generated your direct and indirect costs, and in the Price Break-
down Structure you added profit to come up with a Target Price for the bid, but you still haven’t
decided how to spread the Target Price over your pay items.

In Lesson 4 you created pay items for the project in the Pay Item & Proposal Register. You can now go
back to the Pay Item & Proposal Register to distribute your Target Price over those pay items.

Current Price vs. Target Price
In InEight Estimate, Current Price means the total price that is currently assigned on your pay items.
Open the Pay Item & Proposal Register to see what the Current Price is for your pay items (Price > Pay
Item & Proposal).

At this point there is no pricing on your pay items, so your Current Price is $0.00. This is because you
have not yet spread your Target Price (the total of your cost and profit) over your pay items.

Proposal Recap
On the Pay Item & Proposal Register, there is a Proposal Recap table where you can compare your Cur-
rent Price to your Target Price to see if there is any variance.

Ideally, you want to add pricing to your pay items until your Current Price equals your Target Price, so
that your Variance equals zero. That way you know you are covering all your costs and getting the
profit you want.
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Notice the Variance column will indicate if you need to ADD or CUT pricing on your pay items to hit
your Target Price.

Spread the Target Price
For lump sum contracts, spreading the Target Price may be as simple as spreading it to a single pay
item that represents the entire project. However, most jobs will have at least a few pay items defined by
the owner, and Unit Price contracts will have many pay items.

There are two main ways to distribute pricing onto your pay items:

1. Define pay item prices manually, by entering a unit or total price, or a margin percentage.

2. Use InEight Estimate’s AutoPrice feature to distribute pricing automatically.

Define Pricing for Pay Items Manually
First, you will walk through the process of defining pricing manually. This method requires filling in
each item’s price based solely on your own judgment.

Step by Step — Define pricing manually

1. From the Estimate landing page, select the Price tab.

2. Select Pay Item & Proposal from the Pay Items section.

3. Select a Pay Item row.

4. In either the Unit Price (current), Total Price (current), or % Margin field of a pay item, type a
numeric value.

For this example, we’ll do the following:

l Mobilization pay item – change Total Price (current) to $20,000.

l Clearing & Grubbing pay item – change % Margin to 5%.

Use AutoPrice to Balance and Hit the Target Total
Perhaps you want to get a head start and have InEight Estimate spread your Target Price pro-
portionately over your pay items for you. This can be done using the InEight Estimate AutoPrice fea-
ture.
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Once distributed, you will still have the ability to adjust your pricing on pay items manually as needed.

Look at how you can use the AutoPrice feature.

Step by Step — Use AutoPrice to balance and hit the target total

1. Open the your job in Estimate.

2. From the Estimate landing page, select the Price tab.

3. Click on Pay Item & Proposal to open the Pay Item & Proposal Register.

4. On the Pay Item & Proposal Register menu, choose Actions > Balanced Bid > Hit Target Total.

5. Review the Proposal Recap and see that the Variance is now $0.00. Now that the job is balanced,
you can see that the Current Price and the Target Price are the same, indicating that the costs and
profit are spread proportionately over your pay items.

Use AutoPrice to Unbalance and Hit the Target Total
The Autoprice to Unbalance feature in InEight Estimate can automatically distribute profit to account
for your over- and underrun items.

InEight Estimate will take profit from your underrun and put it on your overrun by using the Actions >
Unbalanced > Hit Target Total feature. The purpose is to maximize your profit by spreading it stra-
tegically between these items.

Step by Step — Unbalance hit target total

1. You may encounter overrun and/or underrun items in the Pay Item & Proposal Register of your
job.

2. If you do, highlight the row for each item to view it’s current balanced item recap.

3. On the Pay Item & Proposal Register menu, choose Actions > Unbalanced Bid.
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l You will see the changes reflected and how the profit was spread to your overrun and
underrun items

l In the example shown, highlighting each item will show that all your overhead and profit
from Excavation was put onto Clearing & Grubbing.
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Bid Adjustments
Often you will want to continue adjusting certain pay items and then rebalance to hit the target total.

Lock Price
You can lock down a pay item price and it will not factor in future rebalancing.

Step by Step — Lock Price

1. Select the Lock Price checkbox on an item's row.

2. After making further adjustments in the next step by step, you will return to the Pay Item & Pro-
posal to rebalance.

l You can continue to adjust at previous levels aside from solely in the Pay Item & Proposal
Register

l For example, you could make a last-minute adjustment in the PBS or CBS. You can make
adjustments anywhere, but for this example an adjustment will be made in the Direct Cost
Add-On record at the CBS level

Step by Step — Make Last Minute Bid Adjustments

1. With your job open, select the Estimate tab.

2. Click on Cost Breakdown Structure to open the CBS.

3. Double click on the row header to open the Direct Cost Add-On dependent cost item record.

4. Under the Description tab on the left, click in the blank row under the Description column.

5. Type in a description.

6. Make the adjustment by typing a numeric value in the Cost column of the Materials Cost cat-
egory under the Cost Breakdown section on the right.

InEight Inc.  |  Release 20.2 Page 139 of 516

Estimate Help Topics Lock Price



l To make a cut, enter a negative value, i.e. -1000

7. Press the Tab key, and your adjustment will be reflected on the left-hand side.

8. Finally, return to the Pay Item & Proposal.

9. On the Actions menu, select Balanced Bid > Hit Target Total.

10. An Auto Price Warning may display, informing you of rounding variances. After reading the
details, click the Close button.

l Note on the proposal recap that a variance may still exists because there are limited num-
ber of pay items to spread the rounding error over

l Note that the locked item did not adjust, but the other pay items were updated

l Note that you can overwrite locked items for spreading your price by checking the Over-
write Locked Pay Items option on the Actions menu

Suspend Pay Items
Like suspending cost items in the CBS Register, you can suspend pay items in the Pay Item & Proposal
Register. Suspending a pay item causes it to no longer contribute quantities and pricing to the estimate.
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This can be helpful when considering alternate items on a bid submission. Should the client decide to
not require a pay item, you can suspend it, causing the pay item and any of its assigned cost items to no
longer contribute any cost or price. It will no longer show up on your bid and no longer contribute to
the overall total price.

You can suspend/unsuspend pay items in one of three ways:

l Right click on the pay item and select Toggle Suspended

l Select the pay item and click Toggle Suspended under the Edit section of the Actions Tab

l Open the pay item record and checking/unchecking the Suspend box
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Quote Management Overview
Quote Management Workflow
When you make the decision to send out RFQs (Requests for Quote), as the estimator you will outline
the specifications for the request, select the vendors you wish to contact, and issue the request for
quotes.

When you receive quotes back from vendors, you can enter their pricing into InEight Estimate, where
you can compare them, award them, and update your CBS costs in one fluid process without the need
to re-enter data in multiple locations. InEight Estimate lets you enter multiple vendor quotes to enable
price comparison.

Awarding a quote in InEight Estimate does not mean the vendor is awarded the contract, but rather that
their price is selected as the carrying cost in the bid.

InEight Estimate provides a built-in workflow for managing your quotes, consisting of three steps:

1. Creating and publishing Requests for Quote (RFQs)

2. Updating quotes with vendor/subcontractor pricing

3. Comparing and awarding quotes

InEight Estimate has a separate form to manage each step:

1. Request for Quote (RFQ) Register

2. Quote Register

3. Quote Comparison & Award

Quotes and Quote Groups
Typically, an estimate contains two types of quotes:

1. Quotes for resources (materials, equipment) purchased or rented from suppliers.

2. Quotes for subcontracted work.

Page 142 of 516 InEight Inc.  |  Release 20.2

Quote Management Workflow Estimate Help Topics



In InEight Estimate, quotes from suppliers are managed at the resource level. In other words, you can
use material resources to represent the items purchased from the supplier.

For the cost items in your project that you plan to subcontract, you can manage quotes at the cost item
level, using the cost items themselves as the descriptions on the quote request.

You can use Quote Groups to group together multiple resources or cost items that will be sent in an
RFQ package. Using quote group tags can save a great deal of time generating packages of items to
request quotes for.

Resource Level Quote Groups

When sending out quotes, you may want to organize your resources into groups based on the type of
material, such as pipe, aggregate, or concrete. When creating Requests for Quote, you will be able to
select your pre-defined quote group and it will bring all the related resources along with it. You can
assign quote groups using a pre-defined tag called a Quote Group in the Resource Rate Register.

Below is an example of resources with a quote group assigned:

CBS Level Quote Groups

For your subcontracted items, you can assign quote groups at the cost item level to group together sub-
contractor work, such as Commercial Work or Landscaping Work. These labels are assigned using a
pre-defined tag called Quote Group in the Cost Breakdown Structure register.
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Requests for Quote
Requests for Quote (RFQs) are invitations to sellers that include a requested list of items or ser-
vices/pricing and terms. When you create an RFQ in InEight Estimate, you are able to indicate the line
items you want to include in the quote, and the vendor(s) to whom you want to send it.

Request for Quote (RFQ) Register Overview
To access the Request for Quote (RFQ) Register, from the InEight Estimate landing page, select the
Quote tab, then click on Request for Quote (RFQ).

l The RFQ register lists all of the RFQs you’ve created, with a Description, a Status, and a
Response Deadline Date

Request for Quote (RFQ) Record
You can double click on the row header, or right-click on any request for quote in the Request for
Quote Register and choose Open to access an existing Request for Quote (RFQ) Record.

Name Definition

1 RFQ Descrip-
tion

Each record contains a Description, Deadline Date and Deadline Time fields to
identify the RFQ and indicate when a response is due.

2 RFQ Tabs The record is organized into tabs where you can define the items for the quote,
terms & conditions, and the seller companies to receive the RFQ.

Overview – Request for Quote (RFQ) Record
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Name Definition

3 Status and
Published
Data

The Status and Published Date let you know if it is new or published (sent out),
and when it was published.

Create an RFQ
When putting together your RFQs, you will be able to select the appropriate material resources and cost
items for which you need quotes in your estimate. To create a new RFQ, you have a few options:

l Create RFQ from scratch:  This creates an empty RFQ Record for you to define

l Create RFQ from Quote Group Tag(s):  This option lets you create an RFQ from a quote group
so you can add multiple materials or subcontract items at once

l Create RFQ using Default Seller data:  In your address book you can store vendors with a list of
their default materials. This option lets you select the vendor and have it automatically find their
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materials in the job

The rest of this section walks through each tab on the RFQ Record in more detail.

Line Items

The Line Items tab lists the resources or cost items selected for the RFQ, including the Description,
Quantity, Quote Group, Currency and other user-defined tags.
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Terms & Conditions

This tab provides ample space for you to enter terms, conditions and instructions that need to be
included on the RFQ.

Vendor Companies

You will use the Vendor Companies tab to select the suppliers or subcontractors that will be receiving
the RFQ. This is done by selecting them from the Estimate Library Address Book. This tab will store
all of the pertinent contact information for each seller, including their fax number and/or email address
so that you can send them the RFQ.

The following options are particularly noteworthy:

l Publish Item Quantities:  If you want the RFQ to specify your take-off quantities, select this
checkbox. If you want to keep that information to yourself and let the vendors or contractors
determine their own quantities, deselect this checkbox
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l Publish To File:  If you choose to Publish To File, Estimate creates a Microsoft Word document
with a template filled out. It is ready to print and send, but you have the opportunity to double-
check the information before emailing the RFQ

When RFQs are generated for multiple vendors using the Publish To File option, be sure to sep-
arate the Microsoft Word document pages and send only the correct pages to each vendor.

l Publish by Email:  If you choose to publish by email, the Word document is created, the template
is filled out, it is attached to an email, and automatically sent to the email address listed for that
vendor in the Address Book

When using the Publish by Email option, the process is automatic and it does not give you the
opportunity to double check your information before the RFQ is emailed. For this reason, it is
recommended to Publish To File, review the information, and then email the RFQ manually.

Attachments
This tab allows you to specify any electronic files that need to be attached to the RFQ, such as draw-
ings or specifications for the work.

Setup
The Setup tab lets you indicate what information will display on the published RFQ template, including
custom tags. In addition to selecting tags and adding notes on the Setup tab, you can also specify your
RFQ Publication Settings and can choose whether you want to include the instructions, special terms
and conditions, notes and attachments.

InEight Inc.  |  Release 20.2 Page 149 of 516

Estimate Help Topics Attachments



Publish an RFQ
Once created, Estimate allows you to generate a Microsoft Word RFQ template that can be faxed or
manually sent via email to the supplier or subcontractor.

When you complete all of the fields that are required for this RFQ, you are ready to publish the RFQ,
To do so, select all of the vendors that you want to receive the RFQ and click Actions > Publish on the
RFQ Record ribbon.

Step by Step — Create and publish an RFQ

This exercise walks through a specific example using the Training Job.

1. From the Estimate landing page, select the Quote tab.

2. Select Request for Quote (RFQ).

3. From the Actions tab, click on the New icon to create a new RFQ.

4. Select Create RFQ from Quote Group Tag(s), leaving the checkboxes checked to only show
quote groups and resources that are being used.

5. Select the Aggregates quote group from the right panel.

6. Click OK.

7. In the Response Deadline Date field, select a date two weeks from today, and for the Response
Deadline Time, type a time stamp (e.g. 11:00 am).
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8. Select the Terms & Conditions tab.

9. Create and type Prices are good for the duration of the contract in the Buyer’s Special Terms &
Conditions field.

10. Type in All items to be delivered to jobsite by supplier’s trucks in the RFQ Instructions field.

11. Select the Vendor Companies tab and click in the first blank row in the Company Name
column.

12. Click on the Address book icon, and then select the following example vendors:

l Example Vendor 1: Pat Roberts

l Example Vendor 2: Stan Mark

l Example Vendor 4: Lester Slim

13. Click OK.

14. Make sure Publish to File is checked for all vendors.

15. Uncheck Publish by email for each vendor.

16. Select the sellers to whom you want to send the RFQ.

l Word opens the file automatically for you to review; and from here you can either print it
or send it in an email as an attachment
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l

17. On the Actions tab of the record, select Publish to create your RFQ document.

18. Select the folder to publish to.

19. Click OK to save the RFQ Record.

RFQ Email Draft
When sending out Requests for Quotes (RFQ) on a bid, it is essential to be able to effectively com-
municate the project requirements to potential subs or suppliers to ensure you have good quote cov-
erage within your estimate. Email RFQs open as a draft email message, giving you, the sender, the
opportunity to control specifically what is sent and customize the message before sending it out to subs
and suppliers.
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Quotes
When you receive responses to your RFQ, the next step is to enter their pricing in the Quote Register.
The Quote Register stores all of the quotes you have for that job. Each quote has a Description and a
Quote Status, and each quote displays seller contact information.

In this case, an estimator in charge of receiving quotes would need to determine how best to input these
quotes within the Quote register.

Sample Received Quote Scope Sheet

Name Description

1 Section one Scope item one includes 4 items the subcontractor has considered as work to
be done onsite. You may want to consider adding all 4 items as individual
quotes. Then creating a package identifying these quotes as on-site work,
totaling $203,000.

2 Section two Scope item two includes 3 items the subcontractor has considered as work to
be done offsite. You may want to consider adding all 3 items as individual
quotes. Then creating a package identifying these quotes as offsite work,
totaling $24,650.

3 Exclusions The subcontractor is showing 9 items they excluded from their scope of
responsibility.

4 Qualifications The subcontractor has included 3 stipulations pertaining to this bid. If selec-
ted all 3 are considered accepted terms.

Overview – Received Quote Scope Sheet
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Quote Register Overview
To access the Quote Register, choose Quote > Quotes on the main InEight Estimate menu or click the
Quotes icon on the toolbar.

Quote Record Overview
The Quote Record establishes who the vendor is, along with quoted prices and all terms and conditions.
Once a requested quote returns, you can either create the quote in InEight Estimate from scratch or con-
vert the original RFQ to a quote and enter the supplier or subcontractor pricing. Each Quote Record
contains additional fields and options for managing the quote.

Quote Records utilize data blocks allowing you to reposition tabs, detach tabs into individual windows,
and redock tabs in new locations. Using the data blocks layout, you can input and maintain important
quote data like Vendor Qualifications and Special Terms & Conditions.

Right click on any existing quote in the Quote Register and choose Open to access the Quote Record.

Name Description

1 Header
block

You can include detailed contact information about the supplier or subcontractor.
This automatically fills when you select the seller from the Address Book. The
External Ref field can be used to access information specific to the bid/quote.

2 Price
block

The Price data block contains a breakdown of pricing information for the quote,
including taxes, item conditions, and special conditions.

3 Quote
tabs

The tabs at the bottom of the screen hold detailed information regarding the quote.

4 Default
Data
Blocks

Data blocks include Special Terms & Conditions, Qualifications, Packages, Taxes,
Vendor's Profile, Setup, and Minority.

Overview – Quote Record
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Header Block
The Header block portion of the screen is where you enter in description information pertaining to the
quote, along with vendor/contractor information.

There is an External Ref field you can use as a hyperlink for attaching any supporting bid quote attach-
ments from the vendor/contractor.

On the right portion of the header block is where you enter optional information related to:

l Optional Code – A code used to reference the received quote.

l Date – The date the quote is received.

l Source – This is the method by which the quote was received. The options are Email, Fax, Hard
Copy, Phone, and Other.

l Currency – System of money in general use for a particular country..

l Ignore – By ignoring the quote, and providing a reason, the quote will turn grey in the Quote
Comparison & Award screen.

Quote records

The Quote record header block includes a vendor field with a searchable address book library register
drop-down list. You can select shared vendor data to populate your quote header record with Platform’s
shared master data.
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Using Platform’s shared data also reinforces accurate Estimate quote reporting. For example, you can
report on which vendors and contacts have been awarded quotes or run a report on how many RFQs
have been sent to select vendors and how many RFQs were returned for certain jobs. Additionally,
using Platform shared vendors makes it possible to report on all activity related to a particular vendor.
Examples include seeing how many subcontract agreements have been executed in InEight Contract, or
how many claims/issues a vendor has been involved with in InEight Change. The predominant value
for Estimate using Platform vendors, along with other InEight applications, ensures that the same
vendors are being used by all applications.

Price Block
The Price block includes the quotes extended price, along with any additional taxes, bonds, item con-
ditions, and special conditions.

Quote Record Tabs
Resources & Cost Items

The Resources & Cost Items tab displays the resources or cost items quoted, along with their estimated
quantities and units of measure.

l A Unit Price column is included on this tab for entering the quoted pricing from the seller, either
manually or by pasting from an electronic format

l If a Package code is entered, the Unit Price field is greyed out, and the Package code amount is
used
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l Additional columns are provided for making conditional amount or percentage adjustments to the
quote to manage last-minute changes

l A note field is included for explanation changes

l A No Split option indicates that the seller will only provide the quoted goods or services if they
are selected to provide all listed items. They will not provide one quoted item without you pro-
curing all others from them as well.

l You can check an item as Free for circumstances where the vendor will include the price of one
item with another. Marking the included item(s) as free reminds you there is no quoted price for
that item

Cost item tags and user defined fields

There are 25 tag fields in the Quote Record register cost items tab. There are also 15 user defined fields
that let you sort, filter, and group on selected quote records more efficiently.

For example, you can use tags and user-defined fields to isolate certain cost items, or group cost items
together.

Data Blocks
The Quote Record utilizes data blocks that allows you to customize the layout and focus on data block
tabs that matter most to you. You can select the default data block action in the ribbon to revert back to
the default setting, which shows all six data blocks.

Data Block tabs include:

l Special Terms & Conditions

l Qualifications

l Packages
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l Taxes

l Vendor's Profile

l Setup

l Minority

The seven data blocks appear at the bottom right of the screen.

It’s possible to move the entire data block, or individual data blocks to other parts of the screen. For
example, select the Special Terms & Conditions header row, and drag to the desired part of the screen.

Drop the data block on top of an arrow where you wish to land the data block.
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The data block will now reside on the left side of the screen.

You can also close a specific tab if it’s not commonly used. In this example, you can right click on a
tab (like Special Terms & Conditions) and select close.
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Data Block Tabs
Special Terms & Conditions

Special Terms & Conditions is where you can include buyers and sellers special terms, add fixed cost
to the quote, and include/exclude scope items.

Qualifications

This tab allows you to include bond. You can enter the bond rate and the system will calculate the total
Bond Cost or vise versa. This tab also allows you to enter insurance contact information and seller
license information. If the vendor in the address book already had this information, then this inform-
ation will get pre-filled when the seller is assigned to the Quote.
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Packages

Using the Packages feature lets you logically organize quotes into an arranged collection of like
grouped packaged quotes. You can determine how to enter quotes from subcontractors and classify
them into a package grouping. When you create a package within the Packages block, and give it a
monetary value, you can then assign that package code to one or more quote records. The package code
is limited to three characters.

When comparing various vendor quotes in the Quote Comparison and Award form, with each quote
containing its own scope of work, you can easily distinguish which items belong to each package. This
helps to identify which quotes to award in your decision-making process.

As an example, the following Civic Center Parking Structure quote has three packages defined in it.
The P1, P2, and P3 on the left represent the grouped package numbers that will be used to determine
the package structure in the quote record. The vendor that submitted this quote shows detailed estimates
defined for each of the three packaged items, but there is no breakdown provided in the quote of how
much each line item is worth. Rather, this quote is showing a package price for each collection of items
(scope of work).
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Estimate's Package feature lets you pick all the cost items that belong to a particular package, then
assign the price to that collection of packages. It then proportionally distributes the total package price
across all of the corresponding cost items when comparing and awarding.

Step by Step — Create a multi-packaged quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).

4. In the Description field, type in or replace the description.
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5. In the Contact field, select a contact.

6. Click OK

7. Select the Cost Items tab on the left side of the screen.

8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost Items.

10. On the Packages tab, enter the following 2 new records:

l Code: P1

l Description: On Site

l Amount: $200,000

l Code: P2

l Description: Off Site

l Amount: $300,000

11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.
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13. Select OK.

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

l Quote Comparison and Award shows the newly created quote with the associated package
quotes.

l The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
menu.

Taxes

Item Tax and Quote Tax have been combined to display on a single data block called Taxes. Using the
taxes feature allows you to add item taxes to each item's price. You can also add taxes to the quote.
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Seller’s Profile

The Seller’s Profile tab populates with address book notes and alternate contact information.

Setup

This tab provides extra space for any additional notes and tags to be assigned to the quote.
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Minority

This tab allows you to determine if the seller qualifies for any type of minority business, and the ability
to apply a certification number.

If any of your Data Blocks become deleted on a Quote Record, simply click the Default Data Block
icon.

Create a Quote from RFQ
Walk through the steps of creating a quote from an RFQ.
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To create a quote from scratch, click the New icon on the Quote Register and fill in the quote details
and seller fields manually.

Step by Step — Create a quote from RFQ

This exercise walks through a specific example using the Training Job.

1. From the Estimate landing page, select the Quote tab.

2. Select Request for Quote (RFQ).

3. Open the RFQ record for which you’ve received quotes.

4. Select the Vendor Companies tab and select the vendors for whom you need to create quotes. In
this case, select all the vendors.

5. From the Actions menu, select Create Quote.

6. Click OK on the Quotes created prompt.

7. Close the RFQ record and the RFQ register.

Enter Quote Details
Now that you have quotes created, you can enter pricing.

Step by Step — Enter quote details

This exercise walks through a specific example using the Training Job.

1. To open the Quote Register, select Quote from the Estimate landing page.

2. Select Quotes from the Quote Management section.

3. Open the Aggregates Quote Record for Vendor 1 – Pat Roberts.

4. On the Resources tab, make sure No Split is unchecked for all items.

5. Also on the Resources tab, enter the following unit prices:

Resource Code Description Unit Price

MBR Aggregate Base Rock $8.00

MDIRTB Dirt Class B $6.00

6. Click OK to close the Quote Record.
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Step by Step — Create a multi-packaged quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).

4. In the Description field, type in or replace the description.

5. In the Contact field, select a contact.

6. Click OK

7. Select the Cost Items tab on the left side of the screen.

8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost Items.

10. On the Packages tab, enter the following 2 new records:
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l Code: P1

l Description: On Site

l Amount: $200,000

l Code: P2

l Description: Off Site

l Amount: $300,000

11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

13. Select OK.

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

l Quote Comparison and Award shows the newly created quote with the associated package
quotes.
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l The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
menu.

Use Unit Price or Extended Price on Quote Record Item
It's possible to enter the Extended Price for a Quote Item, and the Unit Price is then calculated, which
makes entering quotes more efficient and results in less errors.

Duplicating an Existing Quote
You can create a new quote by duplicating an existing quote from the Quote Compare & Award form.
Duplicate Quotes will contain the same scope as the quote that you previously copied.
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Step by Step — Duplicate an existing quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

3. Highlight any row under the Quote column you want to duplicate.

4. Select the Actions tab.

5. Under the Quotes section, select the Duplicate Quote icon.

l The resources and prices from the quote you previously selected have been copied into a
new Quote Record.

6. From the Header block, enter in any missing information.

l The information listed in the Header block will not copy over to the duplicated quote.

7. Enter additional Cost Items in the Quote tabs data block.

l Check the default data blocks for any information you want to add to your duplicate quote.
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8. Once done, click OK.
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Quote Comparison & Award
Now that you’ve received quotes and entered pricing information, you will compare them to determine
which is the preferred vendor or contractor to carry their pricing in your estimate. The Quote Com-
parison & Award forms improve visibility into comparative analytics, while increasing efficiencies in
populating the estimate with quoted values.

The Quote Comparison & Award screen is designed to closely match the layout of a vendor com-
parison sheet. It’s designed to show all scope items with prices provided by multiple vendors and sub-
stitute pricing where items have been excluded.

Now that you’ve entered contextual quote information in the Quote Register, the Quote Comparison &
Award screen provides you with the ability to make better, and more efficient determinations for award-
ing the quote.

Quote Comparison & Award Overview
To open the Quote Comparison & Award form, select Quote > Quote Comparison & Award.

Name Definition

1 Resource and
Cost Item Filter

You can show either your quoted resources or cost items.

2 Quote Group Fil-
ter

This section provides checkboxes to further filter your items. The Quote
Group Filter allows you to mark the quotes as reviewed.

3 Quote Descrip-
tion and Vendor

Your quotes display with the vendor name plus the quote description.

l Awarded items have an award symbol
If an item is designated as No Split, it has a chain link icon

l Awarded and Locked items have a lock symbol next to the award sym-

bol

4 Cost Source
Type

The cost source can either be a Plug or Detail type.

Overview – Quote Comparison and Award Form
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Edit Mode
You can make last minute modifications to the quote price directly in the Quote Comparison and
Award form.

When in Edit mode, the quote item's price, unmodified by the quote's bond cost or special conditions,
can be updated. You can modify the Unit price or the Extended price for each of the quote items that
are not part of the package or marked as Free.

The updates made to quote items in Quote Compare and Award will update the estimate in real time
allowing you to see the impact of the changes in the estimate.

Substitute Values
You can display a substitute value by selecting Actions > Substitute Values.

Notice the entered quotes. One of the vendors did not give pricing for three of the CBS items.
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When you compare this quote to the others, it can be difficult to see if the total cost of the quote is high
or low because it is missing some of the pricing. InEight Estimate can help you make an “apples to
apples” comparison by filling in a substitute price for items that are missing.

You can tell when it’s a substitute value because the price displays in italics.

InEight Estimate grabs the substitute value from one of four places:

1. Awarded splittable quote

2. Lowest splittable quote you’ve received

3. Detail (this only applies to quoting cost items)

4. Plug cost (the rate defined for that resource in InEight Estimate)

You can set the order for a substitute value by selecting Actions > Set Substitute Ranking.

On the resulting Substitute Ranking window, you can use the up and down arrows to change the selec-
tion order. It will look from the top to the bottom of the list. The plug being in red represents the most
risk, while the Awarded Splittable Quote is the least risk. Users can modify the color coding of these
Substitute values by navigating to System Customize dialog and then selecting Substitute Quote Rank-
ing in the colors sections.
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Note that the substitute values are color-coded so that back on the Quote Comparison & Award form
you can see the source that your substitute value comes from. When you hover- over a substitute value
it displays the vendor whose substitute value has been used.

When you use a substitute value, it is included in your Comparable Total so you can have a more real-
istic comparison of your quotes.
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Display Ignored Quotes
You can view ignored quotes by selecting Actions > Ignored Quotes.

You can ignore a quote by right clicking on the subcontractor header, then selecting Edit Quote.
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From the Quote Record screen, select the Ignore check box and also a Reason, then select OK.

If the quote record is already awarded, you will not be able to select the Ignore option.

If the Ignored Quotes button is pressed, the ignored quote will display in grey. An ignored Quote can-
not be awarded. The ignored quotes get appended to the right end of the QC&A form.

Export Quote Comparison and Award to Microsoft Excel
The Microsoft Excel file generated when you export the Quote Comparison & Award form closely
resembles the form in Estimate, so users of this output can more clearly understand what the estimators
knew when they made determinations on which numbers to carry.
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The Quote Comparison & Award form changes frequently in the closing hours of a bid, which can
prompt estimators to keep track of what the subcontractor and supplier quotes might have looked like at
any point throughout the bid closing. Some estimators rely on such bid leveling information but do not
want to access live information directly in the application, making it crucial to produce an identical out-
put file of the Quote Compare & Award form at any given time.

To create the Quote Comparison & Award Excel file, click on the Export to Excel icon. Enter a file
name for the Excel file, and then click Save.
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Additional Quote Comparison and Award functions
The Quote Comparison and Award form contains other notable functions which improves the process
of selecting the quote that brings the greatest value to the estimate.

Name Definition

1 Asterisk next to
Quote Item

An Asterisk (*) is displayed on a quote to indicate when that quote includes
quote items appearing in other Quote groups.

2 Zero value
Plug/Detail

Award quotes to Plug or Detail when its value is zero.

3 Updated Quote
Items Tool tip

Quote Item Tool tip displays details including:

l Unit Price
l Extended Price
l Bond
l Taxes
l Special Conditions
l an indicator for a delta quote item

Overview – Additional Quote Comparison and Award Functions

Configure Totals
You can display and sort additional Summary Totals, Special Conditions, and Last Updated fields by
selecting Actions > Configure Tools.
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The Options radio button give you better control for viewing totals at the tops of the screen or after the
quotes.

After selecting additional captions, the new fields appear at the bottom of the Quote Comparison &
Award screen. Notice that the caret symbol next to the Comparable totals in the below screenshot indic-
ates that the Quotes are sorted based on Comparable totals in an ascending order.

Adding Notes to Quote Comparison & Award
The Notes feature within the Configure Totals tool, allows you to quickly add, edit, and view notes for
a quote in the Quote Comparison & Award form. Having visibility into the notes such as phone con-
versations with vendor/supplier, quotes that need clarification, or notes on other attributes will help you
in making better decisions on who to consider when awarding a particular quote.

Step by Step — Add the Notes section to Quote Comparison & Award form

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

l Notice the absence of the Notes section. This is the default option until you follow the next
steps.

3. Select the Actions tab.

4. From the View section, select the Configure Totals icon.
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5. Select the check box in the Visible column for the Notes caption.

6. Select OK.

l The Notes section displays on the Quote Comparison & Award form.

All Quote Groups Layout
The All Quote Group icon, located within the Quote Comparison and Award ribbon, allows you to see
all the quote groups at the same time.

You can make appropriate quote group selections based on understanding how choosing a quote group
impacts the entire estimate. In addition, the quote groups layout provides you with the visibility and
flexibility in aligning scopes, and being able to perform an efficient comparison of various quotes.

Features of this layout include:
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Name Definition

1 Totals per Quote
Group

Ability to see the Awarded Total Plug, Detail and Quote amount per
Quote Group

2 Total Awarded
Amount

Visibility into the Total Awarded Amount per Quote Group

3 Comparable totals Better visibility into the Comparable totals per Quote Group

4 Expand/Collapse Expand/Collapse individual or All Quote Groups to display the quote
items

Overview – Quote Groups Layout

You can scan through all the quote groups in the estimate and see if you are carrying the most appro-
priate quote. You can also review the Totals per Quote Group and better analyze the risks in the estim-
ate based on whether the cost is a plug number, detailed estimate or a quoted value.

Compare and Award Quotes
To award an item, right click on that item and select Award.

The Award icon displays next to the awarded item(s).
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Once you award a quote in InEight Estimate, you can see it adds the Awarded Total on the comparison
screen, and the pricing updates automatically in the Cost Breakdown Structure.

You can award multiple Quote items by selecting all the items and then using the right click context
menu to award.

Open Status

If a quote is yellow, this indicates that the quote record is open in another screen. Closing out of the
quote record, will turn the record back to gray.
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Award Status

The Award Status indicates whether or not all quotes are awarded within a quote group.

Review

You can keep track of what quote groups have been reviewed by checking the Reviewed check box.

This can be helpful when there are many quotes to track and several users managing them. If any
changes are made to quotes within a quote group after the quote group is marked as Reviewed, the
quote group will be highlighted in yellow to indicate something changed since the last review.
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Once reviewed again after the changes, you can uncheck and check the Reviewed checkbox again to
indicate it is up to date, and the yellow highlighting disappears.

The following steps walk you through comparing and awarding the Aggregate quotes.

Step by Step — Compare and award quotes

This exercise walks through a specific example using the Training Job.

1. From the main Estimate landing page select Quote>Quote Comparison & Award.

2. Select Resources on the Quote Comparison & Award ribbon.

3. Under Quote Groups, select Aggregates.

4. Review the quotes to determine the lowest bidder:

l MDIRTB is marked as Free for Example Vendor 4 and their quote is not splitable.

l Vendor 2 Stan Mark did not give a quote for MDIRTB, so a substitute value is being used.

5. Vendor 2 has the lowest comparable amount for MBR Aggregate Base Rock and Vendor 1 has
the lowest comparable amount for MDIRTB, so you decide to award each respectively. Award
each of them by right-clicking on the value and selecting Award.

6. On the attention prompt click Yes.

Package Entire Quote
The Package Entire Quote function allows you to mark an entire quote as a package. This is beneficial
if you are attempting to quickly update an existing detailed quote to a lump sum quote from the Quote
Record or Quote Compare and Award form.
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Incomplete Quotes
The Incomplete quotes status indicates if a quote includes quote items that do not yet have a price. This
is often the case when vendors respond to an RFQ expressing interest in bidding but do not provide
their prices until right before the bid is due. These quotes display in gray in the Quote Compare and
Award form.

Incomplete Quotes that are Scope Only can be viewed in the Quote Compare and Award form using
the Zero Items toggle. These are quotes that have none of the Items priced. These quotes are displayed
to the right of all the Comparable Quotes.
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Scope Items
During the bidding process, it’s common for subcontractors and suppliers to provide a quote(s) for
work during the tail end of the bidding process. These last-minute offers make it extremely difficult for
you to evaluate and compare the various quotes and your ability to award them. With scope items, you
can create and evaluate checklists and quote group exclusions, and account for them within the Quote
Comparison and Award form.

You can view scope items as a checklist of items that break down the quote’s scope of work into indi-
vidual tasks to aid in the process of evaluating subcontractor and supplier quotes in greater detail. This
can be used to ensure that certain items of work are included or excluded. If excluded, the scope items
need to be properly accounted for by contractor awarding the quote.

Section Description

Seller’s Spe-
cial Terms
& Condi-
tions

By default, all scope items are considered included in the quote, and the Special Condi-
tions amount is $0.00. On the quote record, by selecting the checkbox, you can indicate
scope items and uncheck items that are not included. The amount associated with these
items will then total up in the Special Conditions subtotal. The person responsible for
awarding quotes needs to update the Inclusions field to correspond with what the sub-
contractor has agreed to include in the quote.

Overview – Quote Record – Scope Items
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Section Description

1 Scope Items Quote Comparison and Award checklist items for your quote that help with eval-
uating subcontractor and supplier quotes in greater detail. This is used to ensure
certain items are either included (inclusion) or excluded (exclusion) in the quote
and accounted for by the entity awarding the quote.

2 Scope Item Maintained in Quote Record form. These are the Seller’s Special Terms &

Overview – Quote Comparison and Award – Scope Items
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Section Description

Inclusions Conditions scope items that the subcontractor is including in their quote price.
When the scope item contains a value, the subcontractor is agreeing to perform
the work. 

3 Scope Item
Exclusions

Maintained in Quote record form. These are the Seller’s Special Terms & Condi-
tions scope items price. If the Inclusions checkbox is blank, the subcontractor is
NOT agreeing to perform the scope items.

4 Scope Item
value

An entered value means that the subcontractor is excluding this scope of work.
However, you may add an amount because this scope could incur a cost. Once
the bid is awarded, you may find another subcontractor to perform the work.
You are simply accounting for a cost for this scope of work. In the example
below, HD Engineering is not going to paint the electrical equipment, but you
know the cost is $150.00. You are showing this cost to account the cost for this
scope of work that needs to happen.

5 Seller’s Spe-
cial Terms
& Condi-
tions

By default, all scope items are considered included in the quote, and the Special
Conditions amount is $0.00. On the quote record, by selecting this checkbox,
you can indicate scope items and uncheck items that are not included. The
amount associated with these items will then total up in the Special Conditions
subtotal. The person responsible for awarding quotes needs to update the Inclu-
sions field to correspond with what the subcontractor has agreed to include in
the quote.

InEight Inc.  |  Release 20.2 Page 191 of 516

Estimate Help Topics Incomplete Quotes



The example below in the Quote Register form shows quotes from two subcontractors, both with dif-
ferent quote prices. It is important to understand all scope of work the subs are quoting. By just view-
ing these quotes alone, it’s difficult to understand which quote will provide you with the best value. In
other words, just because Example Sub #3 is the lowest priced quote, does not mean it is the best quote
to go with.

The example below in Quote Comparison and Award shows that HD Engineering Group is excluding 3
scope items in their quote that totals $950. This provides a more granular picture for what is being
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included within each subcontractor’s scope of work. It also displays how much each scope of work
costs, so you have the option to find another subcontractor to perform this scope work.

Utilizing Scope Items enables you to more effectively compare quotes from subcontractors and sup-
pliers by providing a deeper comparison of quotes. Moreover, it provides clearer visibility of what a
proposal may or may not be including at the time you are attempting to make an award.

You can make a more informed decision on whom to award the quote to, now that the vendor quotes
and associated scope items are all visible on one screen.

Scope Item Setup
Scope items are stored within each quote group tag in the Foundation Setup Data form. On each Quote
Group Tag Record, you can list out scope items that break down the work into smaller scopes of work,
along with the estimated cost amount associated with each scope item.
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Step by Step — Set up scope items

This exercise walks through a specific example using the Training Job.

1. Open your job.

2. Select the Setup tab.

3. Click on Foundation Data Setup in the Initialize section.

4. Select the Quote group tags tab to set up scope items within a quote group.

5. Create a new Quote Group Tag called Electrical Work and click Ok.

6. Open Electrical Work and add the following scope items:

l Permits

l Surveying and Layout

l Temporary Traffic Control Devices

l Trench and Backfill for Electrical Work

l Painting Electrical Equipment

l Temporary Power and Lighting

7. Enter 500 in the Amount field for Survey and Layout, and a 300 for Temporary Power and Light-
ing.
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8. Click Ok.

Step by Step — Set up quotes for scope items

This exercise walks through a specific example using the Training Job.

1. From the Estimate tab, click on Cost Breakdown Structure (CBS).

2. Change your saved views to Quote Group Setup view.

3. Create a cost item Entry Gate with a subordinate Electrical Work.

4. Assign the Electrical Work quote group to the Electrical work cost item.

5. From the Quote tab, click Request for Quote (RFQ) to open the RFQ register.

6. Create an RFQ by selecting the New icon on the Actions tab.

7. Select Create RFQ from Quote Group Tag(s) and select Electrical Work.

8. Click Ok.

9. Click on the Seller Companies tab and select the following company names:

l Architectural Designs

l HD Engineering Group

10. Highlight both companies and select Publish.

11. Assuming you’ve already received quotes back from both companies, create a quote from this
RFQ for both companies by selecting the companies and selecting Create Quote.
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12. Click Ok to close the RFQ record.

Scope Item Creation and Award
The following Step by Step assumes you are putting out an advertisement for bids for some electrical
work on a project. You will add scope items with some fixed costs as a special condition, then will com-
pare quotes in order to decide which vendor quote is the best deal.

Step by Step — Manage and award scope items

This exercise walks through a specific example using the Training Job.

1. Click the Quote tab and then click the Quotes icon to open the Quote register.

2. Open the Quote Record for HD Engineering Group and enter a Unit Price of 3,500 which is
based on the quote you received.

3. Select the Special Terms & Conditions tab and select the Seller's Special Terms & Conditions
radio button.

4. Assuming the HD Engineering is excluding certain scope items from this quote, click on the
Included checkbox to exclude (uncheck) the following scope items:

l Surveying and Layout

l Painting Electrical Equipment

l Temporary Power and Lighting

5. Type 150 in the Amount field for Electrical Equipment.
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l Notice how the 3 scope items you just excluded are now added to the Special Conditions total for
the quote.

6. Click Next to move to the other Quote record for Architectural Designs.

7. Enter a Unit Price of 3,700.

8. Press Tab to move to the Special Terms & Conditions tab and select the Seller's Special
Terms & Conditions (at right) radio button.

9. Uncheck the inclusions checkbox for Surveying and Layout.

10. Add the amount 500.

11. Click Ok.

12. Select the Quote tab.

13. Open the Quote Comparison and Award form, and select the Cost Items tab.

14. Under Quote Groups, select Electrical work.

15. Right-click on the quoted amount for Architectural Design and select Award to award the work
to them.

16. Click Yes on the resulting prompt to mark the quote group as reviewed.
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Quote Item Adjustment
Quote items can be adjusted even after a quote has been awarded. This could happen on closing day
when a vendor sends in a last minute discount. For example, vendor 3 has sent in a 10% discount on
piping materials. This percentage discount is applied to the vendor 3 quote by entering the 10% in the
Condition Adjustment column.

Step by Step — Quote item adjustment

From the Ribbon, select the Quote tab.

1. Under the Quote Comparison and Award section, select Resources.

2. Locate a Vendor column.

3. Select the quote you want to edit under the vendor column. In the Ribbon, select the Actions tab.

4. Under the Quotes section, select Edit Quote. You can also right-click and select Edit Quote.
This launches the Quote Record.

5. You can make Condition Adjustments by a percentage or an amount. Select the field to adjust the
percentage or amount of the Condition Adjustments.

6. Items adjustments can be applied individually or by using the multi-edit function. Select multiple
resources in the Quote Record, then right-click and select Open. This opens the Quote Resource
Item Record.

7. If you populate a 10% discount adjustment to all of the items selected using the multi-edit tool,
the amount value changes to “Varies”. This is because of the variance in the unit rates for each
selected item.

8. Click Ok to save the changes to the line items in the Quote record and to save the Quote.
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Reports Menu
InEight Estimate provides a lot of out of the box reports, referred to as “canned” or “system” reports,
that can help you review and analyze your estimate.

Non-Modal Report dialog box
The Reports dialog is docked along with the other forms and registers. You can continue to work with
your estimate without being forced to close the Reports dialog box.

If the report becomes undocked, the job code shows in the reports dialog box header.

Adjustable Reports
Most of the reports within InEight Estimate can be adjusted to output the specific data and reporting
format you need. Each report has its own set of output settings for configuring and formatting the
report.

All InEight Estimate adjustable reports are accessed from the Reports menu. You may even run the
same report multiple times and choose different output settings based on what you want to see or who
the intended audience is.

For example, you may choose to run the CBS Details Report several times to satisfy different needs or
for different audiences, and include or exclude specific data depending on what you or the report recip-
ients want to see.

l For a group of estimators, you may want to run a CBS Details Report that shows all cost and pro-
ductivity data for a job

l For field personnel, you may want to run a CBS Details Report that shows no cost data, but all
production and resource data

l Finally, for executive management, you may want to run a CBS Details Report that shows sum-
mary level information only

The following steps take you through a brief overview of the Reports menu and how you can access it.
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Step by Step — Getting to the Reports menu

1. Open the Training Job, and select Setup tab.

l You access the Reports menu by clicking on the Reports icon

You can access the Reports menu from the Setup, Estimate, Quote, Price, and Execution
tabs.

2. Select Reports.

3. Here you select the Report of your choice. For this example, select the first option, Job
Properties.

l You will see a split screen with the reports available on the left side bar

l The side bar on the left of the Reports form contains a “tree” of all InEight Estimate
adjustable reports

l On the right, when you select a report node on the left, note that it displays the Output Set-
tings on the right side of the form, from which the report settings can be adjusted and the
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report can then be run

4. Each report has a Print tab, a Layout tab and a Header/ Footer tab specific to that report.

l There are also Master Layout Settings and Master Header/Footer Settings located at the bot-
tom of the left-hand side bar tree. Here you can define settings that will apply to all reports

Output Settings
This section provides a more detailed explanation of the output setting tabs.

Report Printing Options

The Print tab includes three options for printing output: Print to Printer, Export to File, and Preview.
Export file outputs include PDF, Excel, text, and more.

Print Preview

The Reports print previews opens in its own tab in the Report Dialog. This lets you keep the report
open while continuing to use other parts of the application.
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You can also undock and float a report on a different form, or you can tile it side by side with another
register to view and compare them.

Print Preview Ribbon

The Print Preview menu is displayed on its own ribbon. Menu commands are shown in the ribbon as a
contextual Print Preview menu when navigating to Reports > Print > Preview > Run.
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Apply custom Layouts and Headers/Footers to register reports

You can apply custom Layouts and header/footers to register based reports. Upon saving a view in any
register, select the option to save it as a corporate view and include the view in the reports dialog box.

When selecting a Saved View from the Reports register you can use the Print tab to customize the print-
ing preferences, use the Grid Options tab to change the font type/size, use the Layout tab to modify the
design style, and use the Header/Footer tab to insert a header and footer to your report.

InEight Inc.  |  Release 20.2 Page 203 of 516

Estimate Help Topics Output Settings



When you click on the Run button it will create a new register-style report. You can modify the layout
or header/footer directly in this register. You can also toggle between any of the four other tabs to make
modifications and see the changes on the saved view report.

Report Layout Settings

Many of the InEight Estimate adjustable reports include formatting options for the general layout of the
report, located under the Layout tab of the report’s output settings. Settings for the report include: Ori-
entation, Margins, Font, and Number Format.
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Report Header/Footer Settings

Many of the InEight Estimate adjustable reports include the option to define and insert headers and foot-
ers into the report. You can add information to the left, middle, or right of the header and footer sec-
tions of the report.

1. Once you define headers and footers, you can save them for use on other reports.

2. You can add page, time, and date stamps as needed, as well as images (e.g., company logo).

3. You can also use brackets to have it “stamp” the report with the Job Code and Job Description.

4. You can enter your own information as desired.
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Cover Sheet fields and Job folder tags

In addition to the existing job code and job description tags in Job Properties, you can use the Cover
Sheet fields and Job Folder tags for your headers and footers in all standard reports.

Additional tag values such as contract numbers, work order numbers, PO numbers, company logos, or
any other tag fields can also be included. These additions help you customize headers and footers to
give the recipients more transparency in the reports.

A Header and Footer field menu exists to the left of the Page Header and Page Footer grid, for all stand-
ard reports. This lets you choose which fields from Job Folder Tags and the Cover sheet to include in
your report.

You can customize your header and footer layout settings, save them, and re-use them in other reports.
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Report Detail Settings

Most reports have a Details tab with various options to configure what information is included on the
report.
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Save Output Settings

Once you’ve configured your settings for the report, you can save them as a custom version of that
report.

The following steps walk you through configuring the settings and formatting for two different reports.
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Step by Step — Configure Report Output Settings (Report 1)

1. Open the Training Job and select Setup >Report>Resources.

2. Under Resources on the left side bar, select Resource Utilization.

3. On the Print tab there are three options. A best practice is to always set to Preview so you can
review before printing.
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4. On the Layout tab you can make adjustments based on your preferences.
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5. Move to the Header / Footer tab. Remove the default Report Title from the first page Header
only and enter Resource Utilization in the center Report Header box as a title that will appear on
the first page only.
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6. Go to the Details tab, and you can see the details and options you can select to customize and
adjust the report.

7. For this navigation, you will not Filter by currency; leave the selection as No Filter.

8. Under Report Type, choose the first option, Resource Utilization Summary.

l You can choose to select the Hide Zero quantity/cost Resources Employments Details box
if you prefer to have your printed report not show any resources that have a dollar value of
zero
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l You can choose if you want the report at a summary level, or if you want it to reference
your cost items when you are looking at a resource

l If you choose Resource Utilization Summary with Employed Cost Items, it adds CBS pos-
ition to the structure of the report

l You would select this if you wanted to see cost items and resources by the cost item

The Details settings are “sticky” features, meaning they default to what was selected the
last time.

9. You can use grouping to group by different tags and user-defined fields. Most of them are related
to the Resource Rate Register, for example: Geographic Area, Organizational Category, Wage
Zone, etc. For this example, group by Resource Organizational Category.

10. Next, you can choose the resources you want to see. For this example, select the Labor and Con-
struction Equipment Resource Types.

l For this example, you will not make any selections under Columns or Details

l This is just one of many ways to organize and adjust your report.

11. Click Run to run the report.

l This report can be helpful for seeing your utilization hours, broken down by regular time
and overtime hours

12. Click the red X to close this page and open the Construction Equipment page.

13. Click the red X to close the Construction Equipment report.

Step by Step — Configure Report Output Settings (Report 2)

1. Open the Training Job and select Setup >Reports, then expand the Cost Breakdown Structure
node.
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2. Under Cost Breakdown Structure on the left side bar, select Estimate Summary.

3. Along with the Print, Details, Layout, and Header / Footer tabs, there is an additional tab called
Cost Item Selection. Select this tab.
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4. The Cost Item Selection tab allows you to report on a selection of cost items:

l Print a contiguous range of cost items:  Allows you to print a series of cost items in a row.
In this case, print just items: select 4.1 in the From field and 4.3.2 in the To field.

l Select cost items to print from the register below:  Allows you to use column filters to
select the cost items to include in the report; leave this button unselected.

5. You can roll up your cost items to a certain CBS level for the report as well, depending on the
level of detail you need.

6. On the Details tab, select Days for Cost item production field 1, and Man-Hours / UM for Cost
item production field 2 (this report allows you to report on two production values).

7. Under Resource Types, uncheck all of the boxes except Labor, ConstructionEquipment, and
Installed Material.
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8. Leave the rest of the settings at their defaults, then select the Header / Footer tab.

9. In the center Page Footer field delete the existing text, then type Confidential –Internal Use Only.

10. To save the settings you’ve configured, click on the Settings drop-down arrow above the output
setting tabs.

11. Select the Save disk icon to save the new settings.

12. Type Estimate Summary – Manager.

13. Click OK.

l Notice that a custom version of the report now displays under Estimate Summary on the
Reports tree on the left
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Helpful Reports
PBS Summary

Under the Price Breakdown Structure Report node, the PBS Summary Report gives a good overview of
how your price breaks down by cost category. This provides a high-level overview that is cost category
driven, providing information based on the total value of the project.

When selecting your settings on the Details tab, a best practice is to select and include:

l Cost Categories

l Markup Rate

l Percentage of Cost

This allows you to see your costs and markup broken out by cost category.
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You can also select to show markup rate and what percentage the markup is of your cost.

Access Control
You can use the Access Control report to audit user permissions, command access, and various restric-
tions without having to search through the Access Control register for this information.
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Standard Proposal
Located under the Pay Item & Proposal report node, the Standard Proposal report can be used for con-
tractors required to submit a pricing proposal to a client. It lists all the pay items with the client
provided quantities and your final pricing. You can include subtotals (defined on the Pay Item & Pro-
posal Register), cover sheet information, and a signature block.
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CBS Details
Under the Cost Breakdown Structure report node, the CBS Details report can be a helpful report for bid
review. On the Details tab you can include or not include any of the information contained in the CBS
Register, including cost items with production, costs by category, shift arrangements, resources, and
notes.

Audit
Under the Job Tracking node, the Audit Report is a very important report to run during estimate review
to make sure you didn’t leave anything out of the estimate. It checks for a number of potential errors in
the estimate, including:

l Zero Price Pay Items

l Zero-value cost items

l Pay items without Cost Items assigned

l Resources with a quantity of zero
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Register Reports
At any time, you can print a report of the data in the currently displayed register using the Print or Pre-
view option available from the Actions tab for the register you are in.

The data that prints is the data currently displayed on the register form. The report will print whatever
columns are displayed on the register; if you have customized the display in the register, the report
prints that data. In other words, register reports are entirely customizable.

By creating Saved Views, you can report the data on a register form in several different variations.

The following step by step example will walk you through creating a custom register report on resource
utilization and saving it as a Saved View.

Step by Step — Create a Register Report

1. Open the Training Job and select Setup tab, then select the Resource Rates drop-down list.

2. From the drop-down list, select Labor.

3. From your Saved Views drop down menu on the Resource Rate Register, select the Print View
for Summary view.

4. Notice this view includes utilization hours

5. Right-click on a column header and select Column Chooser.
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6. From the Customization window, drag-and-drop the Minority Percent, Unique Sales Tax, (Scale
2), and Maint. Man-Hour Factor columns into the register.

7. Close the Customize window.

8. Sort the Utilization Count column by clicking on the column header twice so that you see the
bars descending.

l This sorts your items so the most utilized resources are at the top

9. Click on the Saved Views drop-down menu and select the Save disc icon to save the view.

10. Name the view Labor Utilization View, and then click OK to save the customized view.

11. From the Actions menu, select Preview to review the report before printing.

Page 222 of 516 InEight Inc.  |  Release 20.2

Audit Estimate Help Topics



Register Report Output Settings
Within the Preview for a register report, there are several options to choose from to configure the out-
put of your report.

Page Setup

While in the Preview mode, selecting File > Page Setup provides setup options for the page format:

l Page Size (legal, letter, etc.)

l Paper Width & Height

l Orientation (portrait or landscape)

l Page Margins (left, right, top, bottom)

Exporting to Document

Using the Export function allows you to identify a Print range, Image quality, Password Security, and
more. Selecting File > Export Document prints an Adobe Acrobat (*.pdf) report.
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Copy an Existing Job
As you build an estimate, you may want to reuse pay items, cost items, or resources from a previous
estimate. When you plan to reuse the majority of content within a job, you can simply make a copy of
the existing job.

Using the Create a new Job from… Existing Job option on the Backstage View creates an exact replica
of the existing job, including the job’s properties, pay items, cost items, and resources.

The following Step by Step walks you through how to make a copy of an existing job.

Step by Step — Copy an Existing Job

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Existing Job.

3. The Job Register displays a list of your existing projects; select the Training Job and click OK.

4. On the New Job dialog, click the ellipses and select a Core Project.

5. In the Code field, type Infra Job Copy with your initials.

6. To copy the cost details from the existing job to the new job, verify that the Copy Cost Details
checkbox is selected

l If you wanted to copy just the cost item structure without cost details, you would uncheck
the box.
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7. Uncheck the check for copying the PBS Changes Log, Copy Quotes and Auto-Update Job in Con-
nected Analytics.

8. Click OK to create the new job.

The new job opens with the Job Properties form active, so you can begin to modify the new job
as needed. If you look through the tabs on the Job Properties form, you will find that it looks
exactly like the job from which it was copied. Other forms, such as the Pay Item & Proposal
Register and the CBS Register, also look the same in both jobs until you make modifications in
one job or the other.

This is a very easy method for creating a new job, and it is a good choice if you want to copy an
entire job. However, if you want to pick and choose which parts of a job to duplicate, the Bid
Wizard is a better choice.
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Templates
Job Templates provide you the ability to maintain a list of template jobs that can be used to create new
jobs. As your company grows and increases the number of projects, the need to standardize the estim-
ating process increases to ensure consistency and reduce the chance of information being overlooked.

In InEight Estimate you can create job folders and store them in a separate register as templates. This
allows you to store cost items in master templates separate from the jobs in your Job Register.

You can copy the template’s foundation setup data, such as account codes, tags, work breakdown struc-
tures, and work group tags to your estimate. In Setup > Foundation Setup Data > Copy data from
another Job, select a template job to copy its foundation data.

The Copy data from another Job action includes jobs marked as Is Template.

You can create templates from scratch or from existing job folders. The following steps walk you
through how to create a new template from an existing job folder.
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Step by Step — Create a Template

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select Templates.

3. Under Templates, select the Template Register.

4. From the Actions tab, select Create Template from Job.

l The Job Register opens for you to select the source job for the template

l Assume that you want to make a template from your E101 Training Job

5. Select the E101 Training Job with your initials, then click OK.

You cannot create templates from jobs that are published to Job Tracking.
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l The New Template From Job 'Training Job' with your initials prompt appears.

6. Click the ellipsis to the right of the Organization field.

The Organization Register Library opens.

7. In the Organization Register Library, select an organization and then click OK.

8. In the Code field, type Small Project Template[your initials].

l Leave Copy Cost Details and Copy PBS Changes Log checked

9. Click OK.

l The new template is created and opens to the Job Properties form

l You can add the description in addition to the code for any new job you are creating from
a template. This description is later added to the Overview tab of the new job on the Job
Properties form

l Back in the Templates Register, you can see the new template created
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l Similar to copying an existing job, you can create a new job from a template from
the New menu in the Backstage View.

l You can also create a new job from a template from the New menu in the Bid Wiz-
ard.

10. Select Add to existing job

11. From Select Source Job, click the dropdown arrow

12. Click Next

13. Select a job that is shown as having a Template

14. Click OK

OBS filter tree
The Template register's organization tree filter shows the templates assigned to a selected organization.

InEight Inc.  |  Release 20.2 Page 229 of 516

Estimate Help Topics OBS filter tree



Just like the job register, the list of templates is filtered based on the selected organization. The primary
difference between the OBS tree filter in the job and template registers is that estimates are associated
with projects in the job register, and projects belong to an organization. In the template register, tem-
plates belong to an organization.
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Archive and Restore Templates
The templates feature gives you the ability to archive and restore templates, enabling templates to
become portable. You can move templates between different environments. You can also backup the
templates similarly to the Jobs Archive and Restore function.

Step by Step — Archive and Restore a Template

1. Click File to open the Backstage View.

2. Select Archive / Restore.

l Several options appear for archiving and restoring your jobs, templates, and library

3. Select Archive Template.

l The Template Register appears

4. Select the Small Project Template [your initials] template you previously made, then click OK.

5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. Select Restore Template from the Archive / Restore page of the Backstage View to begin restor-
ing the template.

8. Browse to the archived template and select it.

9. Click Open.

l If the template already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Template Code

You can assign templates to specific organizational nodes in the OBS, grant permissions, and control
user access for templates.
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For example, you can assign a template to a specific node level in the OBS that is specific to Power
Delivery. The OBS node structure assignment is useful for assigning estimators access to designated
templates as determined by an Estimate administrator.
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Estimators with the appropriate Estimate/template permissions in Suite Administration > Roles and Per-
missions > Master Data Libraries > Estimate, can use the templates in which they are assigned to in
their designated OBS node.

Step by Step — Assign Template to OBS

1. Open the Training Job, then select the Templates.

2. Select Template Register.
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3. Select New.

4. Click the ellipsis to the right of the Organization field.

Page 234 of 516 InEight Inc.  |  Release 20.2

Archive and Restore Templates Estimate Help Topics



The Organization Register Library opens.

5. In the Organization Register Library, select SF2090-Renewables, and then click OK.

The new template will be set at the SF2090-Renewables node in the OBS. Users assigned to the
SF2090-Renewables level or above in the OBS will be permitted to use this template when cre-
ating estimates.

6. The next step will be to create a new template code and a description to complete the new tem-
plate creation process.
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What's next: After the template is created you can start to create estimates using a template.
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Bid Wizard
InEight Estimate’s Bid Wizard is a powerful tool that can help automate the process of setting up estim-
ates by copying information that already exists in other InEight Estimate job folders. The Bid Wizard
can be used to create new projects, create a new job from an existing template, or to add to projects that
are already underway.

Rather than copying every part of an existing job, the Bid Wizard gives you more flexibility and con-
trol over which parts of a job you want to duplicate, e.g., pay items or cost items or both.

In most cases you will be copying cost items, but if you have a project with pay items that are com-
monly used, you can copy them into a new project. If you select pay items, you will be able to select
cost items as well.

The following Step by Step walks you through how you can use the Bid Wizard to create a new job by
importing pay items and their associated costs from an existing job.

Step by Step — Use the Bid Wizard

1. To open the Bid Wizard, click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Bid Wizard.

l The Bid Wizard – Step 1 dialog displays

Notice that you can either create a new project or add to an existing project.
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3. Type E101 Bid Wizard (with your initials) in the New Code field.

4. Type Bid Wizard Example in the Description field.

5. Click the Next button.

l The Bid Wizard – Step 2 dialog displays

6. Choose Select cost items and click Next.

l The Bid Wizard – Step 3 of 4 dialog displays

l You use this step to indicate which source you want to pull your setup data from (the lib-
rary or your source job)

7. For all selections, select Copy from source job.

8. Check the Also copy all non-utilized resources checkbox.

9. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy Markup
box is automatically selected.

10. Click Next.

l The Bid Wizard – Step 4 of 4 dialog displays

11. Click the Source Job drop-down arrow.
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l The Job Register opens

12. Find and select Training Job.

13. Click OK.

l This screen displays the cost items of the source job (Training Job). All items are auto-
matically selected

14. Use the Toggle Include All button to exclude all selections.

15. Select the checkboxes to include Mobilization, Clearing & Grubbing, and Unclassified Excav-
ation.

16. Notice that when selecting Unclassified Excavation, that cost item’s subordinates are auto-
matically selected

17. Click Finish to add the new job.
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l An Attention prompt appears asking, “Do you want to adjust Pay Rules and Shift Arrange-
ments of the copied cost items?”

l Typically, you will want to use the shifts and payment rules of your new destination job.

18. Select Adjust the pay rules and shift arrangements to match the destination.

19. Click OK.

l A help bubble appears letting you know the job has been created, and that you can use the
ribbon tabs on the Estimate landing page to open any form

20. Close the help bubble by selecting the X in the upper right corner.

21. Open the Estimate > CBS to see the three cost items that were brought in.

Bid Wizard Updates
While using the Bid Wizard, the Include option is left unchecked by default. A filter is applied to bring
in pay items when using the Bid Wizard. The Toggle Include All button only selects the filtered list of
items instead of all items.

When the filter criteria is modified, the selected items remain checked even if some of the items might
not be visible in the view. When the view is changed, the selected items remain checked.

Tags and UDF fields are included in the Bid Wizard Selection register for the cost items and Pay Item
& Proposal selection registers. This lets you filter the list of cost items based on a tag or UDF.
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When you select the Toggle Select All button, only filtered items are included which allow you to
include scopes of work relevant to your estimate without having to manually select all items needed.
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Copy Estimate Data Using Edit Commands
While the Bid Wizard is an efficient way to copy cost history into new projects, you may prefer to use
edit commands such as copy and paste to bring cost history into your estimate.

To copy and paste cost history from one job to another, it is beneficial to see the jobs side by side. The
following steps walk you through the process.

Step by Step — Copy Estimate Data Using Edit Commands

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you just cre-
ated.

2. Open the Training Job (if you do not still have it open).

3. Make sure the CBS is open for both jobs by going to the Estimate menu and selecting Cost Break-
down Structure (CBS).

4. Since you have both jobs open and they are in their own application window, align them to be
side by side by using the minimize icons of each job or utilizing Windows align functionality.

l Note that the window caption identifies the CBS Register for each job
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5. On the CBS of the Training Job, click the row header on cost item 4 – Aggregate Base and press
Ctrl+C to copy the cost item.

When you copy a superior cost item, all of its subordinates are automatically copied.

6. On the CBS of the E101 Bid Wizard job, click the row header on the first blank register row, and
press Ctrl+V to paste the cost item.

7. On the Attention dialog, select Adjust the pay rules and shift arrangements to match the des-
tination and click OK.

l You can see in the destination job’s CBS that you’ve added the Aggregate Base cost item,
along with its subordinate cost items and all cost and productivity detail
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You can also drag and drop cost items from one CBS to another instead of copying and
pasting.

Copied cost items are considered Job Overhead until they are assigned to a pay item

8. To go back to your full screen view of the E101 Bid Wizard job, select the maximize icon.
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CBS Bid Wizard
You can also use the Bid Wizard to add cost items while you are in the CBS Register. The following
steps walk through using the CBS Bid Wizard.

Step by Step — Use the CBS Bid Wizard

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you created.

2. From the Estimate tab, select Cost Breakdown Structure (CBS).

3. Create a new cost item by typing New in the Description column on the bottom row of the CBS

4. Highlight the New row.

5. To open the CBS Bid Wizard, click the Bid Wizard icon on the More Actions tab.

l The Bid Wizard window opens

6. Click in the Source Job column on the New cost item row.

7. From the Source Job drop-down list, select Training Job.

8. Scroll to the right of the Source Job column and click in the Source CBS Position Code column
on the New Cost item row.

l A source CBS Register window appears

9. Select CBS position code 5 – Asphalt Concrete Hot Mix Type A from the register.
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10. Click OK.

11. Click Finish on the Bid Wizard.

l An Attention prompt displays, asking if you want to make adjustments

l Keep the default options selected: Make Adjustments according to their quantity drivers
and cost drivers and Adjust the pay rules and shift arrangements to match the destination

12. Click OK.

l You can see that cost item 5 and its subordinates are now imported into your existing job.

l You could choose a new name for the cost item, or name it Asphalt Concrete Hot Mix
Type A to match the original cost item
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Snapshots
A job snapshot is a copy of an estimate that provides read-only access to the job as it existed at a spe-
cific point in time. You can now filter the Snapshot register to jobs containing snapshots.

The Snapshot register has some additional columns as well. In addition to the Code, Description, Last
Saved, and Version column, the Snapshot register contains all fields that are present on the Jobs
register that provides you with an easier way to group, sort, filter, and find the jobs you need.

Snapshot Register
The Snapshot Register is where you will view individual snapshots for specific jobs.

Step by Step — Snapshot Register

1. Click theFile tab to open the Backstage View. In the panel, select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. To view individual snapshots for specific jobs, click the icon next to the desired job to display
the list of snapshots.

Creating a New Job Snapshot
Step by Step — Create a New Job Snapshot

You can create a Job Snapshot from an existing Job.
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1. From the Snapshots form, select the Create Snapshot tab.

2. If an existing job is open select Save, if you haven’t already done so.

3. A New Job Snapshot [Job Code Here] dialog box appears. From there, you can add a Snapshot
comment.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box, otherwise uncheck the box.

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button.

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
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(Users with current access to the job default onto the list.)

4. Click OK to create the snapshot.

5. A pop-up indicates when the snapshot has been created.

Editing a Job Snapshot
Step by Step — Edit a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to edit and select Edit.

3. The same sort of dialog box opens up as when you created the Snapshot. In this case, from the
Edit Job Snapshot [Job Code Here] dialog box, modify the Snapshot Comment and the User
Access options as needed.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box. Otherwise, uncheck the box

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button
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l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
(Users with current access to the job default onto the list.)

4. Click OK to update the snapshot.

Deleting a Job Snapshot
Step by Step — Delete a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to delete snapshots from and select Delete.

3. Click OK

Alternatively, you can delete all Job Snapshots by clicking Delete All Job Snapshots from the
Actions tab.

Loading a Job Snapshot
When you load an existing Snapshot, it loads into Estimate as any other job.

Step by Step — Load a Job Snapshot

1. Click the File tab to open the Backstage View, then select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. On the Snapshot Register, click the icon next to the desired job to display the list of snapshots.

4. Right-click on the individual snapshot you want to load and select Load.
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To identify a snapshot in Estimate as a read-only snapshot:

l The job name is preceded by the label SNAPSHOT: centered on the top of the toolbar

l A red banner shows the specific snapshot information at the bottom of the screen

A snapshot can be modified, but it cannot be saved as it is read-only.
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Export to Excel
InEight Estimate's integration with Microsoft Excel includes a two-way integration that allows you to
update register fields in InEight Estimate with data contained in an Excel workbook, and update Excel
cells with data contained in a register column in InEight Estimate.

InEight Estimate includes a workbook export that makes it easy to transfer data out of InEight Estimate
register forms to Microsoft Excel spreadsheets. This feature makes it faster and easier to send data from
an InEight Estimate register to a spreadsheet, analyze it, modify it, and customize it for any other uses.

The Export to Excel feature is available on all register forms in the system and allows you to export the
data currently displayed on a register form to an Excel worksheet.

Step by Step — Export Data to an Excel Workbook

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. From the Actions tab, select Export to Excel.

3. On the Export spreadsheet to... dialog, browse to the location (folder) in your system where you
want to save the workbook, enter CBS Export in the File name field, and click Save.

l The workbook is saved to that location with the specified file name, and Excel auto-
matically launches and displays the workbook

l Notice that the columns are formatted, with column headers and filtering turned on
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Cell Select
To copy and paste data in InEight Estimate or to Excel, you can use a feature called Cell Select. Walk
through the following steps to learn how to copy specific fields in InEight Estimate to an Excel Spread-
sheet.

Step by Step — Cell Select

1. Open the Training Job and from the Setup tab, open the Resource Rate Register.

2. Select the Labor tab.

3. Select Print View for Summary from your Saved Views drop-down menu.

4. From the top-right corner, select the Cell Select icon, (next to the Help icon). This puts you
in Cell Select mode, so you can select cells to copy in the same way you would in Excel.

5. With the Cell Select icon active, highlight all information in the Description, Utilization Count
and Unit of Measurecolumns for all Labor resources.
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6. Right click on the selection and select Copy.

7. Open an Excel spreadsheet, right click in the A1 field and select Paste Special, choosing CSV as
the Source.

8. Click OK. The fields you copied from InEight Estimate paste into the spreadsheet.
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To turn off the Cell Select, simply click the Cell Select Icon again and it deselects
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Linking to the Job Workbook
InEight Estimate Workbook
Every job has its own workbook embedded within it for doing side calculations and take-offs. You can
link your calculations to fields in InEight Estimate to automatically update them into your estimate.
When you create a new job from scratch, the Library Master Workbook is copied to create a new
embedded workbook for the job.

The job workbook comes with some pre-defined take-off and analysis worksheets, or you can create
your own. Simply open the appropriate job worksheet, plug in your values, and the worksheet will cal-
culate your results. To open your job’s workbook, select the Estimate tab, and then click on theWork-
book icon in the Workbook section.

The embedded job workbook for the job opens.
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Linking to and from the workbook
InEight Estimate's linking capabilities with the job workbook can be done in one of two ways. A field
in InEight Estimate can be populated with a value from the job workbook, or a cell in the worksheet
can be populated with the data from an InEight Estimate field. This two-way linking functionality lets
you to make quick work of complex chores to perform workbook-based take-off or formula-driven ana-
lysis.

The following example walks through how to link a simple take-off calculation into InEight Estimate
from the job workbook. It is a take-off to determine the size of a concrete foundation.

Step by Step — Link Estimate to the job's workbook

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. For this example, create a new cost item in the blank row at the bottom of the CBS register and
name it Concrete Foundation.

3. Open the job’s workbook from the Estimate tab, by selecting theWorkbook icon.

4. In the job's embedded workbook, create a new worksheet named Concrete Take-off and enter the
following fields:

5. Create a new row to calculate the total cubic yards by factoring the length, width, and height
quantities.
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l Your Volume Total should be 50 cubic yards

6. InEight Estimate will only link to named fields in the worksheet. Click in the field you want to
name (B6), then click in the Field Name window and type Volume.

7. Go back to the CBS register and right click on the Concrete Foundation cost item Forecast (T/O)
Quantity field.

8. From the resulting right click menu, select Link this field to Workbook.

l You can also link the field by selecting the field and then selecting Link Field from the
Actions tab

9. On the Link to Workbook dialog, select the Update Estimate Field from Workbook radio button.

10. In the Field to link window, select Volume (you may need to click the Refresh button for the
field name to display).
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11. Click OK.

l The Forecast Quantity field for Concrete now is linked to the Volume field in the work-
sheet and populates with the take-off quantity (50)

Update Links
When data in InEight Estimate or the job workbook changes, you can quickly update all links, in just
the currently active job or in all open jobs.  Simply select one of the following options from the Work-
book drop-down list on the Estimate tab.
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Cash Flow Display Settings
Cost Items and Cost Categories
The Cash Flow Display Settings allow you to control what information displays on the Cash Flow
graph. To open the Display Settings click on the Actions > Display Settings icon in the Tools section.

Section Description

1 You can save your display settings for future use.

2 Select how the graph measures the timing of your cash flow. Options include:  Day,
Week, Month, Quarter, and Year.

3 Under the Cost Items section, you can select:

l Total Cost (Forecast):  The total cost of your scheduled cost items, based on when
your costs are accrued (when your cost items are scheduled). This is displayed as a
dashed line on the graph

l Total Price (current):  The total revenue of your pay items, based on when the rev-
enue is earned (when your cost items are scheduled). This is displayed as a dashed
line on the graph

l Total Cost (Forecast) – Cash:  The total cost of your scheduled cost items, reflecting
the cost timing you specify in the Cash Flow Options. This is displayed as a solid
line on the graph

l Total Price (current) – Cash:  The total revenue of the pay items, reflecting the rev-
enue timing you specify in the Cash Flow Options. This is displayed as a solid line
on the graph

l Cash Flow:  Displays the difference between your Total Cost – Cash and Total Price
– Cash values, so you can see if you are making or losing money

l Finance Cost:  Displays the Cost of Money amount calculated from the settings you
specify in the Cash Flow Options

4 You can check the Estimated box for any specific cost categories you need to display.

l The other check boxes are used for InEight Estimate Performance

Overview – Cash Flow Display Settings – Cost Items and Cost Categories
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Cash Flow Display Set Up

The following steps walk you through setting up your Cash Flow Display Settings.

Step by Step — Cash Flow Display Settings Set Up

1. In the E101 – Training Job, from the Estimate tab, select Cash Flow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. From the Period drop-down list, select Week.

4. Under the Cost Items section, make sure the following are selected:

l Total Cost (Forecast)

l Total Price (Forecast)

l Total Cost (Forecast) – Cash

l Total Price (Forecast) – Cash

l Cash Flow
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l Finance Cost

5. Under the Cost Categories section, check the Estimated checkbox for the Labor and Owned
Equipment categories.

6. Click OK to close the Display Settings window.

l Your Total Cost (Forecast) displays as a dashed red line, indicating your accrued costs
based on when your cost items are scheduled and the assigned cost curves for each cost
item.

l Your Total Price (current) displays as a dashed green line, indicating the revenue you’ve
earned, based on the timing of your pay items

l Your Total Cost (Forecast) – Cash displays as a solid red line, indicating your costs, based
on when your cost items are scheduled and the cost timing defined in Cash Flow Options

l Your Total Price (current) – Cash displays as a solid green line, indicating your revenue,
based on the timing of your pay items and the revenue timing defined in Cash Flow
Options

l Your Cash Flow displays grey bars indicating when your cash flow is negative or positive
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l Your Finance Cost displays as a blue line on the graph

7. To filter your graph by date range, click on the Start drop-down arrow and select a start date of
your date range filter.

8. Click on the End drop-down arrow and select an end date of your date range filter.

l Your graph now only includes your cost items that fall within the specified date range

9. To remove the filter, click in the Start field and press the Backspace key.

10. Do the same for the End field.

Resource Utilization
You can also use the Cash Flow graph to report on resource utilization. For example, you may want to
run a report that displays a work hours curve for a particular labor trade or to see the peak usage times
for a particular piece of heavy equipment.

You can run resource utilization graphs based off of any of the following:
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l Resource Type

l Resource Code

l Description

l Organizational Category

l Tag 1, 2, and 3

l Quote Group

l Account Code and Cost Item Account Code

l Fuel Type

You set up your resource utilization settings from the same Display Settings window you use for set-
ting up Cash Flow, Display Settings in the Tools section of the Actions menu.

Resource Utilization Display Set Up

The following steps walk you through setting up your Cash Flow graph to report on Resource Util-
ization.

Step by Step — Resource Utilization Display Setup

1. In the E101 – Training Job, from the Estimate tab, select CashFlow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. Make sure the all checkboxes are unchecked under the Cost Items and Cost Categories sections.

4. Under the Resources section, check the Resource Utilization checkbox.

5. From the Summarize resources by drop-down list, select Description.
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6. From the resulting list of Values, select Laborer.

7. Click in the Qty field for the selected value and select a color of your choice.

l In this case the Qty represents the work hours for your Laborer resource

8. Click in the Cost field for the selected value and select a different color of your choice.

9. From the Quantity and Cost drop down lists, you can select how your quantities and costs will
display on the graph. In this case select the Quantity to display as a Bar and Cost to display as a
Line.

10. Click OK to close the Display Settings window.

l The graph now displays the utilization of your Laborer resource, showing the work hours
and costs used over time

The graphs displayed on the Cash Flow form are based on the estimated cost of each cost
item and its resource employments (in the case of resource utilization).
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Cash Flow Options
The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and vendors/sub-
contractors. Cash flow is then calculated based on both the earning and payment terms you specify, and
the job's schedule and pay item prices.

To open the Cash Flow Options, click on the Cash Flow Options icon in the Tools section of the
Actions tab.

You can also access Cash Flow Options from the Setup > Job Properties > Cash Flow tab.

1. Revenue timing:  Revenue is the amount of money actually paid to a contractor by the client for
the completion of project deliverables. This section contains options to specify when and how
often payment is recieved.

2. Cost Timing:  Cost is the amount of money expended to complete the scope of the project. This
section contains options to specify when and how often you pay contractors, subcontractors and
vendors.

To include any of your costs in your cash flow (including indirect costs), they need to be sched-
uled

3. Cost of Money:  Represents the financing cost to fund the project. This section contains fields to
specify interest rates you pay for the money you borrow, and interest rates you earn for money
invested, to determine a total Finance Cost.

4. Quantities: Allows you to calculate cash flow based on pay quantities or forecast (T/O) quant-
ities.

5. Dates: By default, the scheduled Early Start and Early Finish dates of each cost item (and its
resource employments) as listed in the CBS Register, provide the timing of the expenses, rev-
enue, and costs that show up on the Cash Flow graph. You have the option to base cash flow tim-
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ing on Start/Finish dates or Late Start/Finish dates.

Cash Flow Options Set Up

The following steps walk you defining settings on the Cash Flow Options form.

Step by Step — Cash Flow Options Setup

1. In the E101 – Training Job, from the Estimate tab, select Setup >Job Properties >Cash Flow.

l You will see the default options already there

l You will adjust a few of those options

2. Change your Revenue timing to Every month on the 10th.

l The average calendar days from billing to collection should be set to 25 days

3. For Cost timing, bills are received from subcontractors and vendors Every month on the 25th.

l Average calendar days elapsed from receipt of invoice to payment should be set to 30 days
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4. For Cost of money, enter 10% for the Average annual interest rate paid to borrow money (when
cost exceeds revenue) and 2% for Average annual interest rate earned (when revenue exceeds
cost).

5. Leave all remaining options as originally defaulted.
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Cash Flow Overview
The Cash Flow form provides a graphical representation of the cash flow and resource utilization of
your project, so you can quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

In order to generate a cash flow curve the estimate must be populated with schedule dates either dir-
ectly from integration with Primavera, Microsoft project, or input manually.

Section Description

1 The graph displays the projected cash flow of your project, along with job financing
expense, individual cost category costs and resource utilization.

l The x-axis measures time

l The left y-axis measures amounts

l The right y-axis measures quantities (when resource utilization is displayed)

l All graphs depicted on the Cash Flow form can be displayed based on Pay Quantity
or Forecast (T/O) Quantity

2 Click on the Display Settings icon to indicate what to display on the graph.

l You can display total costs and price or specific cost categories

l You can also set the display settings to report on Resource Utilization

3 Click on the Cash Flow Options icon to specify revenue timing, cost timing, and cost of
money.

4 Click the Excel icon to export the numerical data represented on the graph into an Excel
spreadsheet where you can run additional analysis.

5 You can filter the Cash Flow graph by date range or by a range of cost items.

6 Click and drag over the graph to zoom in on a particular section. Click the Reset Zoom
button to restore the graph to its original state.

Overview – Cash Flow Form
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Haul Calculator
The Haul Calculator allows you to enter the specifics of up to three haul routes (distance, travel speed,
etc.). Once entered, you can either:

l Calculate the number of trucks required to complete the haul in a set amount of time, or

l Calculate how long it will take to complete the haul with a set number of trucks

The following activity walks step by step through using the Haul Calculator to calculate the number of
trucks needed for a cost item.

Step by Step — Haul Calculator – Calculate Quantity of Trucks

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.
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5. On the Haul Calculator, select the Calculate quantity of ETDT required to complete haul in dur-
ation entered below radio button. (ETDT is the resource code for the Dump Truck you selected.)

6. For the Haul Distance, type 5.

7. Enter an Average Payload (Ton) of 30.

8. For Load Time (Minutes), type 3.

9. Enter a Travel Speed Full of 35 Mile/Hour.

10. For Dump Time (Minutes), type 2.

11. Enter a Travel Speed Empty of 45 Mile/Hour. Notice this calculates a cycle time of 20.24.

12. Enter a Work Efficiency of 90 percent.

l The calculator shows a result of 1.56 concurrent haulers

13. Click OK.

14. Your cost item now shows a quantity of 1.56. Round up the Quantity to 2. Also, adjust the Team-
ster Quantity to 2 (if needed).

Step by Step — Haul Calculator – Calculate Total Duration

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.
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3. On the Cost Item Record, click the Detail tab.

4. Change your Teamster and Dump Truck quantities back to 2 each.

5. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.

6. On the Haul Calculator, select the Calculate total duration of haul using quantity of ETDT
entered below radio button.

l With the previous information you entered still there, the calculator calculates a total dur-
ation of 281.08 hours

7. Click OK.

l The Hours field on the Production tab updated to 281.08

l Your ETDT Dump Truck quantity remains at 2
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Trench Calculator
The Trench Calculator allows you to quickly calculate trench, pipe, and bedding values. You can per-
form pipe-related take-off by defining the details of the trench (e.g., length, depth, width, hinge elev-
ation, backslope, and swell factor), the pipe (diameter, elevation, and waste factor), and up to four
beddings.

With this information, the Trench Calculator can automatically calculate:

l Total excavation volume (neat-line)

l Total excavation volume (including swell/shrinkage)

l Total pipe to purchase

l Lift Volume (for up to four beddings)

l Lift Weight (for up to four beddings)

You can use these calculations to define certain cost item setup data:

l You can use the Total Excavation Volume that is calculated as the quantity of the cost item

l You can use the Total pipe to purchase calculation as the quantity of a resource (e.g., pipe) that
has been employed to the cost item

l You can use the Lift Volume or Lift Weight that is calculated as the quantity of a resource
employed to the cost item in either cubic yards or tons

l You can click the Toggle English / Metric button at the bottom of the dialog to switch between
the English and Metric systems for entering data

You can access the Trench Calculator from the Actions tab of a Cost Item Record

When copying cost items in a job or from job to job, the Trench Calculator variable data is included
with the data being copied. When a cost item is copied to the clipboard, Trench Calculator variable data
is also included.

Trench Calculator – Trench Tab
The following steps walk through using the Trench Calculator to take-off excavation volume.

Step by Step — Trench Calculator – Trench

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Create a new cost item from the bottom row of your CBS and call it 24” Pipe.

3. Add the following three subordinates and update their Units of Measure:
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l Excavate Trench: CY

l Install Pipe: LF

l Backfill Trench: CY

4. Open the Excavate Trench Cost Item Record. Add the following resources:

l LL2  Laborer – 1

l LO2  Operator Class 2 – 1

l EX245  Excavator 245 – 1

5. Adjust the Production to: 100 CY/Hour.

6. On the Cost Item Record’s Actions tab, select Trench Calculator.

7. For Trench Length, type 1000.00 feet.

8. For Trench Width (at the bottom) type 4.00 feet.

9. Enter a Trench Depth of 10.00 feet.

10. Enter a Hinge Elevation of 5.00 feet.

11. Enter a Backslope of 45 degrees.

Page 276 of 516 InEight Inc.  |  Release 20.2

Trench Calculator – Trench Tab Estimate Help Topics



12. Define the Material Swell/Shrinkage Factor (fraction expressed as a decimal) at .10.

l You can select either a “neat-line” total volume or include swell/shrinkage

13. Select the “Total excavated volume (including swell/shrinkage)” checkbox.

14. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

15. Click OK.

Trench Calculator – Pipe Tab
You can also use the Trench Calculator to take off how much piping and bedding you need for the
trench.

Step by Step — Trench Calculator – Pipe

1. On the CBS Register, adjust the Forecast T/O Quantity for the Install Pipe cost item to 1000 LF.

l Assume this quantity is based off manual take-off calculations you already did

2. Open the Install Pipe Cost Item Record.

3. Add the Resource Assembly of CPIPE - Pipe Crew and adjust the production to 300 LF / Day.

4. On the Cost Item Record’s Actions tab, select Trench Calculator.

5. Select Load Configuration from Library.

6. Select Trench Example (with your initials).

7. Click OK.
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8. On the Trench Calculator, select the Pipe tab.

9. Enter the following for the size and position of the pipe:

l Pipe exterior diameter:  26.00 inches

l Pipe center elevation (from bottom):  19.00 inches

l Waste factor: 10%

10. Click on the resource icon to pull up the Resource Rate Register.

11. Select the Installed Material tab.

12. Select MPP24 Pipe 24” PVC SDR35, then click OK.

l The Pipe variables you entered should match the following image:

13. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

14. When prompted to overwrite the existing saved file, click Yes.

15. Click OK to close the Trench Calculator.

Trench Calculator – Beddings Tab
The following steps walk you using the Trench Calculator to calculate bedding take-offs.

Step by Step — Trench Calculator – Beddings

1. Back on the CBS Register, adjust the Forecast T/O Quantity for Backfill Trench to 2300 CY,
based on manual calculations.

2. Open the Backfill Trench Cost Item Record.

3. Add the following resources:
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l LL2 Laborer – 3

l LO2 Operator Class 2 – 1

l RPC Plate Compactor – 1 

l EL950 Loader 950 – 1

4. Adjust the Production to 160 CY/Day.

5. From the Cost Item Record’s Actions tab, select Trench Calculator.

6. Select Load Configuration from Library

7. Select Trench Example (with your initials), then click OK.

8. On the Trench Calculator, select the Beddings tab.

9. On the Beddings tab, you can define up to four beddings to backfill the trench

l The variables you enter will determine how much bedding you need

10. Enter the following variables for each bedding:

Bedding Lift 1 Bedding Lift 2 Bedding Lift 3

Elevation (from trench floor) 6.00 38.00 76.00

Additional material needed 5.00 5.00 5.00

Conversion factor 1.60 1.70 1.60

l Under Results, you can match each of the Bedding Lifts with a material resource, by select-
ing the resource icon and selecting the resource you want to employ from the Material tab

11. Selecting the resource from the Tons selection field, select the following materials for each bed-
ding:

Resource Code Resource Description

Bedding Lift 1 MASAND Sand

Bedding Lift 2 MAFA Fine Aggregate

Bedding Lift 3 MACA1-1/2 Coarse Aggregate
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12. Click OK.

l Note that the pipe and bedding materials are added to the cost item with their quantities
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In-Field Calculator
You can use the In-field Calculator to do simple mathematical calculations in any numeric field on
records, registers, and tree lists. You use this calculator much like an Excel workbook field, by insert-
ing the cursor in the field where you want to perform a calculation, then pressing the "=" key, followed
by a valid arithmetic expression. To display the calculated result, you press the tab key. The resulting
value is stored without the arithmetic expression used to calculate the value.

The following steps walk through using the In-field Calculator to calculate the area of how much sand-
blasting is needed for painting the steel bridge structure specified in the Training Job.

The resulting field value is stored without the arithmetic expression used to calculate the value.

Step by Step — In-Field Calculator

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Scroll to find cost item 13.3 Sandblast.

3. Click in the Forecast (T/O) Quantity field.

4. Press the = key, then type 10*250.

5. Press the Tab key and it calculates the result.

InEight Inc.  |  Release 20.2 Page 281 of 516

Estimate Help Topics Trench Calculator – Beddings Tab



Cost Item Assembly Overview
Overview
Cost Item Assemblies utilize predictive models to quickly and accurately estimate elements of a job
that can be repetitive in nature on a single job or from job to job. They use parameter driven estimating
to create cost items. They use created parameters and mathematical calculations to incorporate quantity
takeoffs and estimate quantification into cost items. A cost item assembly will output fully populated
cost items directly into the project CBS. The inputs are dimension values and specification sections,
while the output is cost items.

Cost Item Assemblies accomplish the following:

l Model a construction system or component that is quick and easy to employ

l Promote a consistent process of estimating among various users

l Enable less experienced users to more efficiently create an estimate

l Provide good visibility into the assumptions and calculations made to obtain the results

l Provide the flexibility to easily adjust model assumptions and account for varying project require-
ments from estimate to estimate

All the following can be done with Cost Item Assemblies:

l Assembly employments can be re-opened to modify inputs

l Assemblies can be stored in the Library and imported like resources

l Assemblies can be copied and pasted between projects

l Assemblies can be created from existing project cost items

l Assemblies can be modified for project specific needs

l Assemblies can be modified and employments updated in the project

l Employed assemblies can become permanent cost items by deleting the link

l Assemblies can be created for either metrical or imperial units

Users
There are typically two types of users that work with Cost Item Assemblies:

l The power user, someone like the lead estimator, creates the cost item assemblies

l The end user uses the created assemblies
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User Function

Power User This user can determine what questions need to be answered to create
a standard construction system, and how specifically to use those
answers in determining the systems quantities, cost and resources to
be applied in the estimate.

Many companies have spreadsheets that they have created for estim-
ators in the organization to use in estimating specific types of work. If
you are the person that often creates or enhances those spreadsheets,
you probably fall into the category of being a user that will create
Cost Item Assemblies.

End User This is sometimes a less experienced estimator that will benefit from
being provided a set of questions to answer because it can help the
estimator develop an understanding for the way the work is estimated
and provide them with guidance in gathering the right information.

The use of Cost Item Assemblies is not exclusive to less experienced
estimators, however. They can be used by anyone involved in the
estimating process that wants to quickly create an estimate for a
scope of work in a consistent and repeatable way. Cost Item Assem-
blies can be a great way to initialize an estimate and give the estim-
ator more time to focus on analyzing the job and considering
different ways of approaching the work.

User Types

Navigation / Data Blocks
The use of data blocks in the Cost Item Assembly Register allows you to set up a layout that works
best for you.

The data blocks in the Cost Item Assembly Record are:

l Cost Items

l Inputs

l Calculations

l Notes

l Setup

l Tables

l Sub Assemblies
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The Default Data Block view looks like the following:

Move Data Blocks
To move Calculations onto the screen, simply click on the name and drag it until the following options
appear:

Next, choose where to place it on your screen:

The calculations data block now appears on the screen.
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Add and Remove Data Blocks
To look at Setup and Tables, click on the tabs to view them.

To get rid of the Notes screen, simply press the X, and to bring it back, click on Default Data Blocks in
the ribbon.

InEight Inc.  |  Release 20.2 Page 285 of 516

Estimate Help Topics Add and Remove Data Blocks



Cost Item Assembly Creation
Create a Cost Item Assembly Record
Cost Item Assemblies allow you to create intelligent construction systems to automatically estimate
various scopes of work, based upon a user providing specification and dimension variables. You can
create multiple Cost Item Assemblies and maintain a library of construction systems that are used
throughout the estimating department. When creating an assembly, it’s helpful to have a solid under-
standing of the various inputs that will be used and how those inputs will be used to influence the res-
ulting collection of cost items.

Cost Item Assemblies are created by entering a code and description for the assembly. Both fields can
be changed at any time.

Scenario

One scope of work that is part of the estimate is a ductbank. This ductbank work entails excavating, lay-
ing the conduit, and then either backfilling it with concrete or soil depending on the location, and all
conduit runs consist of two conduits. You want to estimate the cost and hours for this work using a cost
item assembly.

Step by Step — Create a Cost Item Assembly Record

1. From the Setup tab, click on Cost Item Assemblies.

2. From the Actions tab, click on New.

3. In the Code field, type TEST – Your Initials.

4. In the Description field, type Test Cost Item Assembly - Ductbank.

5. In the bottom right corner, click OK.
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l Notice that your Cost Item Assembly now shows up in the Cost Item Assembly Register

Workflow
There is a standard workflow for building cost item assemblies .

1. Define the desired output from an assembly (cost items).

2. Decide what questions the estimator will be required to answer (and what assumptions you want
to set).

3. Create input tables for user selections.

4. Create expressions to provide the required results to populate the cost items.

Build Cost Item Assembly Record
Once your Cost Item Assembly has been created, it is time to build the assembly. To begin, you first
fill out the setup information, then you use the remaining data blocks to build the assembly record.

The fields in the Setup tab can be filled with unique names, choice of pull-downs or left blank. The
fields on the Setup tab include:

l Assembly file

l Geographic Areas

l Wage Zone

l Org. Category

l Last Changed By is updated when the definition of the assembly is modified, such as the inputs,
calculations, cost items, tables, notes, etc.

l Last Changed On is updated when the definition of the assembly is modified, such as the inputs,
calculations, cost items, tables, notes, etc.

l The Tag and User Defined field can be filled in by the user

The first four fields are used the same way resource attributes are used to filter which resources are
imported from the master library into a project. These will appear on the cost basis tab of job properties
as filters to determine which cost item assemblies you import into a new estimate.
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Step by Step — Cost Item Assembly Set Up

1. Select your assembly from the list and click Open from the ribbon.

2. In the bottom right corner, click on the Setup tab.

3. In the Assembly File drop-down, select Standard Cost Item Assembly File.

4. Select a Geographic Area and Org. Category.

5. In the Tag 1 drop-down, select Concrete.
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6. In the Tag 2 drop-down, click the Add icon.

7. Enter the following, then click OK.

Cost Items
The Cost Items data block is used to create cost item breakdown structure, where you can assign the
default values and resource employments and link the results of the calculated values to the appropriate
cost item and resource employment fields. This is where you build a framework of cost items that you
want as output from this assembly.

Cost Items for a Cost Item Assembly are created within the Cost Item Assembly Record, not in the
CBS Register.

There will be at least one cost item with the following default values which you can override.

l Default Description is equal to the Assembly Description

l Default Forecast (T/O) Qty = 1

l This is the top-level cost item in the assembly. Any additional cost items will need to be created
as subordinates to this cost item

After you complete the values in the Cost Items data block, the steps included in the Calculations
data block need to be completed prior to linking any values to the cost items.

This data block has the same functionality as the CBS register; double-clicking one of the cost
items or selecting one of the cost items and choosing Open from the menu will open the Cost
Item Record. To quickly perform this work, you can easily copy cost items from the CBS
Register and paste them into the Cost Items data block of the Cost Item Assembly Record.
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Step by Step — Create Cost Items in an Assembly

1. Click X on the pop up.

2. From the Cost Items data block, right click on your cost item and select Insert Subordinate.

3. Insert 4 subordinates.

4. Enter the descriptions and units of measure as follows:

Inputs and Tables
The Inputs data block is where you define the questions that will be asked of the user when they
employ a Cost Item Assembly. Inputs can be value, table, text or object type inputs and validation rules
can be specified for value-type inputs such as minimum or maximum values that are acceptable, or
default values that appear when the Cost Item Assembly is employed. These Inputs will be the para-
meters used in calculations to drive the Cost Item Assembly outputs.
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Tables

Tables are used for reference data and can provide functionality similar to a lookup field in excel.
Tables may contain account codes, production rates, or other reference fields and can be imported from
the Library or copied from one assembly to another. Tables can be assembly specific, project level
(Standard), or Enterprise (Library) level (Master Standard). You can populate tables from a project spe-
cification list.

Value

The Value field shows the Cost Item Assembly employment dialog input fields with a prefilled value
so you don't have to specifically provide or select a value. The Data Validation field determines what
type of data validation is enforced when the Cost Item Assembly is employed. This field is enabled
only when the Input Type is Value. The selections are shown in the Using the Formula Editor step by
step in the Inputs and Calculations Topic:

Text

If you are using the same cost item assembly multiple times, the text Input Type can be used with a dis-
tinct description to distinguish each of the cost item assemblies in the CBS.
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In the CBS Cost Item Assembly Input, you can modify the input value with a descriptive specific to
this one entry, in addition to changing other input values. For example, you can change the Standard
Retaining Wall Assembly cost item and name it to Section A.

Using the cost item assembly text input values lets you manually enter in a text value to be used in the
cost item assembly formula. By not using text input values, if you want multiple sections of a Standard
Retaining Wall Assembly, it would be difficult to distinguish between the various instances of the
retaining wall assemblies in the CBS.

Object

The object input type lets you choose an object that already exists in Estimate, such as existing tags,
resources, or account codes. The object list changes dynamically based on data that exists in the current
estimate without requiring a manual update to the Cost Item Assembly table data, so users can choose
from valid selections.
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As an example, if you were to employ a pipe installation CIA in the CBS, a Type of Pipe input may be
required, and by using an Object type input variable, the assembly can show a Resource Selection
Register, requiring you to select from a list of resources that currently exist in the job.

Picking an Object that exists in the job helps ensure the formulas that use those objects return valid res-
ults, such as linking a formula result to the resource employment for the MPDIP10 Pipe 8” Ductile Iron
resource as picked from the Resource Rate register.
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Additionally, selection registers often permit new objects to be added on the fly, so if a resource or tag
value is missing from the job, it can easily be added while employing the Cost Item Assembly.

Using Object Type Inputs

Object Type inputs can be used in formulas by directly referencing either the Code or the Description
as attributes of the input variable. These two fields can be easily referenced and selected using the For-
mula Editor.
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ObjectValue Function

The ObjectValue function accepts an object type, the key code field and the desired name of the field to
be looked up and will return the value of the lookup field for use in a formula.

In the following example, The ObjectValue function looks up the value stored in the User Defined 1
field of the resource whose resource code is stored in the FTGCODE_11 variable. In this case, the
return value represents the material resources unit weight and is used to calculate the total weight of the
material being installed.

Step by Step — Create Input Values

1. Navigate to the Inputs data block. In the first empty field under Variable Name, type in the name
of a variable that will be referenced in the formula expressions, such asLength, then press Tab.

The Variable Name is a free text field and is determined based on how the calculations are ref-
erenced in the input values.

l The Display Order field can be set to control the order in which you are prompted to
provide the input values

2. Select the Description field and type Ductbank Length (ft), then press Tab.
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3. In the Input Type field, select Value from the drop-down list. In the Default Value field, type
100.

4. Fill out additional fields as shown below:

Data Validation

The Data Validation field determines what type of data validation is enforced when the Cost Item
Assembly is employed. This field is enabled only when the Input Type is Value. The data validation
options are as follows:

Selection Description

None No validation is enforced, and any numeric value is permissible.

Equal Permits the entry of a value that is equal to the value entered in the Value/Minimum
field.

Not Equal Permits the entry of a value that is not equal to the value entered in the Value/Minimum
field.

Greater
Than

Permits the entry of a value that is greater than the value entered in the Value/Minimum
field.

Greater Permits the entry of a value that is equal to or greater than the value entered in the
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Selection Description

Than or
Equal

Value/Minimum field.

Less Than Permits the entry of a value that is less than the value entered in the Value/Minimum
field.

Less Than
or Equal

Permits the entry of a value that is less than or equal to the value entered in the
Value/Minimum field.

Between Permits the entry of a value that falls between the range of numbers defined by the val-
ues entered in the Value/Minimum field and the Maximum field.

Not
Between

Permits the entry of a value that does not fall between the range of numbers defined by
the values entered in the Value/Minimum field and the Maximum field.

Step by Step — Create Input Values from a Table

1. In the bottom right corner of the Cost Item Assembly Record, click on Tables.

2. Right click in the Table Code field and select New.

3. In the Code field, type CONC – Your Initials, and in the Description field, type Concrete Types.

4. In the Columns section, enter in the following column names and descriptions, choosing the Text
Type.

5. Click OK in the bottom right corner.
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6. In the Tables section, enter in the following data for the Concrete resource codes and types:

7. Click OK in the bottom right corner.

8. Add the following input, selecting Table for the Input Value from the drop-down.

9. From the Table drop-down list, select your CONC table.

Standard Tables

In the Setup tab, you can create standard tables for the project. These are created exactly like tables
within the Cost Item Assembly Record. All users in the project have access to the standard tables.
These tables can be copied and pasted into the Cost Item Assemblies’ tables. You can create, edit, or
delete standard tables from the Standard Table Register. You can copy Standard tables from the library,
to the library, and from another job.

Conditional Inputs
Conditional input expressions can include variables that reference other input values or ask simple
Yes/No questions. This allows the user to provide answers to inputs, which are then used to determine
if the user is asked to provide more answers for additional inputs. The variable Default Value is used in
the conditional input expression, so the input is always hidden when the Cost Item Assembly is initially
employed. Therefore, the Default Visibility checkbox is not selected, and when you create an estimate

Page 298 of 516 InEight Inc.  |  Release 20.2

Conditional Inputs Estimate Help Topics



and employ the Cost Item Assembly in the Cost Item Assembly Inputs view, the conditional input is
hidden.

You can then provide information and enter a dimension or a response to a question. Note that:

l If the value entered changes the expression result to True, the conditional input shows

l If you want to see all the inputs in a Cost Item Assembly even if their conditions are not cur-
rently evaluating to True, you can click View in Cost Item Assembly Inputs, and then select
Show Hidden Inputs. This will display all the conditional inputs for the Cost Item Assembly

l To make it easier for users to select data from tables, you can hide unnecessary table columns in
the Table Row Selection Register

l In both Cost Item Assembly Register and Standard Tables Register, go to the Columns data block
and clear the Default Visibility checkbox to hide columns in the table

More user tags and user defined fields are available on the Cost Item Assembly > Inputs data block
related to a group of variables or with other similarities. A Standard View also exists, so you can define
saved views to make use of the additional tags and fields.

Step by Step — Set Conditional Inputs

1. Create a new input as follows, choosing Table as the Input Type, and selecting Standard Table
from the drop-down.

2. Set the Default Value of the CONC variable as No, then click OK.

3. In the Visibility Condition field for the CONC TYPE variable, click the fx button.
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4. In the Formula Editor, and from the Fields section, double click [CONC.CODE].

5. In the Operators field, double click on the ‘==’

6. In the Formula Editor, type ‘Yes’.

7. Click OK.

l Notice that the Default Visibility field for CONC TYPE becomes unchecked

l This means that only when the answer to Is Concrete required is Yes, the CONC TYPE
input will become visible; otherwise, it will stay hidden
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8. In the Tag 1 fields for CONC TYPE and CONC, select Concrete.

9. In the Find field under Inputs, select Tag 1.

10. Begin typing in Concrete and notice that the CONC TYPE row becomes highlighted.

Calculations
Calculations are values produced from expressions that utilize hard values, input values, and lookup val-
ues. They can be numerical, Boolean, and/or character expressions. These calculations will provide the
method to produce values to use with the cost item output of the assembly. Variable names can contain
these special characters:

l A-Z

l 0-9
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l _

l ? (Null)

Formulas

The Formula field enables you to create your own custom expressions. You can take assembly inputs
and calculate results. Calculation results may be used in other calculations or linked to an assembly’s
cost item register field values. Formulas can be created with numbers, math operators (e.g., + or – for
addition or subtraction), input variable values or other calculation results, table lookup values, or any
number of functions that are built into the Formula Editor.

The following formula shows an example of how to calculate the cubic foot volume of concrete in a
10’ wide by 15’ long by 6” thick slab on grade. The resulting answer is 75 cubic feet.

To calculate the same volume in cubic yards (there are 27 cubic feet in a cubic yard), the formula can
be rewritten as follows. The resulting answer is 2.78 cubic yards.

Variables

Variables are placeholders for values that can be changed based upon user input or calculation results,
and they can be used to simplify a complex formula. Variables require a name that is unique within the
Cost Item Assembly, and the syntax for referencing a variable in a formula is to enclose the entire vari-
able name in [brackets]. Using the preceding example, a calculation named [VOL_CUFT] determines
the cubic foot volume of 75. The second formula then references the value stored in the variable
[VOL_CUFT] and divides it by 27 to calculate the cubic yard volume of 2.78.

Input variables are also used to store user inputs as described above. In the following example, three
inputs are created in the Inputs section of the Cost Item Assembly and employing this Cost Item

Page 302 of 516 InEight Inc.  |  Release 20.2

Calculations Estimate Help Topics



Assembly will prompt the user to provide the values for the width, length and thickness of the concrete
slab, those values are stored in the variables named [WIDTH], [LENGTH] and [THICK] respectively.

The [VOL_CUFT] calculation in the following example is the same as in the preceding example, but
replaces the 10 foot, 15 foot, and 6 inch values with the variable names, which you would provide
when the Cost Item Assembly is employed.

As in the preceding example, the [VOL_CY] calculation takes the result of the [VOL_CUFT] cal-
culation and divides by 27 to convert the volume from cubic feet to cubic yards.

Functions

Functions can be used to expand the power of a formula by performing special types of operations on
the formula’s values. Functions are most commonly used by the name of the function, followed by the
values that the function will use to perform the special calculations.

As an example, the Ceiling() function can be used to take the result of a calculation and round it up to
the nearest whole number. In using the concrete slab example from above, the calculation [VOL_BUY]
will take the result of the [VOL_CY] calculation and round it up from 2.78 CY to 3.00 CY using the
syntax Ceiling([VOL_CY]), which represents the amount of concrete you would want to purchase for
this work.

Null Value

Creating valid formulas can be challenging when calculations start to become more complex. Improper
referencing of variables, incorrect spelling of functions, or invalid mathematical operations are all
examples of ways in which a formula expression can be invalid. When a formula results in an invalid
expression it will return a NULL value. A NULL value is displayed using a ‘?’ character and will pre-
clude you from employing the Cost Item Assembly in the job. In the following example, a formula that
divides any number by zero generates a mathematically invalid result and is indicated by the ‘?’ char-
acter.

Formula Editor

The Formula Editor is a tool you can use to assist in the creation of validated formulas that correctly ref-
erence variables and ensure the use of proper syntax. Select the fx button to open the Formula Editor.
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Element Description

1 Expression
Box

Type your formula expression here or add expression elements by double click-
ing items in the Expression Values section as described below.

2 Expression
Elements

Click on an element type to view its categories in the Expression Values list
(3).

3 Expression
Values

Double-click a value to add it to the Expression Box.

l If Functions is the selected Expression Element, a drop-down list of vari-
ous categories of functions will be displayed so the list can be filtered
making it easier to find the desired function.

4 Information
and Help

When an expression is selected from the Expression Values list (3), an explan-
ation of that expression and how it is used will appear in this window.

l If Fields is the selected Expression Element (2), the Expression Values
section will list all the available variables used in the Cost Item
Assembly, as well as displaying the variable type and the Description
as provided by the user in the Description Field of the indicated Input
or Calculation variable

l If Constants is the selected Expression Element (2), then choosing any
of the values in the Expression Values section will provide a brief
explanation of the constant

l If Operators is the selected Expression Element (2), then choosing a
mathematical operator in the Expression Values section will display a
brief description of what the operator does

l If Functions is the selected Expression Element (2), choosing a Func-
tion in the Expression Values section will display the selected functions
syntax as well as a brief description of how the function is intended to
work

Overview - Formula Editor
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Within the Formula Editor, you can use tables to provide reference data for use in calculations. For
example, the following illustration shows a table that stores values for various Concrete Strengths along
with their associated resource code values.

Step by Step — Create Calculations

1. Drag the Calculations data block into view.

2. In the Variable name field, type Volume, then press Tab.

The Variable Name field in the Calculations section will be the name that other Calculations can
refer or link to and this name must be unique within the context of the Cost Item Assembly, and
unique with respect to input variable names.

3. Enter the Description Ductbank Volume, then press Tab.

4. In the Formula field, select the fx formula editor button.
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5. Select the Field values and Operators as indicated below to create the displayed formula, then
click OK.

l Notice that the Default Result auto calculates using the calculation and input values
provided

6. In the blank row under the Variable Name field, type Conduit and enter the Description Conduit
Length, then click the fx button to open the formula editor.

7. Select the Fields value and Operators as indicated below to create the displayed formula, then
click OK.

8. In the blank row under the Variable Name field, type Volume2 and enter the Description Conduit
Volume, then click on the fx button to open the formula editor.

9. Enter the following formula, using the PI() function from the Functions > Math tab, the radius
and length from the Fields tab, and the available Operators tab, then click OK.
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10. In the blank row under the Variable Name field, type Volume3 and enter the Description Back-
fill/Concrete volume, then click on the fx button to open the formula editor.

11. Enter the following formula, selecting the already created calculations from the Fields section.
Click OK.

12. In the blank row under the Variable Name field, type Concrete and enter the Description Con-
crete type, then click on the fx button to open the formula editor.

13. Enter the following formula, selecting the table value from the Fields tab, then click OK.
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l A default result will not appear because a value from the table has not yet been chosen.

Notes
Notes can be utilized to provide guidance to you on how to use the Cost Item Assembly or provide fur-
ther clarification on what the various inputs are requiring or how the calculations are being performed.
This field supports rich text editing, meaning users can copy and paste from an editing tool various
graphics or formatted text such as bold text, bulleted or numbered text, hyperlinks to websites, or vari-
ous fonts. The Notes data block is displayed on the right side of the Cost Item Assembly Record
screen.

Step by Step — Add to the Note Section

1. Click on the Notes tab in the bottom right corner.

2. In the Notes text box, type Ductbank Notes.

3. Right click within the notes section and select Hyperlink.

4. Type in a link to your SharePoint or document sharing site, then click OK.
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l Note how the hyperlink appears in the notes section.

5. Still in Notes, copy a picture or drawing from your computer, then Paste it into the notes section.

Linking Calculations to Cost Items
The results of calculations can be assigned to any number of different fields in the Cost Items data
block of the Cost Item Assembly record. It is common to link dimensional calculations to the Forecast
(T/O) Quantity fields of various cost items, but calculation results can be linked to many other fields
such as Productivity fields, Description fields, and even Resource Employment fields such as Quantity
or Code. You can link multiple cost item fields to a single calculation by holding the CTRL key. To
link a calculation to a cost item, you right click on the cost item field and then either select to link to
the calculation result from the context menu or from the ribbon.

Step by Step — Link Calculations to Cost Items

1. Expand your Cost Items window so that you can see all the cost items.

2. Right click on the Excavate Ductbank Forecast (T/O) Quantity field and select Link this field to
Calculation Result.
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You create calculations prior to linking the values field. The linking of calculation results is sim-
ilar to linking to Excel values except all linked values update automatically.

3. Select VOLUME, then click OK.

l Note how the Forecast (T/O) Quantity field is now populated with a linked quantity

4. Right click on the Install Ductbank Conduit Forecast (T/O) Quantity field and select Link this
field to Calculation Result.

5. Select CONDUIT, then click OK.

Page 310 of 516 InEight Inc.  |  Release 20.2

Linking Calculations to Cost Items Estimate Help Topics



6. Select the Forecast (T/O) Quantity field for Pour Concrete, hold down CTRL, and select the Fore-
cast (T/O) Quantity field for Backfill.

7. Right click and select Link this field to Calculation Result.

8. Select VOLUME3, then click OK.

9. In the Inputs data block, select the Default Value field for the CONC TYPE input.

10. Select MC2000, then click OK.

l Notice that this value is now populated in the Default Value field.

11. Navigate to the Calculations data block.

l Note that the Default Result field is now populated
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12. In the Cost Items data block, right click in the Optional Code field for the Pour Concrete cost
item, and select Link to Calculation Result

13. Select the CONCRETE calculation, then click OK.

l Note how the optional code for Pour Concrete is now populated
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Cost Item Assembly Employment
When an estimator wants to estimate a scope of work, they can use any available Cost Item Assemblies
that have been included in the job. Cost Item Assemblies are employed in the CBS Register in much
the same way a resource is employed on a cost item. Cost Item Assemblies can be imported into a pro-
ject from the Library via the Setup > Job Properties > Cost Basis tab in the same way that resources
can be brought in.

Employment
Employing cost item assemblies comes after they have been created by a lead estimator typically.
Employing an assembly means an estimator selects a specific assembly to insert into the CBS register
as if adding a new cost item. The estimator will be prompted to provide all the inputs or accept the
default assumptions required for that assembly.

Job Properties
Cost Item Assemblies can effectively be used as a starting point for various components of an estimate.
You can import job specific cost item assemblies by navigating to the Setup menu and selecting Setup
> Job Properties > Cost Basis > Cost Item Assembly.

You can also import cost item assemblies into the Library the same way as doing it from within a job.
You can access the Master Cost Item Assembly Register by navigating to the Library > Cost Item
Assembly Register.
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Insert Cost Item Assemblies
Once your Cost Item Assemblies are created, the cost items must be inserted into the CBS Register.
They can be inserted as a subordinate or new cost item anywhere in the CBS hierarchy. To do so, you
right click on the position code where you want to place the cost item assembly and select to either
insert the assembly as subordinate cost items or as new cost items.

Once the cost items are inserted into the CBS, you can hover over Forecast (T/O) Quantity to see the
associated calculation.

Step by Step — Insert Cost Item Assemblies

1. Navigate to the CBS Register.

2. Right click on the first cost item in the hierarchy and select Insert Cost Item Assembly as Subor-
dinate.
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3. Select your Cost Item Assembly, then click OK.

4. Click OK again.

l Your Cost Item Assembly is added to the bottom of the CBS

Edit an Employed Cost Item Assembly
Employed Cost Item Assemblies are read-only cost items in the CBS register, but the inputs that were
provided by the user to create the cost items can be modified to update the resulting cost items. If you
change one variable in the cost item assembly, it will automatically update all associated cost items.

You can update the values of an Employed Cost Item Assembly in two ways:
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l From the CBS Register

l From the Cost Item Assembly Register

From the CBS Register
You can edit the entire Cost Item Assembly from within the CBS Register.

Step by Step — Edit an Employed Cost Item Assembly from the CBS Register

1. Right click on your Excavate Ductbank cost item and select Edit Cost Item Assembly Inputs.

2. Maximize your screen.

3. Change the Length input value to 120.

4. Click OK.

l Notice how all the quantities for the cost items using the input Length change

From the Cost Item Assembly Register
You can navigate back to the Cost Item Assembly Register, select your Cost Item Record, and make
any changes there. Once the Cost Item Assemblies have been employed, to update the cost items with
any changes made in the Cost Item Assembly Register, you need to go back to the CBS Register to
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update the cost items. You follow the same steps as above except you do not actually change anything
in the edit window, you just click OK to see the updated changes.

Advanced Options
The following step by step demonstrates some advanced options within Cost Item Assemblies, such as
conditional inputs and functions.

Step by Step — Advanced Options

1. Navigate to your Cost Item Assembly Record.

2. In the Calculations data block, click on the formula editor for the “Volume” calculation.

3. Using the Functions tab, select the Round function and put your existing formula within its par-
enthesis, then click OK.

l You now see a rounded number in the Default Result field

4. You now see a rounded number in the Default Result field

5. Do the same for the Volume2 and Volume3 calculations.
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6. Create a new calculation. In the Variable Name field, type Include_Conc, enter Include Con-
crete? in the Description field, then click on the fx button to open the formula editor.

7. Using the Iif(, , )function from the Functions tab, and the existing Volume3 calculations from the
Fields tab, enter in the following formula, then click OK.

8. Navigate to the CBS Register.

9. Right click on one of your cost assembly items, and select Edit Cost Item Assembly Inputs.

10. On the CONC input, select the ellipses next to the Default Value.

11. Select Yes.
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12. Click OK.

l Note how the conditional input CONC TYPE is now displayed

13. Click OK.

14. Navigate back to your Cost Item Assembly Record.

15. In the Cost Items data block, right click on the Pour Concrete Forecast (T/O) Quantity field.

16. From the ribbon, click the Unlink from Calculation Result option.

17. Now click Link to Calculation result.

18. Select the INCLUDE_CONC calculation, then click OK.
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19. Right click on the Pour Concrete Optional Code field.

20. From the ribbon, click the Unlink from Calculation Result option.

21. Navigate to the CBS Register.

22. Right click on one of your cost assembly items, and select Edit Cost Item Assembly Inputs.

23. Click OK.

24. Right click on one of your cost assembly items, and select Edit Cost Item Assembly Inputs.

25. Change the default value of CONC to No.

26. Click OK.

27. Click OK again.
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l Notice that your Pour Concrete cost item now disappears

Breaking the Link to a Cost Item Assembly
To ensure that the logic used in the calculation of a Cost Item Assembly is retained, employed Cost
Item Assemblies are not directly editable in the CBS Register. To customize the results of an employed
Cost Item Assembly, you can disassociate it from the originating Cost Item Assembly logic as per the
following steps.

Step by Step — Break the Link to a Cost Item Assembly

1. Right click your Excavate Ductbank cost item and select Break Cost Item Assembly Link.

2. On the resulting Attention prompt, click Yes.

3. When prompted about changing the Quantity Driver to Superior CI, click Yes.
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l Note that the hyperlinks disappear, and the link has been broken
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Cost Item Sub-Assemblies
With the Sub-Assemblies in the Cost Item Assemblies form, you can easily create and maintain cost
item assemblies that model construction systems and contain multiple complex calculations. Sub-assem-
blies enable the Cost Item Assemblies feature to be more modular, allowing you to maintain smaller,
simpler versions of cost item assemblies and reuse them in multiple places.

Accessing the Cost Item Assembly Sub Assemblies
A sub-assembly can be created within a cost item assembly by simply inserting it as a subordinate cost
item.

To access a cost item assembly record, select Setup > Cost Item Assemblies. The Cost Assembly
register will open.

Select the cost item you want to open by double clicking or right click and select Open.
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Overview of the cost item assembly sub assembly
Under the Cost Items window you will see the cost item assemblies listed. On the right side of the
screen will be the sub assemblies relating to each cost item.

When you expand the sub assemblies on the right, it lists all the elements which make up that sub
assembly.
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On the Cost Item Assembly Record screen there are three windows. Below are their functions:

Windows Description

1 Cost Items These are the component cost items that will be inserted when the assembly is
employed. Fields on the cost items can be linked to Calculations, which are
driven by the Input values in window 2.

2 Inputs / Cal-
culations

Inputs: These are the inputs the user will specify during employment of the
assembly. These input values drive the Calculations which can be linked to the
cost items in window 1.

Calcutions: This is where Calculations are defined. Calculations can be based
on Input values and other Calculations, and the Calculation results can be
linked to fields on the assembly’s cost items and resource employments.

3 Sub Assem-
blies

Four tabs appear: Notes, Setup, Tables, and Osub Assemblies.

l Notes are displayed when the assembly is employed

l Setup shows file and Tag information

l Tables link to individual Table Records by Table Code

l Sub Assemblies list all the elements which make up that sub assembly
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Selecting the Default Data Blocks icon in the top left of the screen will change the view of the Cost
Item Assembly Record.

The cost item assemblies input values can then be assigned to the sub-assembly input values for you to
answer a question only one time. For example, when providing the total square footage of a wall sys-
tem, the single input can be used by the cost item assembly and its sub-assemblies. Adjusting values in
the questions, will change the preview, as shown below.

From the Cost Item Assembly Record > Sub Assemblies tab, compare how changes affect the Cost
Breakdown Structure (CBS) Register:

Changing these values will…

adjust these totals.
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Sub-assembly input values can be sorted and shown conditionally based upon your inputs. Then you
can employ a cost item assembly which only views the questions that are relevant. For example, a ques-
tion in the cost item assembly could be, "Is insulation required?". If the answer to the question is yes,
then a sub-assembly that defines the cost of installing insulation gets included in the cost item
assembly. If the answer is no, then the sub-assembly is not included.

To view the formulas used to calculate the values of the cost items, in the Cost Breakdown Structure
(CBS) Register hover over the Forecast (T/O) Quantity line items. This will help you to understand
how these values were determined.

When your Input questions require answers as Yes/No, Unit of Measure, etc., select the field’s ellipse
to open the table screen. Here you can select the item(s) which relate to your initial selection. When
OK is selected, the line item will update with the new selection.

Step by Step — Creating a Cost Item Assembly Sub Assembly

1. Navigate to Setup > Cost Item Assemblies.

2. Select a cost item assembly.

l The cost item assembly record will open
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3. With the addition of “Walls” as our example. select a blank line in the Cost Item Assembly and
give it a number and description.

4. Right click on the line item and select Insert Cost Item Assembly as Subordinate.

l The Cost Item Assembly Register sub assembly opens

5. From this screen, select a sub assembly to add and click OK.

l The window for the sub assembly will open with its details

l Complete any changes to the values

6. Click OK.
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The cost item sub assembly has been added:
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Validated Tags
Tags are used to identify or mark records for filtering, sorting and reporting purposes. Think of them as
you would any paper tag that you attach to an object to better identify it or find it when you need it.

Tags can be created and made available to all Tags fields throughout the system or can be created for
specific Tags fields on specific forms. When created for a specific Tags field on a specific form, the list
of available Tags for that field will be limited to those Tags assigned to that field and form. Tags that
have not been assigned to a specific field and form will be available to all Tags fields on all forms.
After data is tagged, it can be filtered, sorted, and grouped using the filtering and grouping features on
the register containing the data.

Validate Field Examples

Examples Description

Area Assign construction area to cost items

Phase Assign construction phase to cost items

Work Type Assign construction work types to cost items

Estimator Assign an estimator’s name to a cost item for
responsibility/tracking

Estimate Scope Cost item tagging for secondary reporting scope
needs

Issues Issues to discuss during estimate reviews

Risk Level Assign risk level to cost items for estimate
reviews

Division/District/Region
Tags

Division/District/Region tags

Review Status Sections of the estimate that have been reviewed

Contract Type Contract types

Bid Review Date Date organization reviewed the bid

Bid Award Date Date the bid was awarded

Bid Place Track how the bid placed against competitors if
not won

Quantity Verification Cost item takeoff validation complete
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Users can take advantage of validated and non-validate tags in every register within estimate. It will be
up to the organization on how they want to best leverage tags in each register.

Register Examples

Master Foundation Setup Data – Validated Tags
A master set of Tags is created and stored in theMaster Foundation Setup Data - Tags tab of the
Library. When you create a new folder, the master set is automatically copied from the Library to the
new folder. If you feel the current job requires new or different Tags to adequately categorize its cost
items and resources, you can change, create, or delete them any time you want.

Step by Step — Validated Register Tags

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Setup tab.

3. Under the section Master Initialization, select the Foundation Setup Data button. The Found-
ation Setup Data Register opens.

4. From the Foundation Setup Data Register, select the Tags tab.
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5. Click in the first blank cell in the Code column. Then enter the code that defines the tag.

6. In the Description field, enter a description for the tag.

7. In the Register field, define the type of item to associate with this tag.

8. In the Field column, define the tag field to associate with this tag.

9. Repeat the previous steps to add additional tags.
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Creating Validate Tags in the Record
The following steps walk you through how to create validated tags within a User Tag Record.

Step by Step — Validated Record Tags

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Setup tab.

3. Under the section Master Initialization, select the Foundation Setup Data button. The Found-
ation Setup Data Register opens.

4. From the Foundation Setup Data Register, select the Tags tab.

5. Select the Actions tab.

6. Under the Edit section, select New. A new User Tag Record opens.
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7. In the Code column, enter the code that defines the tag.

8. In the Description field, enter a description for the tag.

9. In the Register drop down, define the type of item to associate with this tag.

10. In the Field drop down, define the tag field to associate with this tag.

11. When you are finished, click OK to close this record and return to the register.

12. Repeat the previous steps to add additional tags.

Page 334 of 516 InEight Inc.  |  Release 20.2

Creating Validate Tags in the Record Estimate Help Topics



13. To edit pre-existing tags, select the tag you want to edit. Then, in the Actions tab, click Open.
The User Tag Record opens.

Assigning Validate Tags to Cost Items
The following steps walk you through how to assign validated tags to cost items.

Step by Step — Assigning Validate Tags to Cost Items

1. From the Ribbon, select the Estimate tab.

2. Then select Cost Breakdown Structure (CBS).

3. Double-click the row that you want to assign tags. The Cost Item Record for that row opens.

l e.g., Direct Cost Add-On, Indirect Cost Escalation, etc.

4. Select the Cost Item Setup default data block in the lower right portion of the record.

5. Select a tag to add to the Tag 1 field drop down.

6. Select the Cost Item Setup default data block in the lower right portion of the record.
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If the tag that you want to assign does not display in the drop-down list, you have the ability to
add a new tag by clicking on the green plus button that shows to the left of the validation button
and adding the new tag to your job's foundation data
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7. Repeat the previous steps to add additional tags.

Assigning Validated Tags to an Employed Resource
The following steps walk you through how to assign validated tags to an employed resource.

Estimate provides you with the ability to assign specific tags on a resource-by-resource basis for each
employed resource on a cost item.

Tags are master codes and descriptions that are used, generally, for sorting and filtering purposes and
allow you to group like data for reporting and review purposes.

Step by Step — Assigning Validate Tags to Employed Resources

1. From the Ribbon, select the Estimate tab.

2. Then select Cost Breakdown Structure (CBS).

3. Double-click the row that you want to assign tags. The Cost Item Record for that row opens.

l e.g., Direct Cost Add-On, Indirect Cost Escalation, etc.

4. In the Cost Item Record, select the Detail tab.

5. Select a resource row in the Detail tab and then select the Employment Setup default data block
in the lower right portion of the record.

6. Select a tag for the Tag 1 field using the drop down list.
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If the tag that you want to assign does not display in the drop-down list, you have the ability to
add a new tag by clicking on the green plus button that shows to the left of the validation button
and adding the new tag to your job's foundation data.

7. Repeat the previous steps to add additional tags.

Assigning Validated Tags to Pay Items
Tags are master codes and descriptions that are generally used for sorting and filtering purposes, and
they allow you to group like data for reporting and review purposes.

Step by Step — Assigning Validate Tags in Pay Item Register

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. In the register, select the pay item that you want to assign a tag.

4. Find and click into the Tag 1 field. Then select a tag from the drop down list.

If the tag that you want to assign does not display in the drop-down list, you have the ability to
add a new tag by clicking on the green plus button that shows to the left of the validation button
and adding the new tag to your job's foundation data.

5. Repeat the previous steps to add additional tags.

Assign Tags on the Pay Item Record

Step by Step — Assigning Validate Tags in Pay Item Record

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. In the register, select the pay item that you want to assign a tag.

4. On the Actions tab, click Open to open the Pay Item Record.

5. From the Pay Item Record, select the Tags / User Defined Fields tab.

6. Click the Tag 1 field. Then select a tag from the drop down list.

If the tag that you want to assign does not display in the drop-down list, you have the ability to
add a new tag by clicking on the green plus button that shows to the left of the validation button
and adding the new tag to your job's foundation data.
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7. Repeat the previous steps to add additional tags. Once done, click OK.

Assigning Validated Tags to Price % Add-On
Step by Step — Assigning Validated Tags to Price % Add-On

1. From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structure section, select Cost Breakdown Structure (CBS).

3. Double-click on the PRICE % ADD-ON row.

4. Under the Cost Item Setup default data block, click in the Tag 1 field. Then, select an account
code using the drop down list.

If the tag that you want to assign does not display in the drop-down list, you have the ability to
add a new tag by clicking on the green plus button that shows to the left of the validation button
and adding the new tag to your job's foundation data.

5. Repeat the previous steps to add additional tags. Once done, click OK.
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Assigning Validated Tags to a Quote Record
Tags are master codes and descriptions that are generally used for sorting and filtering purposes, and
they allow you to group like data for reporting and review purposes.

Step by Step — Assigning Validated Tags to Quote Record

1. From the Ribbon, select the Quote tab.

2. Under the Quote Management section, select Quotes.

3. Open the preferred Request for Quote Record by highlighting it on the Quote Register.

4. Then select the Actions tab. Under the Edit section, select Open. The Quote Record opens.

5. Under the Setup default data block, click in the Tag 1 field. Then, select a tag using the drop
down list.

If the tag that you want to assign does not display in the drop-down list, you have the ability to
add a new tag by clicking on the green plus button that shows to the left of the validation button
and adding the new tag to your job's foundation data.

6. Repeat the previous steps to add additional tags. Once done, click OK.
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Non-Validated Tags
Tags are used to identify or mark records for filtering, sorting, and reporting purposes.

Tags can be created and made available to all Tags fields throughout the system or can be created for
specific Tags fields on specific forms. When created for a specific Tags field on a specific form, the list
of available Tags for that field will be limited to those Tags assigned to that field and form. Tags that
have not been assigned to a specific field and form will be available to all Tags fields on all forms.
After data is tagged, it can be filtered, sorted, and grouped using the filtering and grouping features on
the register containing the data.

Non-Validate Field Examples

Examples Description

Risk description Identify specific risks against cost items

Superintendent Identifies responsible person for operations and
forecasting

Commodities Grouping cost items for roll-up and review for
specific commodities

Client Tagging Specific cost item tagging for client

External System Flag External flags for integration

AWP Planning Assign a cost item to a Work Plan for operations

Users can take advantage of validated and non-validate tags in every register within estimate. It will be
up to the organization on how they want to best leverage tags in each register.

Register Examples
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Creating Non-Validate Tags
The following steps walk you through how to create non-validate tags within a Cost Item Record.

Step by Step — Non-Validate Tags in Cost Item Record

1. From the Ribbon, select the Estimate tab.

2. Then select Cost Breakdown Structure (CBS).

3. Double-click the row that you want to assign tags. The Cost Item Record for that row opens.

l e.g., Direct Cost Add-On, Indirect Cost Escalation, etc.

4. Select the User Defined default data block in the lower right portion of the record.

5. Click into the User Defined 1 field and type in the value needed for the cost item.

The following steps walk you through how to create non-validate tags within the register.

Cell select and fill down shortcuts can expedite the assigning process.

Step by Step — Non-Validate Tags in Register

1. From the Ribbon, select the Estimate tab.

2. Then select Cost Breakdown Structure (CBS).

3. Go to the cost item that you want to add tags and scroll to the User Defined 1 field.
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4. Type in the value needed for the cost item.

5. Changing the caption can also assist in notating how the field is to be used.
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Advanced Job Snapshots
A job Snapshot is a copy of an Estimate job that provides read only access to the job as it existed at a
specific point in time.

You can use a Job Snapshot to do the following

l Freeze your estimate at various points for audit purposes, such as after take-off is complete, after
bid review is complete, or after final subcontractor/supplier prices have been entered.

l Give access to users that need access to the information but are not permitted to modify the data.
l Enable users to access a job while eliminating the concern that someone may inadvertently
change live data.

l Copy data from a snapshot version of a job and paste it back into the live job or any other pro-
ject.

l Create a new job from a snapshot version of a job.

Behind the scenes, the job is saved and maintained as an archive. When a snapshot is loaded, the
archive is restored as a local copy. A snapshot can be modified, but changes cannot be saved. Snap-
shots are managed in the Snapshot Register.

Creating A New Job Snapshot
User access can be set for each snapshot as follows:

l Use job’s current User Access restrictions for the snapshot
l Remove all User Access restrictions for the snapshot
l Specify User Access restrictions for the snapshot

Step by Step — Creating a New Job Snapshot

1. Click on the File tab. From the Backstage View, select Snapshots from the left navigation pane.

2. Select Create Snapshot.

3. The job name and description display at the top of the dialog.

4. In the Snapshot Comment area, enter a short description of the snapshot. This comment will be
used to identify the snapshot on the Snapshot Register form.

InEight Inc.  |  Release 20.2 Page 345 of 516

Estimate Help Topics Creating A New Job Snapshot



5. To include all attachments that have been stored in the job folder with this Snapshot, select the
check box.

6. Select the Specify User Access restrictions for this Snapshot option.

7. Ensure that your name is selected, otherwise click the “Add” button and select yourself. Click
OK.
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To Create a New Job from a Snapshot
New jobs can be created from existing job snapshots using the following steps.

Step by Step — Creating a New Job from a Snapshot

1. Click on the File tab. From the Backstage View, select New from the left navigation pane.

2. Select Create Snapshot.

3. Select Create a new Job from... Snapshot.

4. Select a snapshot from which to create the job. Click OK.

5. Enter in a unique code for the new job TEST – Your Initials. Check both boxes to copy cost
details and PBS changes log into the new job. Click OK.
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6. Your job will pop up in a new window. Close out of your job and navigate back to the training
job.

7. Click OK to save.

Load a Job Snapshot
When you load an existing Snapshot, it loads into Estimate like any other job. You can use it for ref-
erence and copy data from it to other jobs. A snapshot can be modified, but changes cannot be saved.
To identify it in Estimate as a read-only snapshot:

l The job name is preceded by SNAPSHOT: in the job tab
l A red banner displays the specific snapshot information in the Current Job area at the bottom of
the screen.

Step by Step — Load a Job Snapshot

1. Click on the File tab. From the Backstage View, select Snapshots from the left navigation pane.

2. Select Snapshot Register.

3. Select the snapshot that you would like to load.
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4. From the Ribbon, select the Actions tab. Then under the Edit section, select Load.

5. Your snapshot opens as indicated by the top and bottom of the screen.

6. Close out of the snapshot. Close out of the Library.

Compare Snapshots in Job Explorer
In Estimate Job Explorer, you are able to now compare a snapshot to another snapshot, or a snapshot to
a job by selecting them in the tree view.
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Step by Step — Compare Snapshots in Job Explorer

1. Click on the File tab. From the Backstage View, select Job from the left navigation pane.

2. Select Compare Jobs.

3. Select a job and a snapshot from the Estimate Job Explorer.

4. Click Set Item Matching Criteria.

5. From the Item Matching Criteria window, select Account Code. Then click OK.
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6. On the Estimate Job Explorer, click Show Column Comparison View. Once done, click OK.

7. You can now compare the snapshot and the job column by column. Close out of the Library
when done.
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Delete a Job Snapshot
If you decide that you no longer need a snapshot or if you want to delete it for any other reason, you
can do so following this step by step.

Step by Step — Delete a Job Snapshot

1. Click on the File tab. From the Backstage View, select Snapshots from the left navigation pane.

2. Select Snapshot Register.

3. Select the snapshot you want to delete.

4. From the Ribbon, select the Actions tab. Under the Edit section, select Delete.
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5. Click OK to complete the deletion of the snapshot.

Upgrade Snapshot Version
When a snapshot is selected in the Snapshot Register that is not the same as the Estimate system ver-
sion, a prompt opens for the user to upgrade the snapshot. The snapshot must be upgraded to be
viewed. The snapshot opens automatically after the upgrade is completed, which shows the updated ver-
sion in the status bar.
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Archive and Restore Jobs
One of the most useful features within Estimate is the ability to archive job folders. This feature is used
to store job folders that you create in Estimate in a compressed format. This feature is particularly use-
ful when you want to create a backup copy of one or many jobs.

Archiving jobs can also be useful for moving a job from one environment to another, such as sending a
job file to another Estimate user in a different office or a different company.

Once you have backed up Estimate job data you always have the ability to restore that data at any time
by using the Restore feature.

As a SaaS product, Estimate is sometimes made the casualty of server-side interruptions in service,
which are out of Estimate’s control. The auto-save function makes attempts to save your data prior to
Estimate shutting down. For more information, see the Estimate resiliency section in the "General Nav-
igation" on page 12 topic.

Step by Step — Archiving a Job

1. Click on the File tab. From the Backstage View, select Archive/Restore from the left navigation
pane.

2. Select Archive Job.

3. From the Job Register, select a job to archive. Click OK.

4. Save the .est job on your desktop. Click Save. Then click OK.
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l A success message shows when saved

Restore Job Archive
Once you have archived an Estimate job, you always have the ability to restore that data at any time by
using the Restore Job Archive feature. This feature de-compresses a specified archive file and provides
you with the ability to overwrite an existing job or specify a new job code where you want to restore
your job data.

Step by Step — Restore Job - Estimate in the Cloud

1. Click on the File tab. From the Backstage View, select Archive/Restore from the left navigation
pane.

2. Select Restore Job.

3. Select the archive that you previously saved to your desktop. Click Open. The New Job from
Archive window opens.
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4. Click on the ellipsis in the Core Project field to select a Platform job.

5. Enter a code TEST RESTORE – Your Initials in the Core field. Check the boxes to copy cost
details, copy PBS changes log, and copy quotes into the new job. Click OK.

6. Your restored job will open in a new window. Close out of the restored job.
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Merge Job with Archive
Once you have archived a job, you have the ability to merge that data with existing job data at any time
by using theMerge Job Archive feature.

When merging job data, the system looks at your existing job data for matching codes or descriptions.
If the system finds a match, the existing data is overwritten (updated) to reflect the data in the archive
file. If the system does not find a match, the data is added to the job.

The Merge Job Archive feature does not merge all of the data in the job. The data that is
included/merged is as follows:

l Foundation Setup Data
l Resource Rates
l Resource Assemblies

Step by Step — Merge Job with Archive

1. Click on the File tab. From the Backstage View, select Archive/Restore from the left navigation
pane.

2. SelectMerge Job with Archive.

3. When prompted, select Yes to continue.
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4. Select your test job, then click OK.

5. Select the archive saved to your desktop, then click Open.

6. Click on the File tab. From the Backstage View, select Start from the left navigation pane.

7. Select your test job from the Open a recent Job section.
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8. From the Ribbon, select the Setup tab. Then select Job Properties.

9. You can now see that your archive and test job have merged data by viewing Resource Rates,
Resource Assemblies, and Foundation Setup Data.
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Work Breakdown Structures
WBS Overview
The Work Breakdown Structure (WBS) feature lets you create a job in one format and present in a mul-
titude of other formats depending on the need. This can be beneficial when the estimating team or the
proposal team needs to present the estimate in a preferred format to a design firm, engineering com-
pany, client or any other stakeholders. WBS retains the same relationship between items as in the ori-
ginal estimate and only changes the view and how items are arranged in the hierarchy.

Format Creation
The Work Breakdown Structure provides flexibility to create other formats, such as Construction Spe-
cific Institute (CSI) MasterFormat or UniFormat. Use WBS formats when you need to have multiple
variations and summary reports of an estimate. This is useful in cases where you want to show different
estimates in one particular way, perhaps for a repeat client or designer.

Once you have your general information entered and set up for a format, you can build your hierarchy.
This lets you organize and define the information in a format that works best for you. You have the abil-
ity to build your hierarchy from scratch or you can use a template. The default Quantity (1.00) & Unit
of Measure (Each) are populated in the WBS hierarchies. You are able to change these two items as
needed. After a WBS item has been created, it is listed in the Foundation Setup Data Register.

Step by Step — Create a WBS Item

1. From the Ribbon, select the Setup tab.

2. Select Foundation Setup Data drop down and then selectWork Breakdown Structure.

3. From the Work Breakdown Structure, select the Actions tab.

4. Under the Edit section, select New. A new Work Breakdown Structure Record opens.
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5. Enter a Code and Description for the WBS item.

6. From the Setup data block, enter a Period in the Hierarchy Separator field.

The Hierarchy Separator is used to separate the parent cost items from the subordinate and ter-
minal cost items.

7. Select the Tag 1 drop down arrow and select Concrete.

8. In the Details data block, build your hierarchy by entering items into the Code and Description
fields.
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9. In the Details data block, leave the Quantity as the default. Enter in a Unit of Measure for each
item.

10. Once done, click OK.

Assign WBS to CBS
The Cost Breakdown Structure (CBS) Register shows you the WBS Code and Description fields. From
here, you can assign your WBS items to any of your CBS items.

Step by Step — Assign WBS item to CBS item

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Right click on any column header and select Column Chooser.

4. In the Customize window, scroll down until you findWBS: Test WBS.
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5. Drag and drop both columns into the CBS column headers.
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6. Select a cost item and then click into the empty field from the WBS column you dragged and
dropped into the CBS. Click the arrow icon that appears to the right of that field. TheWork
Breakdown Structure Detail Register opens.

7. Select the WBS item to assign to the cost item. Once done, click OK.

8. The WBS selected in the previous step is now populated in that cost item’s WBS field.
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View WBS Items
In the Work Breakdown Structure View Register you can:

l Select from the list of WBS formats that you want to view your estimate. You can easily change
to a different format as needed.

l See the total cost roll up of assigned cost items and subordinate detailed items.
l Select from the hierarchy structure and show utilized cost items and associated resources in a sep-
arate panel

l Change quantities of a WBS item.

Only the unit cost is affected when the quantity has been changed.

When you are creating multiple WBS items, you are able to group the data and view the Work Break-
down Structure Hierarchy.

WBS Quantity Roll-Up

The Quantity Roll-Up feature lets you roll up and derive at the parent item’s quantity from detailed
level takeoff quantities, while eliminating the need to manually calculate these roll-up values. Estimate
is capable of automatically rolling up quantities (versus a manual roll-up) directly in the WBS by using
the Auto-Quantity (Roll-Up) field.

When a Quantity Roll-Up code is assigned and the Auto Quantity (Roll-Up) option is checked for the
item in the WBS register, rollup of the item's quantity happens automatically. When unchecked, you
can manually enter a Quantity for the WBS item. This enables you to better control if the WBS Quant-
ities need to be calculated automatically or entered manually.
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Step by Step — View WBS Items

1. From the Ribbon, select the Estimate tab.

2. In the Breakdown Structure section, selectWork Breakdown Structure. The Work Breakdown
Structure View Register opens.

3. From the WBS tree, click the WBS drop down arrow and select your WBS item.

4. In the Cost Items data block, you can view which cost items utilized by a WBS item that you
select. You can also view the total cost roll up of assigned cost items
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5. Expand your utilized cost item by clicking the + icon in the CBS Position Code. You can now
view the associated resources to your cost item and WBS item.
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Zero Production Values
Estimate stores the production values for a cost item when its quantity is set to zero. This provides flex-
ibility when copying items from templates or other jobs and lets you easily identify items that are yet to
be estimated. You can zero the quantities for superior cost items and have the subordinate items and
their employments quantities too be zeroed until they are ready to estimate a specific scope of work.

Updating the cost item’s quantity to a non-zero value restores the production values and calculates the
quantities for the subordinates/employments based on the stored factors. This way, you don’t lose any
of the factors or values.
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Parent Cost Items
When the parent cost item's quantity is updated to zero, the subordinate cost item's quantity also
updates to be zero. This is applicable for cost items that have the Quantity Driver equal the Superior
cost item.

The cost items with drivers that equal the pay item, fixed, or roll-up continues to be suspended. For
example, let's start with the the parent cost item quantity being driven by the subordinate with the quant-
ity roll up code of the parent cost item made into null/wrong code. Then, the assigned/UOM mis-
matches. Resulting in the parent cost item equaling 0. Then, the subordinates are suspended.

When the quantity of a subordinate is updated to a non-zero value, the subordinate is suspended.

When the quantity of the parent cost item is updated to a non-zero value, the subordinate is un-sus-
pended and its values are not updated proportionately.

Terminal Cost Items
For terminal cost items with zero quantity, non-zero quantity employments display in suspended color
as they are not contributing.

The employments show as suspended if the employment quantity is changed/modified after the cost
item's quantity is set to zero.

If a terminal cost item's quantity is set to zero, the employment's quantity is set to zero and is not sus-
pended. Their value is scaled based on stored factors when the quantity of the Cost Item is set back to a
non-zero value.

Upgrading with Zero Value Cost Items
During an upgrade, subordinates with non-zero value remain suspended when the parent cost item has
zero quantity. Subordinates with zero value are unsuspended when the parent cost item has zero quant-
ity.

When new cost item's are added to the Job after the Job is locked, and the parent cost item's quantity is
set to zero, then the subordinate cost item's quantity field is also set to zero and its quantity field is dis-
abled.
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Quantity Roll-Up
Estimate gives you flexibility to determine quantities in different ways depending on the way you
prefer to estimate the work. For projects where the estimate is starting with a schedule of quantities, its
common to break down the work into various activities and verify the quantities. In these cases, chan-
ging a parent level quantity pushes down the proportional changes to the cost items and resource
employments that are subordinate to the modified cost item.

For estimates where very little or no information is provided on the quantities the estimator is bidding
on, it is good practice to have these quantities derived from the detailed takeoff quantity calculations
and the estimators analysis of the work plan. The Quantity Roll-up feature enables you to do just that.

Quantity Roll-up is a flexible feature letting you roll up quantities in many different ways. The most
common use of Quantity roll-up is for you to pick a parent cost item and then choose the subordinate
cost items or resource employments that will roll-up or contribute to the parent cost items quantity.

A green upwards-pointing arrow indicates that cost items and resources employments are contributing
to the parent cost item. For an item to contribute, it needs to meet the following criteria:
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l The parent cost item has a Quantity Code assigned and its Quantity Driver set to roll-up.
l The contributing cost items or resource employments have a matching roll-up code.
l The contributing cost items or resource employments have units of measure with the same meas-
urement type as the roll-up code.

Quantity Roll-up Codes
Roll up codes are maintained in the Quantity Roll-Ups register in the Foundation Set-Up data.
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Units of Measure

Each code has an assigned unit of measure and rolls up when the unit of measurement type for the con-
tributing item matches.

For example, a quantity code of 200 - Pipe with a unit of measure of linear feet whose unit of measure
type is length can roll up the quantity of a contributing item whose unit of measure is on of the fol-
lowing:

l linear feet
l meter
l mile
l inches

As long as the unit of measure type matches, the system automatically applies the conversion factor
between those different units of measure and display the calculated value of the quantity in the unit of
measurement indicated on the parent cost item or WBS element.

Roll-Up Code Hierarchy

Quantity roll-up code assignments do not have to match the hierarchy code as long as they all share the
same parent.

For example, resources could be maintained in the library with roll-up code assignments, such as
200.10 – PVC pipe, 200.20 – VCP pipe, etc. Then those resources are rolled up to a parent item with a
roll up code assignment of 200. This combines the different types of pipe into a single roll-up value.

This lets you maintain a very detailed roll-up code structure and have quantities roll up either spe-
cifically to a single code or generally to the code's parent based on how the estimator wants to structure
the estimate and see quantities roll up.

Rolling up Quantities
Cost Item

Changing the parent-level cost item quantity can also trigger the proportional updating of a non-
contributing subordinate cost item quantity.

For example, to estimate a detailed list of material quantities, you select items in that list to contribute
to the parent cost item quantity. Now, that cost item quantity contributes to its parent, and then pushes
down the quantity proportionally to the install quantity.
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Step by Step — Rolling up cost items

1. From the CBS register, select the child cost item you want to roll up subordinate quantities into.

2. From the ribbon, select theMore Actions tab.

3. Under the Tool section, select Roll Up Quantities. The Roll Up Quantities window appears.
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4. In the Quantity Roll-Up Code drop-down, select a roll-up code. The Quantity Roll-Up Register
window appears.

5. If no codes are shown in the Quantity Roll-Up Register, select the Actions tab in the ribbon.

6. Under the Edit section, select New. The Quantity Roll-Up Record appears.
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7. Enter the required information: Code and Unit of Measure. The Description and Notes fields are
optional.

If your Unit of Measure is not listed in the drop-down list, select the green + to add your pre-
ferred Unit of Measure.

8. After you are done filling out the required information, click OK. Your rolled up quantity code is
shown in the Quantity Roll-Up Register.

9. Click OK to return to the Roll Up Quantities window. Your previously created rolled up quantity
is automatically selected for the Quantity Roll-Up Code.

10. Select the Roll-Up check boxes next to the CBS Position Codes you want to roll up.
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11. In the Cost Breakdown Structure (CBS) Register, the following columns for your previously
selected child cost item are now read-only:

l Forecast (T/O) Quantity
l Unit Cost
l Total Cost (Forecast)

To view only Quantity Roll-Up columns, go to the Saved Views drop-down and select the Quantity
Roll-Up View. This saved view displays the following columns:
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Work Breakdown Structure

You can estimate using a rip and read methodology. Quantities are automatically derived in the WBS,
so you can validate your estimate as you go.

For example, a UniFormat WBS can indicate so many dollars per building square foot or a Master-
Format WBS can indicate a overall cost per container yard (CY) for concrete.
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Step by Step — Adding Quantity Roll-Up Codes to WBS items

1. From the ribbon, select the Estimate tab.

2. Under the Breakdown Structures section, selectWork Breakdown Structures. The Work Break-
down Structure View Register opens.

3. From the WBS Tree, select the WBS drop-down. Then, select the WBS code you want to open.

4. Highlight the WBS code you want to add a Quantity Roll-Up Code.

5. In the Quantity Roll-Up Code column, select the icon to the right of the text box. The Quant-
ity Roll-Up Register appears.
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6. In the Quantity Roll-Up Register, select an existing code to add to the Quantity Roll-Up Code
column. Double-click to add it or select OK.

7. After selecting the Quantity Roll-Up Code to add to your WBS item, the number of quantities in
the Quantity column automatically changes to the quantity listed in the roll-up code you selected.
The Quantity column for that WBS item then becomes read-only.
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Copy Job Resources to Library
Resources are created in the Resource Rate Register. This register is the location where you build out
the structure of those resources.

Use of this lesson will draw from other sections of InEight Estimating Manual. Basic understanding of
the resources is required.

The following procedure is going to guide you through copying resources from a project back to your
library in InEight Estimate.

Step by Step — Copying Job Resources to Library

1. From the Backstage View, select Open from the left pane navigation.

2. From the Job Register, select the job that you want to copy resources.

3. Select the Estimate tab.

4. Under the Resources section, select Resource Rates. The Resource Rate Register opens.

5. Select the Actions tab.

6. Under the Tools section, select the option Copy Job Resources to Library.
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7. A new window appears prompting you to make a few choices on what is to be updated into the
library.

8. The system is grouped by status letting you know what has been modified from the library
resources.

9. In the main grid, you can select which resources to bring to the library. The bottom of the win-
dow has a toggle that allows you to include all the modified or new resources that you wish to
bring into the library. If preferred, select Toggle Include All located in the New or Modified
Resources data block.

10. The quoted values allows a user to update the resource rates based on the pricing that came back
to be the new value in the library during quotation. If preferred, select the Use quoted values for
awarded resources check box in the Quoted Values data box.

11. Once done, click OK.

12. A pop-up will appear asking Overwrite existing Resources?. To confirm the changes, select
Yes.
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Multi-Edit of Resources
The following procedure is going to guide you through editing multiple resources at one time in
InEight Estimate.

Use of this lesson will draw from other sections of InEight Estimating Manual. Basic understanding of
the resources is required.

Step by Step — Mutli-Edit Resources

1. From the Backstage View, select Open from the left pane navigation.

2. From the Job Register, select the job that you want to copy resources.

3. Select the Estimate tab.

4. Under the Resources section, select Resource Rates. The Resource Rate Register opens.

5. Select resources to edit.

l Use CTRL + Click to select many specific individual resources.
l Use CTRL + SHIFT + Click to select multiple resources above or below your first selec-
tion.

6. In the Ribbon, select the Actions tab.

7. Under the Edits section, select Open.
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8. Many of the fields show with the title VARIES. This is caused by different values being present
in the same fields.

9. You can edit your chosen resources to be associated with a specific quote group if that option is
available in the record. You can update records in bulk for other fields within the InEight Estim-
ate resources. To updated the quote group, select the Setup tab in the record.

10. Select the Quote Group Tag drop down. Then select the specific Quote Group Tag to associate
to your chosen resources.
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11. Once done, click OK. Your chosen resources are now associated to the specified quote group.
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Resource Employment Register
In the closing hours of a bid, it might be preferred to make a last minute modification to a resource
charge rate (that is, resource employment), such as overriding the cost of Concrete on various items.

Included in the Resource Employment Register is a detailed list of each individual resource employ-
ments, including its assigned cost item. Modifications can be made on an item by item basis.

This register lets you work with all resource employments for an estimate without the need to filter the
CBS register down to specific employments.

The Resource Employment Register also provides you with flexibility in performing bulk operations
such as editing multiple records at once. You can use the fill-down feature to quickly update data for all
Resource Employments.

Resource Employment Record
The Resource Employment Record provides you with a concise view of all data related to a single
record and lets you customize the employment separately from the Resource Rate Record in the Job
Library.

Follow the step by step below to open the form.

Step by Step — Resource Employment Record

1. From the Ribbon, select the Estimate tab.

2. Under the Resources section, select Resource Employments. The Resource Employment
Register opens.
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3. Select a Resource Employment you want to open in the Resource Employment Register.
4. Double-click the Resource Employment. The Resource Employment Record now opens.

Double-click on an Employment in the CBS or cost item record to open the Employment record.

Quantity Ratio
The Quantity Ratio column in the Resource Employment register represents the ratio between the quant-
ity of a cost item and the quantities of its resource employments.

This column shows you a clearer picture, or reference point of the proportion between the quantity of
the cost item and the quantity of the resource employment.

In the example below, the Quantity Ratio of 75 for Reinforcing steel tells you there is a 75:1 ratio, or
75 pounds per cubic yard, between the cost item quantity of 20 CY and the resource employment quant-
ity of 1,500 pounds of rebar. For example, 20 CY of retaining wall multiplied by 75 pounds/CY results
in 1,500 pounds of rebar.
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This makes the scaling factor that is used when changing the Cost Item Forecast (T/O) Quantity more
visible, so you can easily see if the ratio being applied is accurate. Adding the Quantity Ratio column
to the resource employments records (both Cost Item Details register and the Resource Employments
Register) that shows the ratio between the Cost Item Quantity and the Resource Employment Quantity
lets you more easily scan an estimate and find any quantity variations that do not look right.

Editing the Quantity Ratio field changes the resource employment quantity, making it easier to ensure
the right amount of a resource for a given cost item quantity is being used and changed to scale the
resources quantity if necessary.

The Quantity Ratio Units field shows you how the Quantity Ratio is calculated.
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Cost Escalation Overview
Escalation is the provision in a cost estimate for increases in the cost of labor, equipment, material due
to continuing price changes over time. Escalation is used to estimate the future cost of a project or to
bring historical costs to the present. Most cost estimating is done in current dollars and then escalated
to the time when the project will be accomplished. A good example could be the employment of union
labor over the duration of broader time scope. Often union labor will increase from one year to the
next. Another could be weather changes, from summer to winter conditions.

Cost Escalation is based on a schedule and can be applied to any direct cost category by date range.
Date range escalation is calculated based on each cost item's scheduled earliest start and finish dates. In
this way, escalation changes when the job schedule changes, which means that if you change the sched-
ule at any time and shift any escalated cost items and their costs from one date range to another, the
value of escalation and the effective rate changes.

As a user, you have complete control over the subject cost that you would like Direct Cost Escalation
to be calculated. In essence, you can override the default settings and choose any of the cost items on
the CBS, or define a rule (filter) that uses all cost items matching that rule as your subject cost. For
example, you can specify that the subject cost used in the calculation of Direct Cost Escalation will be
all cost items in the CBS that are assigned to a pay item and whose unit of measure is cubic yards.
Hand picking cost items or defining rules on which subject cost are defined is done on the Dependency
tab of the Direct Cost Escalation Record.

The escalation layers represent, in the Price Breakdown Structure (PBS), cost changes that accrue over
time across a cost category, based upon when the costs are scheduled to occur using the Schedule mod-
ule. For example, it represents forecast wage increases that occur midway through construction, or the
cost of installed material price inflation in the economy.

You can escalate a job's direct cost two ways:

1. Specify a fixed amount to any one or all of the cost categories.
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2. Specify a fixed rate to any one or all of the cost categories.

When you specify a fixed rate, the amount varies with the cost total that it is applied. When you specify
a fixed amount, the amount remains the same and the rate changes as cost totals change. The last input
you make designates which method you prefer. For example, if you last input a figure in the rate field
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of a cost category, then it is understood that the rate is to be fixed. The specified method is indicated on
the form with an arrow symbol.

To open a Direct Cost Escalation Record, follow the step by step below.

Step by Step — Direct Cost Escalation Record

1. From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structures section, select Cost Breakdown Structure (CBS).

3. Double-click the Direct Cost Add-On row. The Dependent Cost Item Record opens.

4. Under Saved Views, select the Date Range View.

5. Setup the escalation by giving the description a time period name (Quarters for this example).
Use the FromDate and ToDate field for each escalation period.
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Dependent Cost Items
Dependent cost items are cost items with values calculated based on a percentage of the cost of other
items. Examples include insurance the company carries, bonds, and labor overhead.

If you need to use additional dependent cost items, you can create your own, but you must delete all the
existing default dependent cost items first.

The following steps walk you through deleting your existing default indirect costs so you can create
your own.

Step by Step — Deleting Existing Default Indirect Costs

1. From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structure section, select Cost Breakdown Structure (CBS).

3. Select the Prime Bond indirect cost item by clicking on its row header.

4. Then press and hold the Shift key while selecting the Job Financing indirect cost item. All your
dependent indirect cost items are now selected.

5. Right click on the selection and select Delete.

6. Select Yes to confirm you want to delete the selected Cost Items. Your indirect cost items are
now deleted.

You can also control which default dependent cost items are copied into new jobs from scratch. You do
this in the Library from the Master CBS.

The following steps walk you through toggling the inclusion of default dependent cost items in new
jobs from scratch.
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Step by Step — Toggling Default Dependent Cost Items

1. From the Ribbon, select the File tab.

2. Select Library from the left pane navigation.

3. From the Library's Ribbon, select the Estimate tab.

4. Under the Master Breakdown Structures section, select Cost Breakdown Structure (CBS).

5. Use Column Chooser or Go To Column to bring the Auto-Include column into your view.

6. A check mark in the Auto-Include column indicates that those cost items in the Master CBS will
be included in new jobs from scratch.

Define a Contingency Add-On based on Man Hours
The following steps walk you through adding ad defining contigency based on man hours for the job.
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Step by Step — Define a Contingency Add-On

1. From the Ribbon, select the Estimate tab.

2. Under the Master Breakdown Structures section, select Cost Breakdown Structure (CBS).

3. From the Cost Breakdown Structure (CBS) Register, right click on the row header for any cost
item and select Insert Dependent Cost Item.

4. On the resulting Attention prompt, select Based on CBS Man Hours.

5. Once you are done with the Attention dialog box, Click OK.

6. Double click on the CBS Man Hour Add-On description to highlight the description title.

7. You can customize the visibility by changing the description to Contingency.
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8. Double click on the newly named Contingency row header to open the CBS Man Hour Add-On
Record.

9. From the Description tab, add a description to the Man Hour Add-On Detail.

10. The description allows the total Man-Hours for the job to display.

11. From the record, select the Dependency tab to see what contributes to your subject to cost.

You can also refine how you build your contingency. It can be based on costs where man hours
is over 10 hours. You can do this by setting a filter on the Hours (Duration driven) column and
choosing Define Subject Cost using column filtering.
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11. Define the Contingency Add-On by designating Add-On Cost/Man-Hour column.

Defining a Price % Add-On
The following steps walk you through adding and defining Price % Add-On for the job.

Step by Step — Defining Price Add-On

1. From the Cost Breakdown Structure (CBS) Register, right click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Job’s Price.
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3. Once you are done with the Attention prompt, click OK.

4. Double click on the Price % Add On row header to open the record.

5. The Price % Add-on Record opens to the Description tab. Type Office Overhead in the Descrip-
tion field and type a rate of 4.

l Office Overhead is now defined with a rate of 4% of the job’s price.

Page 398 of 516 InEight Inc.  |  Release 20.2

Defining a Price % Add-On Estimate Help Topics



6. Once done, click OK to close the record.

Defining a Direct Cost Add-On
The following steps walk you through creating a Direct Cost Add-On dependent cost item.

Step by Step — Define a Direct Cost Add-On

1. From the Ribbon, select the Estimate tab.

2. Under the Master Breakdown Structures section, select Cost Breakdown Structure (CBS).

3. From the Cost Breakdown Structure (CBS) Register, right click on the row header for any cost
item and select Insert Dependent Cost Item.

4. On the resulting Attention prompt, select Based on Direct Costs.

5. Once you are done with the Attention dialog box, Click OK.

6. Double click on the Direct Cost Add-On row header to open the record.

7. On the Description tab, type Small Tools in the blank row under the Description column.
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8. You can define additional rows for other add-on costs as needed.

l The Dependency Cost Breakdown appears on the right.
l The Subject Cost is the cost that the cost item depends on, based on what is defined on the
cost item’s Dependency tab.

9. Click on the Dependency tab to see what contributes to your subject cost.
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l There are a couple of options at the bottom to control how dependency items are selected.
By default, the bottom radio button is selected.

l The bottom radio button allows you to use column filtering to control what items are
included.

l The top button allows you to manually select the cost items you would like to
include.

10. For this activity, leave the default (lower) button selected.
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11. Select the Description tab. You can define an add-on Rate (percentage) or Cost at any of the cost
category levels in the Dependency Cost Breakdown on the right side of the record.

l You can also add a rate at the Total level to have it apply to all your cost categories.

12. Type 10 in the Rate field at the Labor cost category level, then press Tab.

13. Once you are done, click OK to close the record.

Page 402 of 516 InEight Inc.  |  Release 20.2

Defining a Direct Cost Add-On Estimate Help Topics



Split Cost Items
You have miles of trench work that you need to break up into phases. You have already defined this
trench cost item and entered the details defining the total cost to perform the work. You can split this
cost item into 4 phases of work by using the Split feature.

The Split feature changes your Cost Breakdown Structure. Before performing these steps, be sure you
have the correct cost item selected for splitting and whether or not the change is needed.

Step by Step — Split Cost Items

1. From the CBS Register, select the cost item you want to split.

2. From the Ribbon, select the Actions tab.

3. Under the Edit section, select the option.

4. When the Split Cost Item data box appears, enter in the number of parts that you want to split the
selected cost item into.

5. Select OK to copy the previously selected cost item into 4 subordinate cost items with the same
description.
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If there are subordinate cost items in the split cost item, those subordinate cost items are then
copied into each of the 4 new cost items. The cost item Total Forecast (T/O) Quantity is divided
into 4 even quantities. This subsequently divides the cost into 4 even amounts. Add the incre-
mental Phase title to the description of the 4 new subordinate Cost Items to identify them later.

Split by Cost Type

It is common for an estimate to progress through multiple levels of detail. Often a high-level estimate
for a particular scope of work consists of a single cost item inclusive of the entire cost of that work in a
single line item. As the estimate is further refined, more detail is added and at times it can become
necessary to split a cost item by the four main types of costs that make it up, such as separating the
material cost from the installation cost.

The Split by Cost Type feature gives you the ability to select a cost item or a collection of cost items,
and then separate any of the labor, equipment, material, or subcontract costs into separate cost items.

l Right click on a new Cost Item under Guardrail Type 2, and select Split by Cost Item. You can
use this option if there at least two types. If not, you will get this pop-up:
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Alternatively, click on Split.

l Enter the number of parts to split and click OK

l You will be asked if you want to proceed.  If so, click Yes

The end-result will automatically add subordinate rows which you can now edit.
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Swap Resources
Any resource assembly on the Cost Breakdown Structure (CBS) Register or the Master Cost Break-
down Structure (CBS) Register can be swapped for any other resource. In practice, this feature is useful
for making universal adjustments to the cost details. For example, you can swap a Laborer Class 1 for
an Operator Class 1 or Corrugated Metal Pipe for Reinforced Concrete Pipe.

You have a great deal of control over the instances (cost items) in which you want to swap one
resource for another. You can:

l Swap all instances of one resource for another on all cost items where that resource is employed,
whether or not the resource employment is designated as unique.

l Swap one resource for another on all cost items where that resource is not designated as a unique
resource employment.

l Swap instances of one resource for another on a select set of cost items where that resource is
employed, whether or not the resource employment is designated as unique.

l Swap one resource for another on a select set of cost items where that resource is not designated
as a unique resource employment.

In the original estimate, you had employed Dozer D8 for all of the Excavation work. A month after
first draft of the estimate, you want to replace all of your employed Dozer D8 resources with the less
expensive Dozer D6. To make this resource swap in InEight Estimate, you need to use the Resource
Swap tool.

Making changes in the Cost Breakdown Structure (CBS) Register can cause unexpected results. It is
good practice to perform an Archive of the Job or confirming the changes being committed prior to
swapping resources.

Step by Step — Swapping Resources

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Filter drop down. Then select the Filter by Resource option.
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3. When the Filter by Resource window opens, select the Dozer D8 Resource Code.
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4. Once you have this filter applied, you can see all cost items that have the Dozer D8 employed.
From the CBS Register, select theMore Actions tab.

5. From the Batch Operations section, select the Swap drop down. Then select Swap Resource.
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6. From the Swap Resource window, select the icon in the Currently employed resource section.
Then choose the Dozer D8 resource code.
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7. Next Choose the Dozer D6 resource code for the New resource to replace currently employed
entry.

8. The radio buttons in the Swap Resource window determines if you want to replace unique
resources or not. For this example, select Replace only resources that are NOT unique.

Unique is referring to resources that have defaults overridden from what was originally des-
ignated in the Resource Rate Register. If you choose Replace only resources that are NOT
unique, then the unique Dozers D8 resource in the cost structure will not be replaced. If you
choose Replace ALL resources (including unique resources), then all of the Dozers D8
resources are replaced.

9. In the next step, choose which cost items to perform the swap of Dozer D8 for Dozer D6.
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10. For this example, choose all three cost items which have the Dozer D8 employed.

11. Click OK to continue.

Because it can be difficult to revert any changes in the CBS Register you are prompted one more
time as a review of the Cost Items which will be affected by the swap.
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12. Select OK to continue. The CBS Register can appear blank. Remember that you have the filter
applied to only show Cost Items that have the Dozer D8 employed. Remove the filter.

13. The Dozer D6 now shows in place of the D8 Dozer.
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Employment Details in Swapped Resources
When swapping resources, you have the option to select the Use Default Employment Resources check
box. When selected, this check box updates the employment setup values with the defaults from the
new resource. This feature lets you use the default employment set up while swapping the resources.

CBS Hierarchy View for Resource/Resource Assembly Swap
Toggle Hierarchy is added to the Swap Resource and Swap Resource Assembly selection registers.
When selected, it allows you to view the superior cost items of your selections in the context of the
CBS Register Hierarchy. This enhancement makes it easier for you to determine when the cost items
you intended to select are the correct cost items.
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Cost Allocation
The Cost Item Record - Allocation tab lets you to spread costs from a single Cost Item Record to one
or more other cost items in the Cost Breakdown Structure (CBS) Register.

l Allocation Item - The cost item to be allocated, where you define the quantities, resource
employments and the logic that determines how to allocate the item throughout the bid.

l Allocation Target - A cost item to be the recipient of allocated cost, as defined within the Alloc-
ation Item. There may be one or many Allocation Targets for one Allocation Item.

l Distribution - A read-only cost item in the CBS representing an Allocation Target's proportional
share of the Allocation Item.

You can choose from several methods to determine specifically where and how much cost to spread:

l Quantity - Specify the amount of the Allocation Item to be spread to each Allocation Target.
l Proportionately based on another field - Allocate proportionately by one of many available
cost item values, usually based on time or cost.

l Percentage - Specify the percentage of the Allocation Item to spread to each Allocation Target.
l Unit Cost - Use the unit cost from the Allocation Item and the quantity of each Allocation Target
to drive the Forecast (T/O) Quantity of the Allocation Item.

Cost Item Allocation is a good means of spreading costs throughout a bid for the purpose of determ-
ining appropriate bid prices.

Only Level 1 cost items can be allocated, including Add-On and Escalation dependent cost items. A
subordinate cost item cannot be allocated, and a cost item that is assigned to a pay item cannot be alloc-
ated.

Cost Allocation
With Cost Item Allocation, you can track the cost of one broad cost item by distributing the cost of that
item to other cost items, so that the cost can be tracked on a more detailed level. This gives better vis-
ibility into the cost that makes up an item. For example, you can spread ST&S from one cost item to
multiple cost items that will use ST&S.

Imagine that a large portion of your scope of work for the job you are bidding has concrete. You face
the options of batching your own raw materials or purchasing the materials from a supplier. You can
use cost allocation to create the cost of a batch plant and allocate it to different items, and then compare
this unit cost to the unit cost of purchasing the materials from a supplier.

The Allocation tab allows you to spread costs from an Allocation Item to one or more Allocation Tar-
get(s).

In the Allocation Target list, the [Unit of Measure] Quantity column caption displays the Unit of
Measure of the Allocation Item. For instance, if the Allocation Item's Unit of Measure is Cubic Yards
(CY), then the caption displayed for this column is CY Quantity.
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A Distribution cost item is created as a read-only subordinate cost item under each Allocation Target. It
is copied proportionally with the quantity/cost defined to each different item in CBS.

View Filter Excludes Cost Item Allocation Details
A View Filter option is added to show only the level 1 cost item distribution in the allocation des-
tinations to provide you with a clear and comprehensive view of the CBS register, especially when
there are many allocations. When you are allocating cost items, the allocations are created in the des-
tination cost item by creating a copy of the entire allocated cost items structure. This filter allows you
to simplify the view by displaying only the parent level allocation cost item.

Cost Allocation to By Unit Cost
Having an under allocation or over allocation is ok, but it can be fixed by updating the Forecast (T/O)
Quantity of the Concrete Batch Plant. To do this, change the cost allocation to by Unit Cost.
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Dependent cost item allocation
When allocating cost for a dependent cost item, the calculation of the cost item’s subject cost aligns
with the allocation target values (such as values based on quantity, percentage, or unit cost). The target
values are the owner’s target values. This allows you to better manage allocation values.

When you allocate costs for a dependent cost item that defines its subject costs from other cost items
that include allocation from other cost items and select the option Use owner’s quantities to calculate
cost, the subject cost calculation is based on how the cost items are currently allocated. In other words,
it includes the distributed costs from the allocated cost item.

Turning Off Cost Allocation
If determined that you no longer want to spread the cost of an allocated item, you can turn off cost
allocation for that cost item. To turn off cost allocation, in the cost item record’s Allocation tab,
deselect the Allocate this Item’s Cost check box. The logic that you created to spread the costs are
retained, so you can easily select it again later.

Distributions cannot exist in the CBS when a job is published for Job Tracking. To remove dis-
tributions, either break the Cost Allocation link or deselect the Allocate this Item’s Cost check box on
the Cost Item Record - Allocation tab.

Break cost allocation link
You can break a cost allocation link and make a distribution be a permanent part of the CBS and permit
its costs and quantities to be directly editable under the cost items to which it has been distributed.

Breaking the cost allocation link breaks the link from the cost allocation item to the distribution items,
making the distribution items permanent cost items in their current locations. If the allocation item or
any of its distributions are included as a dependency on a dependent cost item, then breaking the link
could result in a change to the job’s target price. The action cannot be undone.
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Breaking a cost allocation link

1. In the CBS, open the cost item record.

2. In the Actions tab of the record, click Break Cost Item Allocation Link.

3. In the Attention dialog box, click Yes.

Pay item assignment for allocation distribution
In locked jobs, the Allocation distributions inherit target Pay Item Assignment option is automatically
selected and cannot be changed. This is normal Estimate behavior for locked jobs.

In a job that is unlocked, you have the option to select the Allocation distributions inherit target Pay
Item Assignment check box to use the same allocation distribution for the cost item’s costs anytime
the cost item is copied and added to a job.
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Alarm Limits
The Alarm Limits lets you establish limits to specific pay items to make sure the pricing is within cer-
tain limits, i.e. percentage or unit price. The Alarm Limits do not do any calculations. It informs you if
either of the limit types are outside the range. If outside the limits, the row is then colored red.

For example, when pricing Mobilization, there can be limits as to the amount that can be entered and
how soon to receive payment. In the screen shot below, you can enter up to 10% of the contract price
and receive that amount when 5 or 10% of the work is completed.

Pay Item and Proposal register:

In this case, the limits are between 8 and 10%. The row is colored red to indicate that the Unit Price is
not within the percentage limits.

The screen shot below is the record view for Mobilization.
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The following is an example for Steel Reinforcement as a Unit Price range.

Based on the screen shots, the Unit Price is not within the $1.00 to $1.50 range. It is $1.60.

The record view is now shown.
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Subtotals
The subtotal feature is for situations where the Owner wanted subtotals on the proposal form of pay
item groups.

The following screen shot is using the supplied Subtotal register view:

From the Subtotal column, the last item in the subtotal group is where the box is checked. Once the box
is checked, then a description may be entered. After the box is checked, the Subtotal Amount and
Running Subtotal Amounts are then displayed in a bold font.

In our standard Proposal Report, there is an option to printout the subtotals.
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Rounding Precision
Rounding Precision lets you change the decimal position of the Unit Prices instead of manually enter-
ing the values.

You can preset the Unit Price decimals, then using this feature, round up or down the decimals. The
job’s default Unit Price decimal is set to 2.

There are two decimal selections to understand. In the Settings form from the Backstage View,
Decimal Precision lets you to calculate how many decimals to display.

In the Cost Basis form from Job Properties, use the Unit Price decimal to calculate the Total Price.

In the following screen shot, the Rounding Precision column is set to 2 for each pay item with the
exception of Mobilization, which was changed to -2. The -2 means to the nearest $100.
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Change the 2 and 3 pay item row's Rounding Precision to 0 and 1. The Unit Price changed accordingly.
In doing so, you are moving the decimal to show tenth, zero, ten dollars, or in the Mobilizations case to
the nearest $100.
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Payment Methods
There are three types of payment methods to choose from:

l Unit Price
l Fixed Final Pay
l Time and Expense
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Unit price
Unit Price is the default payment method. This option multiplies the unit price with the pay quantity to
calculate the total price.

Fixed final price
Fixed Final Price has two applications:

l Include a price for Allowance type pay items.

l Accurately calculate the over/under run pay items that are paid as if they were lump sum items.

Allowance type pay items

Allowance type pay items, sometimes referred to as contingency items, is where the owner provides a
pay item and includes their own price for the item to be used by the contractor when completing the bid
form. The pay item value becomes part of the proposal where the price for this item is included in the
total bid amount and is frequently used by the owner as an allowance for scopes of work that might or
might not be used, enabling owners to include in the total value of those items in their budget/contract
amount for the project.

To identify a pay item as an allowance item, select Fixed Final Pay , and then enter the allowance
amount of the pay item, for example $10,000.

You can then lock the $10,000 pay item so its value does not change when auto-pricing the proposal.
Note that the issue now is having a pay item with $10,000 of price and no assigned costs. Assuming
you did not want to add any overhead and profit dollars to the $10,000 pay item, in the CBS create and
assign a cost item to this pay item and then enter a plug cost of $10,000. The cost category used should
be a category that will not be used in a direct or indirect cost markup item, so the markup can be cal-
culated on the other costs in the job. The price of $10,000 is included in the proposal but is offset by
the $10,000 of cost in a cost category that will not be used in any markup for overhead or profit.
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Calculation of over/under run pay items using Fixed Final Pay method

The Fixed Final Pay method is used to accurately calculate the over/under run pay items that are paid
as if they were lump sum items. An issue occurs where a pay item is provided with a quantity (i.e.,
Superstructure Bridge of 10,000 CY) and you must enter a unit price against the 10,000 CY.

However, if the specifications states that this pay item will not be measured for payment and must be
paid as if it were a lump sum item, but your quantity takeoff reveals that you will actually install more
or less than the 10,000 CY. For example, your takeoff came to 12,000 CY and you entered the Forecast
(TO) Quantity with the 12,000 CY.

In the CBS, the cost of this work is calculated based on the 12,000 CY. Typically, in a quantity under-
run/overrun situation, Estimate can help you decide how best to price out these items. In this case, you
cannot take advantage of the overrun situation. Using the Fixed Final Pay method with a quantity vari-
ance, Estimate can prorate the unit price of the item that will be paid for 10,000 CY, while still account-
ing for the cost to install all 12,000 CY

The following example shows where you have an overrun normally. It shows that you have the CBS
direct cost as $4.00 times 12000 CY for $48,000. Notice the direct costs of $40,000 and the balanced
unit of $5.51. This is the normal calculation if this was a true overrun pay item.

When you change the payment method to Fixed Final Price, the CBS cost of $48,000 now shows.
Then when you price out the pay item, you get a $48,000 return.
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Time and expense
The Time and Expense payment method is used to designate pay items that should be Cost plus pay
items when the estimate is published to InEight Control. When the estimate is published to Control, the
Time and Expense payment items become Cost plus pay items in Control.

InEight Inc.  |  Release 20.2 Page 429 of 516

Estimate Help Topics Time and expense



Unbalanced Pricing
The pay items are provided along with the Pay Quantities. If the pay items are to be measured and paid
on the final measured quantity, then we can provide information to price the pay items to maximize the
return. Some specifications are written that if an over/under pay item runs a certain percent, then the
Unit Price is negotiated. Now, understanding this,you can forecast the final revenue result.

The following screen shot shows a typical over and under run situation. The overrun quantities are
shown in green and the underrun is shown in red. I have balanced priced the job where all pay items
are using their Balanced Unit Price. In the Variance box, the Profit row, there is an ADD of $4153 dol-
lars.

This means that if your Forecast Quantities become the final measure amount, I lose the $4153 dollars.
This is the difference between the Target Profit and the Forecast Profit. The issue is the underrun quant-
ity is priced at its Balanced Price, meaning there is 3000 Ton that I will not be paid for if my 35000
Ton is what I am expecting.

Now, I will use the system’s Unbalanced feature to price all the pay items. See the following screen
shot.

Page 430 of 516 InEight Inc.  |  Release 20.2

Time and expense Estimate Help Topics



What the Unbalanced Autoprice did was to price out the underrun with it’s Direct Cost only. The over-
head and profit share of the underrun was spread proportionately to the overrun items. The underrun
was priced lower than normal and the Overrun items were price higher than normal.

Now look at the Variance block and see the Profit row where it now says CUT, meaning if my forecast
quantities in up being the final measured quantities, I will pick up an additional $61,723 dollars in
profit.

The CUT simple allows you to decide if you want to keep the final Proposal price as shown, or to CUT
the $61,000 OR ANY PORTION of it from the final Proposal amount to get the job believing your
Forecast Quantities is the final measured quantities. Of course you can enter any preferred Unit Price.
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Alternate Scenarios
The Alternate scenarios feature allows a contractor to effectively evaluate multiple approaches to an
estimate, and quickly identify the most cost efficient way of performing the proposed work. Both own-
ers and contractors need more visibility to see the impact of changes made to the assumption made on
the cost model.

For example, a contractor might want to estimate the cost of hauling excavation material using a
scraper hauling machine(s). Alternatively, a contractor may want to compare the cost of loading and
hauling that same excavation material with a loader truck(s). You should be able to estimate both
approaches quickly and switch between various scenarios.

Owners are increasingly requiring contractors to provide alternative items within the bid proposal. Con-
tractors should consider the cost impact of alternative estimate approaches, while also contemplating
how to effectively price their work.

The primary purpose for using Alternate Scenarios is to create ‘What If’ type of scenarios to gain a bet-
ter view of estimating ‘like’ situations. By defining Alternates, you have the ability to compare multiple
scenarios within an estimate, in which you can suspend or unsuspend various records.

Manually suspending and unsuspending items can be time consuming and error prone, and can require
maintenance of several versions of the estimate. Creating Alternate Scenarios is a solution to this prob-
lem.

Base Alternate
Base Alternate refers to your base or anchor estimate and is part of the estimate’s cost.
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Alternates Records
Alternate records are used to define alternate scenarios so that you can assess the impact of those scen-
arios.

To access the Alternates form select the Estimate tab. Under the Alternates section, select Alternates.

This action opens up the Alternate Record Details form.

Names Description

1. Code Code of Alternate Scenario.

2. Description Description of Alternate Scenario.

3. Active Determines if Alternate Scenario is active within
CBS or not.
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Names Description

4. Total Cost
(Added)

When Alternate is set to active, it will not be sus-
pended, and its CBS Total Cost will be added to
the estimate’s Total Cost Forecast. Below
example shows the full $84,000 will be included
in the estimate.

5. Total Cost (Sus-
pended)

When Alternate is set to active, Total Cost Sus-
pended will be $0 because alternate is active part
of bid.

6. Total Cost (Net
Change)

Difference between Total Cost Added and Total
Cost Suspended.
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Alternates Record Details
Drill down into an Alternate Record to view and edit its attributes. The Alternate Record details form
provides you with a way to setup rules for auto suspending and unsuspending groups of cost items.

Names Description

1. Assigned to Altern-
ate

Code of Alternate Scenario.
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Names Description

2. Suspended by
Alternate

Description of Alternate Scenario.

Step by Step — Create Alternate Scenario in CBS

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Using the Unclassified Excavation cost item, type in Rock Excavation as a new subordinate.

4. Then type in 3000 in the Forecast T/O Quantity column.

5. Under the Unit of Measure column, select Cubic Yard.

6. Double click the Rock Excavation cost item to open the cost item's record.

7. Select the Plug tab. Under the Subcontract section click into the Unit Cost field for the Sub-
contract Price.

8. Type $28.00 in the Plug Unit Cost column for the Subcontract Price. Once done, click OK.
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9. On the CBS Register, change your Saved Views to Alternates View.

10. Select the Rock Excavation cost item. Under the Alternate column, select the drop down arrow,
and then select the Add icon. This will open up a new form to create a new Alternate record.

11. Type ROCK1 in the Code field, and type Rock Excavation in the Description field. Once done,
click OK.
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12. An Attention message will appear alerting you the item will be suspended once you move off the
field.

13. Select Yes. You see the Rock Excavation item is now in suspended status.

Suspended status is the default status for alternate items.

14. In order to activate this alternate item, select the Estimate tab in the Ribbon and go the Altern-
ate Scenario drop down in the Alternates section.

15. Then select the ROCK1 scenario. Once done, click OK. The Suspend check box fields is no
longer checked for Rock Excavation.

Alternate Scenario’s BASE and ROCK1 are now both included in the Total Cost Forecast in your
estimate. This is also known as additive type of alternate, meaning that when it’s active it will be
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added to the estimate. When Alternate Scenario Base + ROCK1 are both checked, the cost item
assigned to the ROCK1 alternate is included in the Total Cost (Forecast).

16. When only the Base Alternate Scenario is checked, the cost item assigned to the ROCK1 altern-
ate is NOT included in the Total Cost (Forecast). Only base alternates are including the estim-
ate’s cost.

When a cost item is assigned to an alternate, it’s then considered an alternate item in the estimate
and does not contribute to the job’s cost until the alternate is ‘activated’.

Assigning multiple cost items to one alternate
Any number of cost items can be assigned to a single alternate item. The alternate feature can be used
to quickly suspend and unsuspend groups of items. Another manner in which alternates can be used
would be to consider two different approaches to completing the same scope of work. In this case the
activation of an alternate would replace the preselected cost items.

Imagine you are a contractor and want to assign an Alternate Scenario to your 3.2 Excavation Trucks
cost item, and at the same time automatically suspend your 3.1 Excavation Scrapers cost item. You
need an Alternate Scenario view showing what would happen when you suspend Excavation Scrapers,
but want to keep your Excavation Trucks active. You’d like to evaluate this pricing scenario, especially
your Total Cost Forecast.
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Step by Step — Multiple Cost Items to an Alternate

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Create a copy of cost item Excavation and rename it Excavation, scrapers.

4. Rename the original Excavation cost item to Excavation, trucks.

5. Under the Unit of Measure column, select Cubic Yard.

6. Double click to open the cost item Excavation, trucks.

7. Add a new Construction Equipment Resource: code ETDT Dump Truck, then select OK.

8. Add a new Construction Equipment Resource: code EL950 Loader 950, select OK.

9. Change the quantity of ETDT Dump Truck to 5.

10. Add a new Labor Resource: code LT1 Teamster, then select OK.

11. Change the quantity for LT1 Teamster to 5.

12. Remove resources ES621 Scraper 621, ES623 Scraper 623, L01 Operator Class 1.

13. Change the quantity for L02 Operator Class to 5.

14. Change the Cubic Yard/Day to 2800 on the Production tab.

15. Your results should look like this:
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16. The Unit and Total Cost are now recalculated. Once you are done with all your changes, click
OK to return to the CBS register.

17. Your Excavation, truck cost item is now worth $3.59 a Cubic Yard, while your Excavation,
scraper cost item is worth $3.00 a Cubic Yard.
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In order to make these two cost items mutually exclusive, meaning that you want one or the other
in the bid, you can set this up via an alternate item. You can set this up so that one is auto-
matically suspended, while the other is active

18. For Excavation, truck, add a new Alternate by click on the Alternate field and selecting the new
icon.

19. Type ROCK2 in the Code.

20. Type in Trucking Excavation for the description.

21. Click on the Cost Items tab. In the CBS Position Code field, select the Excavation, scrapers.
Excavation, scrapers will now be suspended when Alternate Excavation, trucks is active.

22. An Attention message will appear alerting you the item will be suspended once you move off the
field. Select Yes to continue. On the CBS Register, you now see that Excavation, trucks is sus-
pended while Excavation, scrapers is activated.
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23. In order to activate this alternate item, select the Estimate tab in the Ribbon and go the Altern-
ate Scenario drop down in the Alternates section.

24. Then select the ROCK2 scenario. Once done, click OK.

25. The trucks cost item is now active and scrapers has automatically been suspended. Now the Sus-
pended by Alternate column is checked for cost item Excavation, trucks.
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Pay Item Alternates
An Alternate Scenario is a set of active Alternates that can also be used with Pay Items. It’s reasonable
for the owner to include pay items as alternates within a job. The owner will most likely base the bid
selection criteria primarily on the base bid items, but may also include alternate items in addition.

The contractor will want to understand the cost impact of an alternate if it is awarded. Contractors may
not know ahead of time which combination of alternates an owner may choose to award. This feature
will help the contactor understand how to spread markup to various bid item prices using different scen-
arios. This permits easy comparisons between different scenarios.

Imagine you are a contractor and bidding a job where the owner has included a security guard booth
pay item as an alternate item in the job. The owner bases the base bid selection criteria on the base bid
items, however, the owner elects to include alternate items in the award of the contract too. You as the
contractor need to add the new security guard toll booth pay item to analyze the cost impact of adding
this alternate, among other scenarios.

Suspending an item is the same as ‘Deducting’ an item.

The owner’s bid could look like this below, where the first eight pay items are base pay items. The last
Toll Booth pay item is the owner’s Alternate. All items the owner is requesting to see in the con-
tractor’s bid.

The one Alternate Construction item below represents a bid item the owner would like to have as part
of the bid as well. However, this one alternate is more of a ‘would like to have’. The Alternate item(s)
help to give the owner the option to accept the Alternates if it still falls within the owner’s budget.
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Step by Step — Create Pay Item and Proposal Alternate Scenario

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. Select the Saved Views drop down arrow and select Alternates View.

4. At the bottom of the register, create a new pay item labeled as Security Guard Booth in the
Description field. Then in the Pay Item Number field, type in SG1.
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5. Now create a new Alternate for the Security Guard Booth pay item using the same steps for your
new cost item.

6. Click in the Alternates field for the Security Guard Booth Alternate. Select the add icon. An
Alternate Record opens.

7. In the Code field, type in code ALT3.

8. In the Description field type in Security Guard Booth Alternate.

9. Go into the CBS and copy all of the subordinate cost items for the existing Toll Booth cost item.
(We will assume the same Toll Booth resources are needed for a Security Guard Booth).
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10. Paste the copied cost items into the new Security Guard Booth cost item you just created in the
PIP.

11. The cost items have all been automatically suspended in the CBS. This is because the Security
Guard Booth pay item is suspended as well
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12. In the Pay Item & Proposal Register, activate alternate pay item Security Guard Booth by select-
ing Alternate Scenario Base + ALT3 at that top of the form.

13. The Security Guard Booth is now activated. You can now see that all of the pay items have
been priced including the Security Guard Booth Alternate pay item.

You may need to establish your pay item price first if a price does not yet exist

14. From the register, select the Actions tab. Then under the Auto Price section, select the Balance
Bid drop down.

15. Select the option Hit Target Goal in order to auto price the job. Now all of the pay items have
been priced, including the Security Guard Booth Alternate pay item.
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Compare Alternate Scenarios
You can price and analyze the impact of each Alternate Scenario to the estimate’s Total Price on the
Pay Item & Proposal Register. This is after the Alternate Scenarios have been defined, assigned, and
activated.

Each Alternate and combination of Alternates represents a different scenario, and prices need to be
established for every scenario that you want to compare.

For example, if you have defined Alternate Scenarios 1, 2 and 3, you may wish to price each of them
separately, and price any combination of them, and/or you may wish to price the combination of all
three.

Be sure to establish bid prices for every alternate or combination of alternates.

Step by Step — Compare Alternate Scenarios

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. On the Pay Item & Proposal Register, select the Actions tab. Under the View section, select
Compare Alternative Scenarios. This action performs a comparison among the various
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Alternative Scenarios you’ve priced so far.

4. After selecting Compare Alternative Scenarios, new columns appear on the pay item form. These
columns show a comparison of the base bid, plus Alternate Scenarios that have been priced so
far.

5. The current scenario base price Total Price is $6,307,253.15, however the Alternate Price scen-
ario for the additional Security Guard Booth is $6,337,826.19
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Benchmarking Overview
Benchmarking is used to validate an estimate's cost and productivity values by comparing them to rel-
evant historical data, specifically as-built and as-estimated information captured from past jobs in Estim-
ate. Unit cost and unit man-hour benchmark data points are displayed graphically in relation to the
current estimate.

When using the Estimate in the Cloud benchmarking feature, it requires the installation of Connected
Analytics.

Benchmarking Master Job Properties Form
TheMaster Job Properties - Benchmarking form is used to establish the historical data to be used
for benchmarking the current job, and to define the default benchmark graph display and calculations.

TheMaster Job Properties - Benchmarking form includes:

l Historical Data Source - Select As-Estimated and As-Built data from the Data Warehouse.
l Default Cost Item Matching Criteria, Default Account Code Matching Criteria and Default
Jobs Filter - Define which cost items, account codes and jobs should be included.

l Benchmark Graph display Options - Define the data to be represented on both the X-Axis and
the Y-Axis of the graph.

l Calculate "Average" as- Define the calculation method as either Average orWeighted Avg
(weighted by current Qty).

l Benchmark - Select a benchmark value of Cost per Unit,Man-Hours / Unit, or Units / Man-
Hour.

l Flag an item's variance relative to the benchmark data when - Define the breakpoints for
low, medium and high variance ranges.

l Don't benchmark items with fewer than <number> historical data points - Designate the
minimum number of data points needed to benchmark an item.

The data in the Master Job Properties - Benchmarking form is automatically copied to any newly cre-
ated jobs. If all of the jobs that you create in Estimate will use the same rules, defining the data in the
Master Job Properties form will save time when you create new job folders in Estimate.

In addition to the primary Forecast (T/O) Quantity and Unit of Measure on each cost item, Sec-
ondary Quantity and Secondary Unit fields in the Cost Item Record can be used to capture a mean-
ingful, alternative quantity and unit on which to analyze As-estimated data.

You can establish the historical data to be used for benchmarking the current job, define the default
benchmark graph display, and define high, low and medium variance ranges on the Job Properties -
Benchmarking form.
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Step by Step — Benchmarking Master Job Properties Form

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Setup tab. Under the section Master Initialization, select Job Prop-
erties. The Job Properties register opens.

3. On the Job Properties form, select the Benchmarking tab.

4. The Historical Data Source defaults to Data Warehouse. Select the historical data to use: As-
Estimated, As-Built, or both.

5. To define Default Cost Item Matching Criteria, click the Edit button and define your criteria
for matching cost items. You can select one or many fields and relate them using AND/OR logic.

6. To define Default Account Code Matching Criteria, click the Edit button and define your cri-
teria for matching cost items. You can select one or many fields and relate them using AND/OR
logic.

A matching benchmark data point will be excluded if its unit of measure type (e.g., area, length,
etc.) is different than the unit of measure type of the matching item in the current estimate.

7. To filter the jobs to include, click the Edit button on the Default Jobs Filter and define your job
filtering criteria.

8. Choose your Benchmark Graph Display Options:

l Select the data to be represented on the X-Axis:
o Date
o Item Quantity (Primary)
o Item Quantity (Secondary)
o Ratio (Primary / Secondary)
o Ratio (Secondary / Primary)

l Select the data to be represented on the Y-Axis:
o $ / Primary Unit
o Man-Hrs / Primary Unit
o Primary Units / Man-hr
o $ / Secondary Unit
o Man-Hrs / Secondary Unit
o Secondary Units / Man-hr

9. Define your average calculation method as either Average orWeighted Avg (weighted by cur-
rent Qty).

10. Define the Benchmark values that will be calculated from the historical data set by selecting
Cost per Unit,Man-Hours / Unit and Units / Man-Hour.

11. Define the variance ranges to be used for flagging an item relative to the benchmark data:
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l To flag an item's variance from the average, select Its % variance from the average
exceeds and choose the Low,Medium, and High percentages to flag (values are incre-
mented by 1%).

l To flag an item's standard deviations from the norm, select Its standard deviations from
the norm (using SSTDEVP method) exceeds and choose the Low,Medium and High
values to flag (values are incremented by .1).

12. To customize the display colors for the Low,Medium and High ranges, click on a color block
and choose a different color.

13. To set a minimum number of benchmark data points required for an item to be benchmarked,
select a number in the Don't benchmark items with fewer than historical data points field.

NOTE: The data in the Master Job Properties form is automatically copied to any newly created
jobs. If all of the jobs that you create in Estimate will use the same data, descriptive information
and rules, defining the data in the Master Job Properties form will save time when you create
new job folders in Estimate.
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Benchmarking Job Properties Form
The Job Properties - Benchmarking form is used to establish the historical data to be used for bench-
marking the job, and to define the default benchmark graph display and calculations.

The Job Properties - Benchmarking form includes:

l Historical Data Source - Select As-Estimated and As-Built data from the Data Warehouse.
l Default Cost Item Matching Criteria, Default Account Code Matching Criteria and Default Jobs
Filter - Define which cost items and which jobs should be included.

l Benchmark Graph display Options - Define the data to be represented on both the X-Axis and the
Y-Axis of the graph.
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l Calculate "Average" as- Define the calculation method as either Average or Weighted Avg
(weighted by current Qty).

l Benchmark - Select a benchmark value of Cost per Unit, Man-Hours / Unit, or Units / Man-Hour.
l Flag an item's variance relative to the benchmark data when - Define the breakpoints for low,
medium and high variance ranges.

l Don't benchmark items with fewer than <number> historical data points - Designate the min-
imum number of data points needed to benchmark an item.

Step by Step — Opening the Job Properties Form

1. On the Ribbon, select the Setup tab.

2. Under the Initialize section, select the Job Properties drop down arrow.

3. On the drop down list, select Benchmarking.
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Benchmarking Graph
The defaults for the benchmarking graph are defined on the Job Properties - Benchmarking form, but
on the Cost Item Record - Benchmarking form you have the ability to override the default criteria in
order to expand or contract the amount of historical data being used to calculate benchmark values for a
specific cost item. This way, you can filter the historical data sources to only the past jobs that are rel-
evant to that cost item.

Before starting this procedure, make sure to set up your default benchmarking options, as outlined in
the Benchmarking Options topic.
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Step by Step — Benchmarking Graph

1. From the Ribbon, select the Estimate tab. Under Breakdown Structures, select Cost Breakdown
Structure (CBS).

2. On the Cost Breakdown Structure (CBS) Register, select theMore Actions tab. Under the Tools
section, select Refresh Benchmarks.

3. The Refresh Benchmarks dialog shows the Last refresh date and the number of Jobs matching fil-
ter criteria.

l If the number of matching jobs is too large or too small, return to step 1 and expand or
contract your filtering options.

l If the number of matching jobs is acceptable, click Refresh Now to proceed.

4. Open the Cost Item Record of any preferred cost item.

5. Click on the Benchmarking default data block located in the lower right portion of the Cost Item
Record.

6. The benchmarking graph shows the historical benchmark values for this cost item, along with the
Current value, the Average value, and the variance ranges represented by each color. This inform-
ation is calculated and displayed as specified on the Job Properties - Benchmarking form.
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7. To refine the values that contribute to this cost item's graph, click the Settings button to display
the Settings dialog:

l To override the job filter for this cost item, click the Edit button in the Override Jobs Filter
field and define the filter to use for benchmarking this cost item.

l To override the Display Options for this cost item, select the desired values from the X-
Axis and Y-Axis drop-down boxes.

l To override the list of jobs that contribute to the Included Historical Data for this cost item,
use the Auto include all matching data points toggle to include all or exclude all, and select
the individual Include check boxes for the jobs you want to include.

l When you have completed your customizations for this cost item's benchmarking, click
OK to save your changes and return to the Cost Item Record - Benchmarking form.
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8. To zoom in on a portion of the graph, click and drag across the portion of the graph that you
want to enlarge. To view the entire graph again, click Reset Zoom.
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9. To print a Benchmark Report, click the Print button, change any options as necessary on the
Benchmark Report dialog, and click Run.
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Account Code Utilization Register
The Account Code Utilization Register is used to roll estimate line items into an account code hier-
archy, with the ability to control which cost items contribute quantity to their parent, in order to bench-
mark against historical projects in a way that is consistent across projects.

The Account Code Utilization Register is similar to the Cost Breakdown Structure (CBS) and the
Master Cost Breakdown Structure (CBS), with the following exceptions:

l The rows in the Account Code Utilization Register represent Account Codes rather than indi-
vidual Cost Items, so the tree structure reflects the Account Code hierarchy rather than the CBS
hierarchy.

l The detail rows in the Account Code Utilization Register reflect a terminal Account Code's
assigned Cost Items.

l The terminal rows in the Account Code Utilization Register represent each utilized Account
Code in the CBS.

l If the Account Code’s Auto-Quantity setting is set to Yes, then the Quantity of the terminal row
is equal to the Quantity (Primary or Secondary) of all the cost items in the CBS with that
assigned Account Code, and the cost items in the CBS employing resources with that assigned
Account Code, provided that they have the same Unit of Measure type as the Account Code.

l Detail rows for each terminal row represent the cost items assigned to the terminal Account
Code, including cost items employing resources that are assigned to the terminal Account Code.

l The Account Code Utilization Register can be filtered to display only terminal items by clicking
the drop down arrow on the Is Terminal column and selecting Checked.

l When an Account Code is assigned to an employed resource, the resource's total Cost/Mhrs are
removed from the Account Code associated with the cost item and placed, instead, in the
Account Code assigned to the employed resource.

The parent-child hierarchy for Account Codes is based on the Account Code Hierarchy Separator,
which is located from the Backstage View Settings under the Options drop down labeled as Account
Code Settings. The Hierarchy Separator defines the parent-child relationship within the Account Code
structure.

The Account Code Utilization Register is used primarily for analysis, and most of the columns are
read-only. Most of these columns originate on the Account Codes tab in the Foundation Setup Data
Register and theMaster Foundation Setup Data Register. Modifying an editable column on this
form has the same effect as modifying the same field on the Account Codes tab of the Foundation
Setup Data Register or on the Account Record. For further information, see Creating Account Codes.

The Benchmarking portion of the form is similar to the Benchmarking data block on the Cost Item
Record, with the following exceptions:
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l The Item Matching criteria is always Account Code.
l Parent account codes will include all matching data points for their child account codes, based on
the Hierarchy Separator.

l Account Code rows can be benchmarked at the terminal row level or at any superior row level in
the Account Code Utilization Register, meaning that both current estimate values and benchmark
values can be compared at any level since both include the values rolled up from their children.

Opening the Account Code Utilization Register

Step by Step — Opening the Account Code Utilization Register

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Estimate tab.

3. Under the section Master Breakdown Structures, select Account Code Utilization. The Account
Code Utilization Register opens.
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Account Code Management
The make-up of account codes is dictated by the specifications of your cost accounting system. Each
code represents one cost account. Account Codes serve as a standardized coding system to track like
operations across a company, for the purpose of global reporting and benchmarking. Multiple CBS cost
items can be coded to the same account code if they fall under the same category.

Once an account code has been assigned to each cost item in a job's Cost Breakdown Structure (CBS),
the software can automatically or manually summarize all like assignments into one budget line (for
each account). Budgets can be captured for both primary and secondary quantities.

Account codes are often used to summarize cost items into standardized categories for use in bench-
marking and estimating applications.

They are useful for large company that use multiple levels of accounting-related cost codes for their
budget. They are extremely useful for benchmarking purposes. Account Codes provide a common lan-
guage (set of codes) that you can use across systems.

Account codes can be used to track: quantity, budget, account code tags, unit cost.

Account Code Setup
Account Codes can be setup for a project from the Foundation Setup Data Registerunder the
Account Codes tab. The columns for populating account code information are as follows:

Column Description

Utilized This is a checkbox denoting whether or not the
account code is assigned to a cost item in the pro-
ject.

Account Code The alpha numeric sequence assigned as the
code.

Description Description detailing the account code’s scope.

Unit of Measure The primary unit of measure for the account
code.

Secondary Unit of
Measure

The secondary unit of measure for the account
code.

Currency The currency assigned to the account code.

Auto-Quantity
(Primary)

Automatically roll up cost item quantities if the
cost items and this account code have the same
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Column Description

primary UoMs. It can also be set on a project spe-
cific basis.

Quantity The default quantity for the account code.

Auto-Quantity (Sec-
ondary)

Automatically roll up cost item quantities if the
cost items and this account code have the same
secondary UoMs. It can also be set on a project
specific basis.

Secondary Quantity The secondary quantity for the account code.

Tag 1-20 Tags that can be associated to account codes to
enable them to be categorized.

User Defined Field
1-10

Optional open-text fields you can use to add
information related to the account code.

Create an Account Code

Account Codes can be created for the project level within a project or for multiple projects within the
Library. Account Codes should be as detailed as possible to most accurately benchmark work. Only
lead estimators or estimators with a lot of experience should create new account codes.

The master set of Account Codes is created and stored in the Library on theMaster Foundation
Setup Data under the Account Codes tab. When a new folder is created, the master set is auto-
matically copied from the Library to the new folder.

If you feel the current job requires new or different Account Codes to adequately organize the job's
budget, you can change, create, or delete them any time you wish. Account Codes can also be created
on-the-fly in the folder.

Step by Step — Create an Account Code

1. From the Setup tab, select the Foundation Setup Data drop down and then Account Codes.

2. From the Actions tab, under the Edit section, select New.

3. Enter a unique account code TEST – Your Initials. Enter the description Test Account Code.
Select a Unit of Measure. Enter a quantity.
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4. When you are done, click OK.

5. Your account code is added to the bottom of the register. The Utilized column is unchecked
because your account code has not yet been utilized.

Edit an Account Code
Editing an account code is also done through the Foundation Setup Data tab and selecting Account
Codes.

Step by Step — Edit an Account Code

1. Select your account code.

2. From the Actions tab, under the Edit section, select Open.

3. Select the Auto-Quantity Primary check box. Notice that your quantity goes to 0.
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4. Enter some notes in the Notes field.

5. Click on the Tags/User Defined Fields tab. From the Tag 1 drop down arrow, select Concrete.

6. Enter in test in the User Defined 1 field. Once done, click OK.
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Quantity Contribution
At the project level, you can manage account codes under the Account Code Utilization Register or in
Foundation Setup Data. In the Account Code Utilization Register, you can see the account codes
assigned to your cost items, along with account code details and quantity contributors.

Other budget information is automatically pulled into the Account Code Utilization Register includ-
ing, Total Cost, Unit Cost, Unit Rates, Primary and Secondary Quantity Ratios, Man Hours, and
Account Code Tags. To access this information, scroll through all of the columns in the Account Code
Utilization Register.

Account Code Quantity
There are two methods for defining primary and secondary quantities for your account codes:

l Manual entry in the Primary Qty and Secondary Qty fields
l Using the auto-quantity feature to have them automatically inherit the quantities of any cost items
that have the same unit of measure as the assigned account code

Quantity Contributors
Within your project, you can specify how primary and secondary quantities contribute to your account
codes. Specifically, you can indicate how:

l Cost item primary and secondary quantities contribute to assigned account code primary and sec-
ondary quantities

l Child account code primary and secondary quantities contribute to parent account code primary
and secondary quantities

For both cost item and account code contributions you can have quantities roll up:

l Primary quantity to primary quantity
l Primary quantity to secondary quantity
l Secondary quantity to secondary quantity
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Account codes will only automatically inherit quantities from cost items/account codes using the same
unit of measure.

Contribution Options – Cost Item to Account Code
From the Account Code Utilization Register, you can specify how cost item quantities roll up to the
account code that is assigned to it, by selecting the appropriate checkbox. The total of the contributing
cost item(s)’s quantities will roll up to become the account code quantity.

Account Code Utilization Register
The Account Code Utilization Register keeps track of how the account codes are used for the project.
It displays the mapping between CBS items and Account Codes.
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The Account Code Utilization Register is accessed through the Estimate tab from either within the pro-
ject (for project specific account codes and cost items) or the Library (for Master account codes and
cost items).

Account code hierarchy rolls up based on your assignments (just like in the CBS). Quantity con-
tributors (discussed above) can be employed from within the Account Code Utilization Register.

The Account Code Utilization Register is used to roll estimate line items into an account code hier-
archy, with the ability to control which cost items contribute quantity to their parent, in order to bench-
mark against historical projects in a way that is consistent across projects.

The Account Code Utilization Register is similar to the Cost Breakdown Structure (CBS) and the
Master Cost Breakdown Structure (CBS), with the following exceptions:

l The rows in the Account Code Utilization Register represent Account Codes rather than indi-
vidual Cost Items, so the tree structure reflects the Account Code hierarchy rather than the CBS
hierarchy.

l The Utilizing Items data block in the Account Code Utilization Register reflect a terminal
Account Code’s assigned Cost Items.

l The terminal rows in the Account Code Utilization Register represent each utilized Account
Code in the CBS.
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l If the Account Code’s Auto-Quantity setting is checked, then the Quantity of the terminal row is
equal to the Quantity (Primary or Secondary) of all the cost items in the CBS with that assigned
Account Code, and the cost items in the CBS employing resources with that assigned Account
Code, provided that they have the same Unit of Measure type as the Account Code.
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l The Account Code Utilization Register can be filtered to display only terminal items by clicking
the filter icon on the “Is Terminal” column and selecting “Checked”.
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l The parent-child hierarchy for Account Code is based on the Account Code Hierarchy Separator.
The Hierarchy Separator defines the parent-child relationship within the Account Code structure.

l The Account Code Utilization Register is used primarily for analysis, and most of the columns
are read-only. Most of these columns originate on the Account Codes tab in the Foundation
Setup Data Register and theMaster Foundation Setup Data Register. Modifying an editable
column on this form has the same effect as modifying the same field on the Account Codes tab
of the Foundation Setup Data Register or on the Account Record.
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Step by Step — Account Code Utilization Register

1. From the Estimate tab under the Breakdown Structures section, select Account Code Utilization.

2. Select an account code. You can see the cost items that are using the account code below in the
Utilizing Items data block.
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3. Scroll to the right and find theMan Hours (w/ Maintenance) column. This shows the total num-
ber of manhours contributing to that account code.

4. Click the ellipses next to the Find bar. Select Unit of Measure.
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5. In the Find field, type in Each. Then press <Enter>.

6. The first account code that matches that Unit of Measure is highlighted.

7. Press <F3> to move to the next account code that matches that UoM.
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8. 8. You can change the quantity contribution of the cost items by checking and unchecking the
boxes of the cost items.

Benchmarking
Benchmarking is a way for companies to track their productivity on all of their different projects. Since
projects have various cost items and pay items, a way to benchmark and track all of these job uniformly
is using account codes. When an account code is assigned to a cost item, the account code tracks all
benchmarking data such as total manhours, MH/unit, and quantities.

In the Account Code Utilization Register, you can scroll through the columns to find benchmarking
data on each account code.

Another way projects can benchmark is by using account code tag fields. All of the account codes with
the same tags can be benchmarked together.

Also in the Account Code Utilization Register, you can use the Benchmarking Data block to view
benchmarked data. The Benchmarking portion of the form is similar to the Benchmarking data block on
the Cost Item Record, with the following exceptions:
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l The Item matching criteria is always Account Code.
l "Parent" account codes will include all matching data points for their "child" account codes,
based on the Hierarchy Separator.

l Account Code rows can be benchmarked at the terminal row level or at any superior row level in
the Account Code Utilization Register, meaning that both current estimate values and benchmark
values can be compared at any level since both include the values rolled up from their "children".

In the Setup tab, under Job Properties - Benchmarking tab, you can select where this project will get
its historical data. You can set criteria and filters to just pull in certain account codes, certain project
data, and certain cost items. You can also configure the Benchmark graph here.

Account Code Assignment
An Account Code can be mapped to multiple CBS items, but a CBS item can only be mapped to one
Account Code. Assigning Account Code to cost items is done for benchmarking purposes. It is best
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practice to assign account codes to cost items in the estimate phase rather than after the project is awar-
ded and work begins. This is beneficial for tracking account codes over the life of the project (from
estimate to completion).

Typically every cost item should be assigned an account code whether it is a terminal cost item or par-
ent cost item.

Account Codes can be assigned directly on the individual cost item, job overhead, or pay item forms.

Step by Step — Assign an Account Code to a Cost Item

1. From the Ribbon, select the Estimate tab. Then select Cost Breakdown Structure (CBS).

2. Change the Saved Views to Account Code View.

3. Double click on a cost item that has not been assigned an account code.

4. In the Employment Setup section, click on the Cost Item Setup icon, and find Default Prop-
erties.
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5. Click the icon next to the Account Code field. From the Account Codes Register, select your
account code. Click OK. Once done, click OK.
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6. Find that cost item in the CBS. Notice that the Account Code field is now populated.

Estimate provides you with the ability to assign specific account codes to each pay item on the Pay
Item & Proposal Register.

Step by Step — Account Code Utililzation Register

1. From the Price tab, select Pay Item & Proposal.

2. From the Pay Item & Proposal Register, select a pay item.

3. Find the Account Code field for that item.
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4. Click the icon in the Account Code field.

5. Select an account code that you wish to assign to that pay item. Once done, click OK.
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6. Notice how the account code you selected is now populated in that pay item’s account code field.
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Scope Sheets
A scope sheet is a table of default values pertaining to different scope items within a quote group. It is
used to more easily compare quotes.

Scope sheets can be created from the Foundation Setup Data Register - Quote Group Tag Record.
You can optionally define a default Amount or % of Total for each scope item.

This is the amount or percentage of total cost to be applied to the total quote if that Scope Item is not
included in the scope of a subcontractor/supplier quote. This amount or percentage can also be entered
or modified on each Quote Record.

Step by Step — Create a Scope Sheet

1. From the Ribbon, select the Setup tab. Under the Initialize section, select the Foundation Setup
Data drop down, and select Quote Group Tags.
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2. From the Quote Group Tags register, select Pipe Materials.

3. Select the Actions tab from the Ribbon. Then, under the Edit section, select Open.

4. Under Row Number, enter 1 in the first blank row.

5. Under Scope Item, enter 5” pipe.

6. Under the Amount section, enter 1000.
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7. Fill out the next row as row 2, 6” pipe, and 25 as the% of Total. Once done, click OK.

Scope Sheet Uses
On the Quote Record - Special Terms & Conditions tab, you can exclude any scope item that is not
included in the scope of a subcontractor/supplier quote. Any default amounts or percentages entered in
the Quote Group Tag Record default into this tab. You can enter or modify the Amount or% of
Total to be applied to the total quote due to the exclusion of the scope item.

Step by Step — Exclude Scope

1. From the Ribbon, select the Quote tab. Under the Quote Management section, select Quotes.
The Quote Register opens.

2. From the Actions tab, under the Edit section, select New.

3. When the Attention dialog box shows, select Create Quote from Quote Group Tag(s). In the
Description, check the box next to Pipe Materials. Once done, click OK.

Page 490 of 516 InEight Inc.  |  Release 20.2

Scope Sheet Uses Estimate Help Topics



4. Select the Special Terms & Conditions tab. Uncheck the Inclusions box for the 6” pipe.

5. Enter the Amount for the 6” pipe as 1000.
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6. Notice that the total quote price has adjusted.

7.
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Quote Comparison and Award Reports
On the Quote Comparison & Award form, you can see the inclusions and exclusions related to all cost
items in the job that have quote groups assigned to them, as described in the Special Terms & Condi-
tions.

Reports
Scope sheets can be seen in two reports:

l Quote Record report
l Compare & Award report

Step by Step — Reports

1. From the Ribbon, click on the Quote tab. Select the Reports option. The Quote Record Report
window appears.

2. Under the Quotes drop down, select Quote Record. Select the Details tab. Check the box next to
Include Terms and Conditions. Once you are done, click Run.
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3. Notice how the scope sheet is shown in the report.
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4. Under the Quotes report drop down, select Compare and Award. Select the Details tab. Check
the box next to Include Scope Sheet. Once you are done, click Run.

5. Notice how the scope sheet is shown in the report.
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Minority Setup Types
Imagine you are a lead estimator and the job up for bid requires 15% minority participation or good
faith efforts. You will want to track this within the estimate to ensure that you are meeting this require-
ment before executing the bid.

Minority Setup Types can be customized under the System tab and clicking on Customize.
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You can then select Minority setup under Titles and customize the minority names.

You can select Minority setup under Colors and customized various minority types to help identify
them easily.
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This enables you to recognize the Minority type of a vendor in registers such as Quote Comparison
and Award just by sight.
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You can select a Minority Business Enterprise to assign to the vendor by clicking on theMinority tab
the Quote Record.

InEight Inc.  |  Release 20.2 Page 499 of 516

Estimate Help Topics Minority Setup Types



You can run a Minority Participation report to easily see the progress towards meeting the minority par-
ticipation goals for a project.
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Quote Comparison and Award Substitute Rankings
To compare quotes from different vendors where not all items are quoted, you can substitute values
using the lowest Awarded Splittable Quote for items rather than the un-awarded plug value. This
offers a more accurate comparison.
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Session Recap
To make it easy to review your award session decisions and their effect on the job's price, the Quote
Comparison & Award form contains the Session Recap feature. This feature shows which items have
been awarded to whom and at what price. In addition, any previously awarded items show the previous
award data, including the awardee, unit price, and total price, and the comparable data for the current
session.

The effect on direct cost also shows, as well as substitute values used for comparing items on the Quote
Comparison & Award form.

Viewing Filtered Items
Follow these steps to display only those resource and cost items that are currently displayed on the
Quote Comparison & Award form.

Step by Step — Session Recap Filtered Items

1. From the Ribbon, select the Quote tab.

2. Under the Quote Comparison & Award section, select either Resources or Cost Items.

3. From the Quote Comparison & Award register, select the Actions tab.

4. Under the Tools section, select Session Recap.

5. From the Session Recap Actions tab, select View Filtered Items.

Viewing Quoted Items
Follow these steps o display only those resource and cost items that have been quoted.

Step by Step — Session Recap Filtered Items

1. From the Ribbon, select the Quote tab.

2. Under the Quote Comparison & Award section, select either Resources or Cost Items.

3. From the Quote Comparison & Award register, select the Actions tab.

4. Under the Tools section, select Session Recap.

5. From the Session Recap Actions tab, select View Quoted Items.
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Quote Item Views
In the Quote Compare & Award Register, quote item toggles have been added to the View subsection.
In the View subsection, you will find the following toggles:

l View All Items
l View Quoted Items
l View Unquoted Items

The All Items toggle displays both quoted and unquoted items in the Quote Compare & Award
Register.

The Unquoted Items toggle displays only unquoted items within the same register. This lets you filter
quote items down to the ones you have received quotes on. It also filters to the items you have not yet
received quotes on but are using in the estimate. That way, you understand where you have good cov-
erage and where may need to follow up on outstanding quotes from subcontractors or suppliers.

Follow the step by step to view different quote items.

Step by Step — Viewing Quote Items

1. From the Ribbon, select the Quote tab.

2. Under the Quote Comparison & Award section, select either Resources or Cost Items.

3. From the Quote Comparison & Award register, select the Actions tab.

4. Under the View section, select Unquoted Items.

5. You can now view items without quotes in the register. You can also choose to view All Items
or Quoted Items.
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Billing rates
In Estimate, revenue can be forecasted in multiple ways. It is common for contractors to use the Pay
Item & Proposal register to assign estimated costs to pay items and submit a price by filling out the
owners bid form. However, for projects that do not use pay items, such as a time and material contracts
or cost reimbursable type projects, Billing Rates can be used to easily estimate the price of the work for
the project owner.

A billing rate is defined as how much the Contractor is charging the client to utilize resources from the
Resource Rate Register. The billing rate can also be viewed as how much money a client is expected to
pay for utilizing one of the resources for a specified amount of time. It is important for you as a con-
tractor to have a way to more quickly see your charge rate to compare against what you will ultimately
bill your client, also known as your billing rate.

Contractors need a reliable method to price projects utilizing various markup strategies with clear vis-
ibility into various costs that drive the markup amounts. It is important for contractors to be able to:

l Apply various costs that drive markups.

l Apply billing rate gains (difference between contractor’s cost versus billing rates/client cost).

l Have clear visibility into the true margin based on both cost and billing rates.

l Compare the cost and billing rates within the CBS.

As a result of appropriately pricing projects, contractors can now create and view a variety of Billing
Rate reports such as:

l A summary of billing rates in lieu of the cost rates for a client (Estimate Summary reports).

l A cost item breakdown that shows associated cost categories, billing unit rates, and total billing
amounts (Billing Rate Summary).

l An analysis of resources and their margins, utilization counts, and billing amounts, (Margin Ana-
lysis report).
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Billing rates reports overview
There are multiple reports you can run to view resource costs, billing rates, and mark-ups that you can
choose to provide to your customer. You could also use these reports to view your markup margins
prior to submitting to your customer.

To locate the project reports, select the Setup tab, and then select Reports.
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Billing Rate Summary report
The Billing Rate Summary report shows cost items and include cost category details.

From the Reports window, select Billing Rate Reports.
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The end of the report shows a total of your Direct and Indirect cost markups and includes a Total
Billing Amount at the bottom right.

Estimate Details with Billing Rates report
The Estimate Details with Billing Rate report shows a selection of resources with associated billing
rates and utilization counts.

Cost Item Summary details

The Cost Item Summary tab in a Cost Item Record, allows the estimator to add additional costs to the
Resource Billing rates by a percentage or amount. For example, there might have been extra work and
a percentage of the work would apply that the owner approves. The Billing reports lists these details for
the owner.
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The following image shows cost item 3.1 with the adjustment. To see the adjustment, select the
Actions tab, and then in the View section, set the Display Billing Rate toggle to show the Billing Rate
columns.

Review the two columns, Total Billing Amount and Unadjusted Total Billing Amount.

In the Billing Rates report shown at the bottom of the image, you can view the 3.1 cost item estimate
details.
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Dependent cost item billing work details

You can use dependent cost items with billing work. For example, the contractor might have an agree-
ment with the owner to add additional overhead costs as a percentage of the work, or the owner allows
a contingency for unknown work.
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The Estimate Details with Billing Rates can include the dependent cost item with billing work.
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Margin Analysis report
The Margin Analysis report is beneficial for showing both mark-up and margin values for selected
resource rates.
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Additional Markup in the PBS form
Depending how the resource billing rates are determined to accommodate the owner, a fee can be
applied using the PBS form.

Markup for Direct Costs shows in the PBS form.

The fee total of the additional markup shows in the Billing Rate Summary report.
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